Common Installation Guide CUSTOMER
Document version: 2015-02-03



2

CUSTOMER
© Copyright 2015 SAP SE or an SAP affiliate company.
All rights reserved.

Common Installation Guide



Content

1 Introduction . ..... ... . i i i i e s e e e e 5
1.1 About this Document . .. . .. 5
1.2 SAP Notes for the Installation . ... ... .. .. . 5
1.3 Information Available on SAP Service Marketplace ... ... ... ... .. . ... .. .. .. ... ... 7
1.4 Naming Conventions . . . .. .. .. . 9
2 Planning ... ... ...t i it it it a e eaeaeaaa e e e 11
2.1 Overall System Planning . . . ... . 11
2.2 System Landscape Variants . . . .. .. 13
SAP Customer Activity Repository . . .. ... 13
SAP Assortment Planning for Retail . . ... .. ... . .. ... 17
3 Prerequisites .. ....... ... ittt te e e e e e e e e 21
4 Installation Scenarios . ...... ... ... ittt ettt m s 26
4.1 SAP Customer Activity Repository . . . . . 26
Installation . . .. .. 26
Post-Installation . . .. . . . 36
4.2 SAP Assortment Planning for Retail . . ... ... ... .. ... 60
Preparation . .. ... 60
Installation . . . . . 62
Post-Installation . . .. ... 72
4.3 SAP Promotion Management for Retail .. ... ... . . . . . 102
Installation . . . .. 102
5 Additional Information . ... ... ... ... . i i i a s 105
51 SAP ERP Sales Document Fields used by SAP Customer Activity Repository ... ............... 105
5.2 SAP HANA Live for SAP ERP Views Required by SAP Customer Activity Repository .. ........... 106
53 Workbook Design Example . . . . . 108
5.4 Referenced SAP Notes . . .. . .. . 110
CUSTOMER
Common Installation Guide © Copyright 2015 SAP SE or an SAP affiliate company.
Content All rights reserved. 3



4

CUSTOMER
© Copyright 2015 SAP SE or an SAP affiliate company.
All rights reserved.

Common Installation Guide



1 Introduction

11 About this Document

Purpose
This guide provides you with information on the installation process of the CAR RETAIL APPIL BUNDLE add-on,
including the following SAP applications:

e SAP Customer Activity Repository 2.0 SPO1

e  SAP Assortment Planning for Retail 1.0 SPO1

® SAP Promotion Management for Retail 8.1 SPO1

For more information on these applications and their business scenarios, see SAP Help Portal at [» help.sap.com/
car » Installation and Upgrade Information » Master Guide 1.

A Caution

If you have an existing installation of these applications, you must perform a software upgrade rather than a
new installation.

Table 1
Application Upgrade Information
SAP Customer Activity Repository ® |p help.sap.com/car » Installation and Upgrade
Information » Upgrade Guide 2
e  SAP Note 2116084
SAP Assortment Planning for Retail SAP Note 2116084
SAP Promotion Management for Retail ® | help.sap.com/retail-pmr810 » System
Administration and Maintenance Information ¥
Administrator's Guide 3
e  SAP Note 2116084

1.2 SAP Notes for the Installation

The following list includes SAP Notes that you must read (and, when appropriate, implement) before you start the
installation. For a comprehensive list of all SAP Notes referenced throughout the entire guide, see the Referenced
SAP Notes [page 110] section at the end of this guide.

Make sure that you have the up-to-date version of each SAP Note, which you can find on SAP Service Marketplace
at service.sap.com/notes.
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Table 2: SAP Notes for SAP Customer Activity Repository

1605140 SAP HANA 1.0: Central Note - SAP LT | Collective note for all the relevant SAP Notes for
Replication Server LT Replication Server for SAP HANA.
1778607 SAP HANA Live for SAP Business What to consider when implementing SAP HANA
Suite Live for SAP Business Suite.
1791342 Time Zone Support in SAP HANA How to handle time zone functions UTCTOLOCAL
and LOCALTOUTC.

1 Note

Demand Data Foundation (DDF) and Unified Demand Forecast (UDF) are optional components depending on
your SAP Customer Activity Repository scenario (for more information, see Installation Scenarios [page 26]).
The SAP Notes related to DDF and UDF are therefore not included here but referenced in the appropriate
sections of this guide. For a comprehensive list, see the Referenced SAP Notes section.

Table 3: SAP Notes for SAP Assortment Planning for Retail

1637199 Using the planning applications KIT Important information for running the Planning
Application Kit (PAK).

2033016 Improved buffering of "unposted" Correction to reduce the number of times the
calls in queries LOAD method in class
CL_RSR_RRKO_UNPOSTED_PLAN is called.

2067733 BW-IP: Not all data is filtered Corrections related to the SAP BW planning
buffer.
2022080 Upgrade of PAL AFL and BFL AFL Corrections to add privileges removed during
from SAP HANA earlier release to upgrade to SAP HANA Platform SPS 08.
SPS08
1662968 Clarification on setting Information on changing the default

ResultSetSizeLimit in Analysis Office | ResultSetSizeLimit registry setting.

2075135 Assortment Planning: Wrong values | Correction related to option planning.
and incorrect planning functions in
option plan
2075211 Assortment Planning: Errors in Correction to Refine Assortment workbook.

Refine Assortment workbook
category display and KPIs

Table 4: SAP Notes for SAP Promotion Management for Retail

2026580 Release strategy for the ABAP add- | This SAP Note contains information about
on RTLPROMO planning the installation and upgrades of the
ABAP add-on [Add-on].
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1.3

More information is available as follows on SAP Service Marketplace.

Table 5: Documentation

Information Available on SAP Service Marketplace

Information on SAP Customer Activity
Repository.

|F service.sap.com/instguides »
Industry Solutions ¥ Industry Solution
Guides » SAP for Retail » SAP Customer
Activity Repository 2

SAP Customer Activity Repository 2.0

Information on SAP Assortment
Planning for Retail.

[P service.sap.com/instguides »
Industry Solutions ¥ Industry Solution
Guides » SAP for Retail » SAP
Assortment Planning for Retail

SAP Assortment Planning for Retail 1.0

Information on SAP Promotion
Management for Retail.

|p service.sap.com/instguides »
Industry Solutions  Industry Solution
Guides » SAP for Retail » SAP
Promotion Management for Retail 3

SAP Promotion Management for Retail
8.1

Information on the Demand Data
Foundation and Unified Demand
Forecast components in SAP Customer
Activity Repository.

|» help.sap.com/car » Integration
Information 3

Administrator's Guide, Demand Data
Foundation (DDF) with Unified Demand
Forecast (UDF) on SAP HANA

Information on installing SAP HANA.

|F help.sap.com/hana_platform »
Installation and Upgrade Information »
SAP HANA Server Installation and
Update Guide 3

SAP HANA Server Installation and
Update Guide (with or without SAP
HANA unified installer, based on your
SAP HANA SPS)

Information on installing SAP HANA
database clients.

|F help.sap.com/hana_platform »
Installation and Upgrade Information »
SAP HANA Client Installation and Update
Guide 1

SAP HANA Client Installation and Update
Guide

Information on installing SAP HANA
Studio.

|F help.sap.com/hana_platform »
Installation and Upgrade Information »
SAP HANA Studio Installation and
Update Guide 3

SAP HANA Studio Installation and
Update Guide

Information on implementing SAP
HANA Live for SAP Business Suite.

| help.sap.com/hba ¥ Installation,
Security, Configuration, and Operations
Information ¥ Administrator’s Guide 3

Administrator's Guide, SAP HANA Live
for SAP Business Suite

Information on installing the SAP LT
(Landscape Transformation)
Replication Server for SAP HANA.

|F help.sap.com/hana_platform »
Installation and Upgrade Information
Installation Guide — Trigger-Based Data
Replication Using SAP LT Replication
Server for SAP HANA 2

Installation Guide - Trigger-Based Data
Replication Using SAP LT Replication
Server for SAP HANA
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Information on managing major
operational aspects of the SAP LT
Replication Server.

| help.sap.com/hana_platform »
System Administration and Maintenance
Information » Application Operations
Guide — Trigger-Based Data Replication
Using SAP LT Replication Server for SAP
HANA 3

Application Operations Guide - Trigger-
Based Data Replication Using SAP LT
Replication Server for SAP HANA

Information on using SAP HANA.

| help.sap.com/hana_platform »
System Administration and Maintenance
Information » SAP HANA Administration
Guides 3

SAP HANA Administration Guide

Information for developers on how to I[P help.sap.com/hana_platform » SAP HANA Developer Guide
use the SAP HANA development tools | Development Information » SAP HANA

to create comprehensive analytical Developer Guide 3

models and to build applications with

SAP HANA's interfaces and integrated

development.

Information for modelers (or business | [ help.sap.com/hana_platform » SAP HANA Modeling Guide

analysts) on how to define data models
that will be used in SAP HANA.

Modeling Information » SAP HANA
Modeling Guide 3

Information on installing SAP Solution
Manager.

| help.sap.com/solutionmanager71 »
Installation and Upgrade Information
Installation Guide 3

| help.sap.com/nw74 ¥ Installation and
Upgrade Information » Master Guide 2

Master Guide, SAP NetWeaver 7.4

Information on installing SAP
NetWeaver 7.40.

| help.sap.com/nw74 ¥ Installation and
Upgrade Information ¥ Installation
Guides » SAP HANA Database 2

Installation Guide, SAP Systems Based
on the Application Server <Your Server>
of SAP NetWeaver on <Your Operating
System>: SAP HANA Database

Information on installing SAP ERP 6.0
Enhancement Package 5.

| help.sap.com/erp605 ¥ Installation
and Upgrade Information » Installation
Guide 1

Installation Guide, SAP ERP 6.0
Including SAP Enhancement Package 5 -
Technical Usage “Central Applications”
<Your Server>on <Your Operating
System>

Information on installing SAP
Enhancement Package 2 for SAP CRM
7.0 or SAP Enhancement Package 2 for
SAP CRM 7.0, Version for SAP HANA or
higher.

CUSTOMER

| help.sap.com/crm702 » Installation
and Upgrade Information ¥ Installation
Guide » Install » Installation Guides for
SAP EHP 2 for SAP CRM 7.0 »
Installation Guide - SAP enhancement
package 2 for CRM 7.0 - ABAP and
Java 1

| help.sap.com/crmhana ¥ Installation
and Upgrade Information ¥
Administrator’'s Guide » Administrator's

© Copyright 2015 SAP SE or an SAP affiliate company.

8 All rights reserved.

Installation Guide, SAP Customer
Relationship Management 7.0 Including
Enhancement Package 2 Java and ABAP
Administrator's Guide, SAP
Enhancement Package 2 for SAP CRM
7.0, Version for SAP HANA

Common Installation Guide
Introduction


http://help.sap.com/hana_platform
http://help.sap.com/hana_platform
http://help.sap.com/hana_platform
http://help.sap.com/hana_platform
http://help.sap.com/solutionmanager71
http://help.sap.com/nw74
http://help.sap.com/nw74
http://help.sap.com/erp605
http://help.sap.com/crm702
http://help.sap.com/crmhana
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Table 6: General Quick Links

SAP Help Portal

help.sap.com

SAP Notes

service.sap.com/notes

SAP Software Download Center

support.sap.com/swdc

Released platforms and operating systems service.sap.com/platforms

System sizing

service.sap.com/sizing

Security

service.sap.com/security

SAP Solution Manager

support.sap.com/solutionmanager

1.4 Naming Conventions

Throughout this document the following naming conventions apply.

Definitions

The following terms are used consistently in the processes and procedures described in this guide:

Table 7

consuming application

An SAP product designed to consume and utilize data obtained from SAP Customer Activity
Repository.

# Example

®  SAP Assortment Planning for Retail

®  SAP Promotion Management for Retail

back-end system

The SAP NetWeaver-based back-end server on which SAP Customer Activity Repository and
its consuming applications (such as SAP Assortment Planning for Retail and SAP Promotion
Management for Retail) are installed.

For a visual representation of the back-end system, see Figure I in the Overall System
Planning [page 11] section.

front-end server

The SAP NetWeaver-based front-end server on which the SAP Gateway, SAP Fiori
Launchpad, SAP Fiori Central Ul, and SAP Fiori product-specific components are installed.

For a visual representation of the front-end system, see Figure 1 in the Overall System
Planning [page 11] section.
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Common Master Guide Common Master Guide for SAP Customer Activity Repository 2.0 SPO1, SAP Assortment
Planning for Retail 1.0 SPO1, SAP Promotion Management for Retail 8.1 SPOL.

You can find this guide on SAP Service Marketplace at [ service.sap.com/instguides
Installation & Upgrade Guides ¥ Industry Solutions ¥ Industry Solution Guides » SAP for
Retail » SAP Customer Activity Repository » SAP Customer Activity Repository 2.0 SPOI ¥
Master Guide 3.

Naming Differences

Due to naming differences between the underlying technical objects of the components, the names of the
following business objects are used interchangeably in this document:

Table 8

SAP Customer Demand Data SAP Promotion SAP Assortment SAP ERP

Activity Repository Foundation (DDF) Management for Planning for Retail

with Unified Demand | Retail
Forecast (UDF)
article product product product article
material
article variant product variant product variant product variant article variant
store location location location store
site

Variables
Table 9

<SAPSID> SAP system ID in uppercase letters

<sapsid> SAP system ID in lowercase letters

<DBSID> Database ID in uppercase letters

<dbsid> Database ID in lowercase letters

<INSTDIR> Installation directory for the SAP system

<DVD_DIR> Directory on which a DVD is mounted

<0S> Operating system name within a path

CUSTOMER
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2 Planning

2.1 Overall System Planning

Retail applications described in this guide require a layered system landscape that includes the following:

Table 10
Prerequisite Mandatory/Optional for Scenario
SAP Customer SAP Assortment SAP Promotion
Activity Repository Planning for Retail Management for
Retail
SAP HANA Mandatory Mandatory Mandatory
SAP HANA Live for SAP ERP Mandatory Mandatory Not applicable
SAP NetWeaver Application Server ABAP Mandatory Mandatory Mandatory
SAP Gateway Optional Mandatory Not applicable
SAP Fiori Optional Mandatory Not applicable
SAP BusinessObjects Analysis, edition for Microsoft | Not applicable Mandatory Not applicable
Office
[ Clients supporting HTMLS |
HTTPS (HTMLIODsts) O
‘SAP Web Dispatcher |_
HITPS (HTML) O e HTTPS (0Data) O

SAP Promotion ‘SAP Assortment
Management Planring

o Retad forRetai
RTLPROMO 810 (ETLRAP 100)

‘Syndicaton Layer
(RTLCONS 100)

‘SAP Customer Actvity Reposiory.
(RTLCAR 200)

ot Sale Data Management
(RTLPOSOM 300)
——
‘Demand Data Foundation
RTLOOF 200)

Figure 1
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Product Versions

The installation of SAP Customer Activity Repository and consuming applications is comprised of the installation
of two distinct product versions:

® SAP Customer Activity Repository retail applications bundle (CAR RETAIL APPL BUNDLE 1.0)

ABAP back-end functionality and the business content (such as SAP HANA views and procedures, local Bl
Content, and workbooks, where applicable) are delivered in several software components, which are all
included inthe CAR RETAIL APPIL BUNDLE 1.0 productversion.

® SAP Fiori 1.0 for SAP Customer Activity Repository retail applications bundle (SAP FIORI FOR SAP
CARAB 1.0)

The user interface of SAP Assortment Planning for Retail is comprised of several transactional SAP Fiori
apps. These apps are delivered in the UTRAP001 software component, which is included in the SAP FIORI
FOR SAP CARAB 1.0 product version. Similarly, SAP Smart Business for SAP Customer Activity Repository
is delivered in the UTSCARO1 software component, also included in the SAP FIORI FOR SAP CARAB 1.0
product version.

For more information about the system landscape for transactional SAP Fiori apps, see [F help.sap.com/
fiori » System Landscape Required for SAP Fiori » Setup of SAP Fiori System Landscape with ABAP
Environment 1.

Central Hub Deployment

For SAP Customer Activity Repository and SAP Assortment Planning for Retail, we recommend that you use
Central Hub Deployment, the deployment option recommended by SAP Fiori for SAP Business Suite.

With central hub deployment, the CAR RETAIL APPL BUNDLE 1.0 productversionis installed on a back-end
server,andthe SAP FIORI FOR SAP CARAB 1.0 productversionis installed on a separate, front-end server.

The central hub deployment option decouples the lifecycle of the Ul Fiori apps from the back-end components,
and offers the following advantages:

® Fasteriterations for the Ul apps
® (Changes to the user interface are possible without having development authorizations in the back end

® Single point of maintenance for user interface issues, such as browser support and updated versions of SAP
Ul5 libraries

e (Central place for theming and branding SAP Fiori transactional and SAP Smart Business apps

In general, when an SAP solution includes an SAP Fiori user interface, you could potentially use the embedded
deployment option, which allows you to use the same SAP NetWeaver server for back-end and front-end
components. Although the advantage of this deployment is that you do not require a separate SAP NetWeaver
front-end server, this deployment option is not recommended for the retail applications described in this guide.

As we do not recommend the embedded deployment option, the remainder of this document is entirely based on
the central hub deployment option.

For more information on deployment options, see:

® SAP Library for SAP Fiori for SAP Business Suite on SAP Help Portal at[p help.sap.com/fiori » System
Landscape Required for SAP Fiori » Setup of SAP Fiori System Landscape with ABAP Environment »
Deployment Options 1.

® SAP Library for SAP Fiori for SAP ERP 1.0 on SAP Help Portal at |r help.sap.com/fiori_bs2013 » SAP Fiori for
SAPERP 1.0 » SAP Library » Central Implementation Information » Installation » System Landscape »
Deployment Options 1.

CUSTOMER
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®  SAP Library for SAP NetWeaver Gateway 2.0 SPO7 on SAP Help Portal at [k help.sap.com/nwgateway20 »
Application Help » SAP NetWeaver Gateway Master Guide » Deployment Options/Embedded Versus Hub
Deployment 1.

2.2 System Landscape Variants
2.2.1 SAP Customer Activity Repository

2.21.1 SAP Customer Activity Repository Standalone

This deployment option has the following key characteristics:

e SAP Customer Activity Repository is deployed alongside an existing installation of SAP ERP for Retail 6.0
EHP5 or higher.

® Therepository is installed as an Add-On to SAP NetWeaver Application Server for ABAP 7.40, on an
underlying SAP HANA Platform SPS 08 or higher.

® Therepository uses SAP HANA content that is:
© Included in the SAP Customer Activity Repository software components and is automatically installed
when installing these software components
© Included in SAP HANA Live for SAP ERP

® Therepository has its own database schema on the SAP HANA Platform (SAP_CAR DB Schema). POS
transactions processed by the repository are persisted in this schema in the form of transaction logs (TLOG).

e SAP ERP data, replicated from a source SAP ERP system into the repository using trigger-based (SLT)
replication, is persisted in a separate schema (SAP_ECC DB Schema) on the same SAP HANA Platform.

e SAP ERP data required by DDF is imported from an SAP Retail ERP system using the DRF data replication
framework (transaction DRFOUT). For more information, see the | Administrator's Guide, Demand Data
Foundation (DDF) with Unified Demand Forecast (UDF) on SAP HANA » Introduction to Demand Data
Foundation (DDF) » Integrate Master Data 3. You can find this guide on SAP Help Portal at |» help.sap.com/
car » Integration Information 3.

® SAP Customer Activity Repository combines data read from the SAP ERP schema with that of the SAP
Customer Activity Repository schema and exposes this combined data to consuming applications.

2.21.2 SAP Customer Activity Repository Co-Deployed with
SAP ERP

In this deployment option, the SAP HANA Platform is shared by SAP Customer Activity Repository and SAP ERP
for Retail 6.0 EHP5 or higher.

This deployment option has the following key characteristics:

® Therepository is installed as an Add-On to SAP NetWeaver Application Server for ABAP 7.40, on an
underlying SAP HANA Platform SPS O8 or higher.

CUSTOMER
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SAP ERP for Retail 6.0 EHP5 or higher is installed on a separate SAP NetWeaver instance that accesses the
same SAP HANA Platform as the repository. This means that the SAP HANA Platform is shared by the
repository and SAP ERP for Retail.

SAP ERP data required by DDF is imported from an SAP Retail ERP system using the DRF data replication
framework (transaction DRFOUT). For more information, see the |» Administrator's Guide, Demand Data
Foundation (DDF) with Unified Demand Forecast (UDF) on SAP HANA » Introduction to Demand Data
Foundation (DDF) » Integrate Master Data 3. You can find this guide on SAP Help Portal at |» help.sap.com/
car » Integration Information 1.

The repository has its own database schema on the SAP HANA Platform (SAP_CAR DB Schema). POS
transactions processed by the repository are persisted in this schema in the form of transaction logs (TLOG).

SAP ERP has its own database schema on the SAP HANA Platform (SAP_ECC DB Schema).

SAP Customer Activity Repository reads data from the SAP ERP schema and combines it with data stored in
its own, SAP_CAR, schema. The combined data is exposed to consuming applications through views included
in the SAP HANA content for SAP Customer Activity Repository.

The repository uses SAP HANA content that is:

© Included in the SAP Customer Activity Repository software components and is automatically installed
when installing these software components

o Includedin SAP HANA Live for SAP ERP

SAP NW AS ABAP SAP NW AS ABAP
SAP CRM
Components
SAP Customer Activity Repository SAP ERP
Components Components
i 3
i DB Schema i
1| saPcrRM | Y
o | Gapcrm\ | |1 J) (])
Tables J fo)
i
FEHER TR eRE: | SAP HANA
DB Schema DB Schema DB Schema
_SYS_BIC SAP_CAR SAP_ECC
SAP Customer
":‘ly - ems ’ P Custome
ompon: us r
S SAP ERP
Activity Repository
Tables
SAP HANA Live @
for SAP ERP

e

Figure 2: SAP Customer Activity Repository Co-Deployed with SAP ERP

This deployment option provides the following advantages:

14

No SLT replication is required from SAP ERP to SAP Customer Activity Repository. The repository uses
virtual data models to consume data directly (without SLT replication) from SAP ERP tables stored on the
shared SAP HANA Platform.

There are no technical dependencies or limitations between the individual SAP NetWeaver stacks used by
SAP Customer Activity Repository and SAP ERP for Retail.
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Only one single SAP HANA Platform is required.

However, this deployment option has the following disadvantages:

Because the SAP HANA Platform is shared by two large applications (SAP Customer Activity Repository and
SAP ERP for Retail), the size of the required SAP HANA Platform increases substantially.

Because data is not replicated from SAP ERP to the repository, there is no opportunity to apply
transformation rules to correct any potential differences in SAP client numbers. As a result, the SAP client
numbers of the source SAP ERP system and of the SAP Customer Activity Repository system must match.
For more information, see Set Up SAP Client [page 28].

2.2.1.3 SAP Customer Activity Repository Co-Deployed with

SAP BW

In this deployment option, the SAP HANA Platform is shared by SAP Customer Activity Repository and SAP
Business Warehouse (SAP BW).

Note

SAP BW and Bl Content are not required for the implementation of SAP Customer Activity Repository. This
section simply outlines the technical details and the advantages associated with this co-deployment.

This deployment option has the following key characteristics:

SAP Customer Activity Repository is deployed alongside an existing installation of SAP ERP for Retail 6.0
EHP5 or higher.

The repository is installed as an Add-On to SAP NetWeaver Application Server for ABAP 7.40, on an
underlying SAP HANA Platform SPS 08 or higher.

SAP BW is installed as a separate instance on the same SAP HANA Platform as the repository. This means
that the SAP HANA Platform is shared by the repository and SAP BW.

The default master data access from the repository is always through SAP HANA views to the master data
tables replicated from a source SAP ERP system.

When SAP BW and BI Content are available on the same SAP HANA Platform as the repository, and you want
to access master data from SAP BW, you will have to re-implement the BAdls that are used for master data
access in SAP Customer Activity Repository.

SAP ERP data required by DDF is imported from an SAP Retail ERP system using the DRF data replication
framework (transaction DRFOUT). For more information, see the |» Administrator's Guide, Demand Data
Foundation (DDF) with Unified Demand Forecast (UDF) on SAP HANA » Introduction to Demand Data
Foundation (DDF) » Integrate Master Data 3. You can find this guide on SAP Help Portal at |» help.sap.com/
car » Integration Information 1.

The repository uses SAP HANA content that is:

o Included in the SAP Customer Activity Repository software components and is automatically installed
when installing these software components

o Included in SAP HANA Live for SAP ERP

The repository has its own database schema on the SAP HANA Platform (SAP_CAR DB Schema). POS
transactions processed by the repository are persisted in this schema in the form of transaction logs (T1.0G).
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e SAPERP data, replicated from a source SAP ERP system into the repository using trigger-based (SLT)
replication, is persisted in a separate schema (SAP_ECC DB Schema) on the same SAP HANA Platform.
e SAP BW also has its own, separate, database schema.

® SAP Customer Activity Repository combines data read from the SAP ERP schema with that of the SAP
Customer Activity Repository schema and exposes this combined data to consuming applications.

® SAP Customer Activity Repository data can be consumed directly from SAP BW (without replication).

SAP NW AS ABAP SAP BW
SAP CRM
Components
SAP Customer Activity Repository Sx:"‘lz‘::s
Companents Components
ifoe_ &
1 | DB Schema
SAP_CRM ]
i | (Gapcrm | | J) (J)
Tables ? Po)
g BB8EH SAP HANA
SAP ERP DB Schema DB Schema DB Schema
SAP NW AS ABAP _SYS_BIC SAP_CAR SAP_BW
I I
SAP Customer
SAP ERP Activity itory
Components Components SAP Customer
I o 2 SAP BW
Activity Repository
DB Sch - Tables
SAP_ECC
Q SAP HANA Live
DB SaP ERP for SAP ERP.
DB Schema Tables 2
SAP_ECC
SAP ERP
Tables

Figure 3: SAP Customer Activity Repository Co-Deployed with SAP BW

This deployment option provides the following advantage:
® You can continue to leverage existing SAP BW assets, for example, by combining data from existing B
Content objects together with data exposed through views of the SAP HANA content for SAP Customer
Activity Repository.
However, this deployment option has the following disadvantage:

® The Point of Sale Data Management component within SAP Customer Activity Repository processes the
transactions received from the point of sale and stores them in the repository. If this component is
unavailable as a result of maintenance that is unrelated to the actual operation of the repository, then
mission-critical POS transaction data cannot be processed. This can result in delayed posting of financial
figures to SAP ERP.
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2.2.2 SAP Assortment Planning for Retail

2.2.2.1 Common Characteristics of Landscape Variants

All SAP Assortment Planning for Retail landscape variants share the following common characteristics:

SAP Assortment Planning for Retail is a consuming application of SAP Customer Activity Repository.

Inturn, SAP Customer Activity Repository is installed as an Add-On to SAP NetWeaver Application Server for
ABAP 7.40, on an underlying SAP HANA Platform SPS 08.

SAP Assortment Planning is installed as part of SAP Customer Activity Repository retail applications bundle
(CAR RETAIL APPL BUNDLE 1.0).However, the applicationis licensed separately, and its usage must be
enabled as described in Activate SAP Assortment Planning for Retail Business Function [page 73].

SAP Assortment Planning for Retail uses SAP HANA content that is automatically installed when installing:

o SAP Customer Activity Repository retail applications bundle (CAR RETAIL APPL BUNDLE 1.0),
including:

©  Demand Data Foundation (RTLDDF software component)

o

SAP Customer Activity Repository (RTLPOSDM and RTLCAR software components)

@]

Syndication Layer (RTLCONS software component)

@]

SAP Assortment Planning for Retail (RTLRAP software component)
o SAP HANA Live for SAP ERP

SAP Assortment Planning for Retail has its own database schema on the SAP HANA Platform (SAP_RAP DB
Schema) in addition to the schemas of SAP Customer Activity Repository software components (SAP_DDF
DB Schema, SAP_CAR DB Schema).

SAP Assortment Planning for Retail accesses master data from two different sources:

© Demand Data Foundation: Data is imported to DDF from an SAP ERP for Retail system using the
DRFOUT data replication framework. For more information, see Configure Demand Data
Foundation [page 74].

o  SAP HANA Live for SAP ERP: Data is made available from a connected SAP ERP for Retail system. The
import process depends on the corresponding deployment option.

Released Merchandise Planning data (for example, Open-To-Buy data generated using the SAP Planning for
Retail, rapid deployment solution) is imported into the SAP_DDF DB Schema using the standard RFC
framework. For more information, see Configure Demand Data Foundation [page 74].

2.2.2.2 SAP Assortment Planning for Retail Standalone

This deployment option has the following key characteristics:

SAP Assortment Planning for Retail is deployed alongside an existing installation of the following:
o SAP ERP for Retail 6.0 EHP5 or higher

o [Optional] An SAP Business Warehouse system that contains data generated using SAP Planning for
Retail, rapid deployment solution

Data is imported from SAP ERP into:
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Figure 4: SAP Assortment Planning for Retail Standalone Deployment

2.2.2.3 SAP Assortment Planning for Retail Co-Deployed
with SAP ERP

This deployment option has the following key characteristics:

SAP Assortment Planning for Retail is co-deployed with SAP ERP for Retail 6.0 EHP5 or higher on the same
SAP HANA Platform but on a different SAP NetWeaver stack.
Since SAP Assortment Planning for Retail and SAP ERP share the same SAP HANA Platform, SLT replication
of data from SAP ERP is not required. SAP Assortment Planning accesses SAP ERP data directly from the
SAP ERP database schema (SAP_ECC DB Schema).
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Data is imported from SAP ERP into DDF, using the DRFOUT data replication framework and is persisted in
SAP DDF Schema.
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Figure 5: SAP Assortment Planning for Retail Co-Deployed with SAP ERP

SAP Assortment Planning for Retail Co-Deployed
with SAP BW

This deployment option has the following key characteristics:

®  SAP Assortment Planning for Retail is co-deployed with SAP BW on the same SAP HANA Platform but on a

different SAP NetWeaver stack.

e Dataisimported from SAP ERP into:

o

SAP HANA Live for SAP ERP, using SAP LT Replication Server (SLT), and is persisted in SAP_ECC
Schema, and

DDF, using the DRFOUT data replication framework. and is persisted in SAP_DDF Schema (subset of
data)

e |f you would like to integrate released Merchandise Planning data (for example, Open-To-Buy data generated
using the SAP Planning for Retail, rapid deployment solution), this data needs to be imported into the

SAP DDF Schema. For more information, see Configure Demand Data Foundation [page 74].

Note

InfoProviders and InfoObjects in SAP BW cannot be accessed by SAP Assortment Planning for Retail in the
SAP NetWeaver layer. However, direct access to these objects is possible in the SAP HANA layer, since the
same SAP HANA Platform is used by both applications.
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Figure 6: SAP Assortment Planning for Retail Co-Deployed with SAP BW
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3 Prerequisites

This section contains a list of all the prerequisite platforms, applications, and components that must be installed
and configured prior to executing the installation instructions covered in this guide.

1 Note

Installation of the following prerequisites should be performed by an experienced SAP Basis administrator.
Documentation and support for each prerequisite is available on the SAP Help Portal and the SAP Service
Marketplace.

The following table presents the prerequisites for each of the installation scenarios and provides links to the
respective installation documentation:

Table 11

Prerequisite Installation Information Mandatory/Optional for Scenario

SAP SAP SAP
Customer Assortment Promotion
Activity Planning for | Management
Repository Retail for Retail

SAP HANA Platform SPS08 | ® |p help.sap.com/hana_platform » Mandatory Mandatory Mandatory

revision 83 or higher Installation and Upgrade

The PAL algorithms, used by Information » SAP HANA Server
SAP Assortment Planning for Installation and Update Guide 3
Retail, are implemented and ® | help.sap.com/hana_platform ¥
shipped as an application Reference Information » SAP HANA
function library (AFL) in the Library References » SAP HANA
SAP HANA database. Predictive Analysis Library (PAL) 3
You have to ensure that SAP

HANA AFL 1.0 (software

component version SAP
HANA AFL 1.0)hasbeen
installed as part of your SAP
HANA Platform.

A Caution

If you were previously
using SAP HANA Platform
SP 07 or lower, and are
upgrading to SAP HANA

Platform SPS 08 or higher,
you need to implement
SAP Note 2022080.
CUSTOMER
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Mandatory/Optional for Scenario

Prerequisite

Installation Information

SAP SAP SAP
Customer Assortment Promotion
Activity Planning for | Management
Repository Retail for Retail

Demand Data Foundation e  SAP Note 2001688 Optional Mandatory Mandatory

(DDF) 2.0 SPO1 ® |k help.sap.com/car » Integration

A cross-industry reusable Information » Administrator's Guide,

data layer supporting Demand Data Foundation (DDF) with

different consuming Unified Demand Forecast (UDF) on

applications. DDF (software SAP HANA 3

component version RTLDDF

200) is acomponent in SAP

Customer Activity Repository

and a prerequisite for using

Unified Demand Forecast

(UDF).

UDF AFL revision 83 or ®  SAP Note 2050229 Optional Optional Recommende

higher e SAP Note 2004952 d

The Unified Demand Forecast

application function library A Caution

provides the demand There are dependencies between the

modeling and forecasting UDF AFL, the SAP HANA database, and

services in SAP Customer DDF. For more information, see the

Activity Repository. The UDF | Component Version Dependencies

AFL (software component section in the Administrator's Guide,

version UDFAFL_INST Demand Data Foundation (DDF) with

100) is shipped separately for | Unified Demand Forecast (UDF) on SAP

installation in the SAP HANA HANA for this support package.

database. The releases are

called “revisions”. The UDF

AFL requires Demand Data

Foundation (DDF) as a

prerequisite.

POS AFL (OSA) revision 83 e  SAP Note 2004952 Optional Optional Optional

or higher *  SAP Note 2016825

The On-Shelf Availability
(OSA) algorithms (software
component version
POSAFL_INST 100)are
implemented and shipped as
a separate application
function library (AFL) for
installation in the SAP HANA
database.
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Mandatory/Optional for Scenario

Prerequisite

Installation Information

SAP
Customer
Activity
Repository

SAP
Assortment
Planning for
Retail

SAP
Promotion
Management
for Retail

SAP Smart Business SAP Note 2018360 Optional Not Applicable | Not Applicable
foundation component 1.0
SPSO1
SAP LT (Landscape | help.sap.com/hana_platform » Mandatory Mandatory Not Applicable
Transformation) Replication | installation and Upgrade Information »
Server for SAP HANA 2.0 SAP HANA Replication Installation
Guides » Installation Guide — Trigger-
Based Data Replication Using SAP LT
Replication Server for SAP HANA 3
SAP Solution Manager ® |k help.sap.com/ Mandatory Mandatory Mandatory
We recommend to always use solutionmanager71 # Installation and
the latest version of the SAP Upgrade Information ¥ Installation
Solution Manager. Failure to Guide 3.
do so may cause problems ® |k help.sap.com/nw74 ¥ Installation
when using the Maintenance and Upgrade Information » Master
Optimizer (MOPZ) Guide 3.
application.
SAP NetWeaver 7.40 SP 09 | | help.sap.com/nw74 } Installation and Mandatory Mandatory Mandatory
If you launch WebDynpro Upgrade Information » Installation
applications from the back- | Guides 3
end system, ensure that you
have installed the SAP_UI 740
SP 11 component. If you have
a lower version, ensure that
you analyze and implement
SAP Note 2038829.
SAP ERP 6.0 ® |p help.sap.com/erp605 » Enhancement | Enhancement | Enhancement
See adjacent columns for Installation and Upgrade Package 5is | Package5is Package 5is
details regarding Information ¥ Installation Guide 3 mandatory mandatory. mandatory.
Enhancement Package ® |p help.sap.com/erp604 » when
version support. Installation and Upgrade mplementing
Information ¥ Installation Guide 3 SAP
Customer
®  SAP Notes (applicable only for SAP Activity
ERP 6.0 EHP5 and higher): Repository
o 1983853 with DDF with
o 1994823 UDF.
o 2004326 Otherwise,
Enhancement
o 2032294 Package 4 is
o 2069483
CUSTOMER
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Prerequisite

Installation Information

Mandatory/Optional for Scenario

SAP
Customer
Activity
Repository

SAP
Assortment
Planning for
Retail

SAP

Promotion
Management

for Retail

o 2068874 mandatory at
abare
minimum if
not
implementing
DDF with UDF.

SAP Enhancement Package ® |p help.sap.com/crm702 » Optional Not Applicable | Not Applicable
2 for SAP CRM 7.0 or SAP Installation and Upgrade
Enhancement Package 2 for Information ¥ Installation Guide 3
SAP CRM 7.0, Version for e | help.sap.com/crmhana »
SAP HANA or higher Installation and Upgrade
Information » Administrator’s
Guide 3
SAP HANA Live for SAP ERP | |p help.sap.com/hba » Installation, Mandatory Mandatory Not Applicable
SP 02 or higher Security, Configuration, and Operations
Information » Administrator’s Guide 2

A Caution

SAP Customer Activity

Repository retail

applications bundle does

not require that you

execute all of the

installation steps exactly

as they are described in

the Administrator's Guide,

SAP HANA Live for SAP

Business Suite.

You must read the Install

SAP HANA Live for SAP

ERP procedure in this

guide prior to installing

SAP HANA Live for SAP

ERP.
Client Client-specific installation information Optional Mandatory Not Applicable
To be able to run SAP Fiori

apps, the runtime
environment (such as the
browser) of the client must
support HTML5.
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Prerequisite

SAP BusinessObjects
Analysis, edition for
Microsoft Office 1.4 SP 09 or
higher

SAP Assortment Planning for
Retail includes a number of
SAP BusinessObijects
Analysis workbooks. To be
able to access assortment
planning workbooks, you
must ensure that SAP
BusinessObjects Analysis,
edition for Microsoft Office 1.4
SP 09 or higher is installed on
your local system.

Installation Information

[P help.sap.com/boao # Installation,
Security, Configuration, and Operations
Information » Administrator’s Guide 3

Mandatory/Optional for Scenario

SAP
Customer
Activity
Repository

Not Applicable

SAP
Assortment
Planning for
Retail

Mandatory

SAP
Promotion
Management
for Retail

Not Applicable

SAP Jam, enterprise edition

| help.sap.com/sapjam » System
Administration and Maintenance
Information » Administrator’s Guide 3

Optional

Optional

Not Applicable
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4 Installation Scenarios

4.1 SAP Customer Activity Repository

411 Installation

The following interactive diagram depicts the installation process for SAP Customer Activity Repository 2.0. If you
are reading this document on a device, you can select elements in the diagram to navigate to the corresponding
sections.

1 Note

The Install ABAP Back-End Server, Install ABAP Front-End Server, Install SAP HANA Live for SAP ERP, and
Create SAP CRM Table Definitions installation processes can be executed independently from one another. You
may assign separate teams to work on these processes in parallel for a faster and simpler implementation.

Installation

Install SAP HANA DB
Install SAP HANA clients and SAP HANA Install SAP Solution
and SAP HANA AFL Studio and connect it to Manager

your SAP HANA system

Co-deployed with
SAP ERP on one

HANA? b4

Install SAP NetWeaver i
Gateway lntegmr:te Y
wi
SAP v

Install SAP LT (SLT)
Replication Server

V
Install Central SAP Configure SLT
Fiori Ul Components replication from SAP
ERP to the target SAP
HANA system
j

Install SAP Customer
Activity Repository
Retail Applications

Bundle

I Install SAP LT (SLT)
Replication Server

AV
Configure SLT
replication from SAP
CRM to the target SAP
HANA system
V.

Create CRM tables in
SAP Customer Activity
Repository
SAP Note 1938004

eate “dummy" CRM
tables in SAP
Customer Activity
Repository
*

Figure 7: Installation Workflow for SAP Customer Activity Repository
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4111 Install Prerequisites

Before proceeding with the installation, the following components must be installed and configured:
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e SAPHANA

e SAP HANA Application Function Library (AFL)
o  SAP HANA Database Clients

e SAP HANA Studio

® SAP Solution Manager

1 Note

The documentation for installing and configuring these components is maintained and published separately
from this product. See the Prerequisites [page 21] section for more information on retrieving the related
documentation.

41.1.2 Install ABAP Back-End Server

41.1.2.1 Install SAP NetWeaver

You must install SAP NetWeaver 7.40 SP 09 prior to installing other back-end components.

For more information about how to install SAP NetWeaver, see [» help.sap.com/nw74 » Installation and Upgrade
Information » Installation Guides 3.

4112.2 Install SAP Customer Activity Repository Retail
Applications Bundle

We recommend using Maintenance Optimizer in SAP Solution Manager to install and update product versions.
SAP Solution Manager calculates the required software components that have to be deployed on each server.

For more information about Maintenance Optimizer, see SAP Help Portal at |p help.sap.com/
solutionmanager71 » Application Help » SAP Library » SAP Solution Manager » Maintenance Management »
Maintenance Optimizer 1.

Alternatively, you can download the required files directly from SAP Service Marketplace and deploy them
manually.

In this procedure, you use Maintenance Optimizer to perform a stack XML installation of SAP Customer Activity
Repository retail applications bundle 1.0.

Procedure

1. Logonto SAP Solution Manager and launch Maintenance Optimizer.

For more information on using Maintenance Optimizer, see [F service.sap.com/mopz 2.
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1 Note

Maintenance Optimizer 3.0 (MOPZ) is the standard for SAP Solution Manager 7.1 SP12. You may
experience difficulties installing products if you are running an older version of SAP Solution Manager.

We recommend upgrading to the latest version of SAP Solution Manager. If you do not wish to do so, you
must implement SAP Note 1940845 to render the MOPZ front-end compatible with the back-end.

2. Inthe Maintenance Optimizer work step that allows you to choose add-on products, select product version
CAR RETAIL APPL BUNDLE 1.0 andproductinstance CARAB ABAP Server.

V] CAR RETAILAPPL BUNDLE 1.0 01 (1012014 ~  SAP Customer Activity Repository retail applications bundle 1.0
() CAR RETAIL APPL BUNDLE 1.0
Instance Reguired Instance Required Product Version ~ Systems
[w| CARAB ABAP Server Application Server ABAP SAP NETWEAVER 7.4 Assign System

Figure 8: Selection of Product Version and Product Instance

Caution

Do not deselect any ABAP components from the product instance.

3. Calculate and download the stack XML file.

Log on to your back-end server, that is, the ABAP system on which you are installing CAR Retail Appl Bundle -
ABAP Instance.

5. Usethe SAP Add-On Installation Tool (transaction SAINT) to load and install the stack XML generated using
SAP Solution Manager Maintenance Optimizer.

For more information on transaction SAINT, refer to the system documentation available directly in the
system when you run transaction SAINT and select the Online Help icon.

41123 Set Up SAP Client

In this procedure, you set up a client on your back-end system.

Procedure

1. Verify the client numbers in the source SAP ERP, and, optionally, in the source SAP CRM system(s).
This installation includes SAP HANA content that provides views on a combination of client-dependent data
authored in these source SAP systems. For instance, sales documents are created in a source SAP ERP
system and are replicated to the repository. Likewise, customer information can be optionally replicated
from a source SAP CRM system.

2. Create the necessary client on your back-end system using client maintenance transaction (scc4).

Caution
If you are performing a client copy, you should only perform the client copy after a successful import of all
related software components. Also, you should only import or transfer Customizing tables after this client
copy is complete, as described in SAP Note 337623.
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If using the same client number is not possible due to the specifics of your implementation and client setup
rules, you must use SLT transformation rules before replicating data to transform the source SAP ERP,
and optionally, the source SAP CRM, client (s) to match the client on your back-end system.

Example
If SAP ERP and SAP CRM are set up on client 100 in your implementation, you should also set up your
installation on client 100. If, for any reason, you are unable to do so, you can transform the source client to
100 using SLT transformation rules.

Cross-system information is client-dependent. As a result, it is required to use the SAP Client (MANDT)
attribute as one of the join attributes in the SAP HANA views to combine cross-system sales and master
data. All data (whether created or replicated) must be affiliated with the same client number.

More Information

For more information, see | help.sap.com/nw73 » Application Help » Function-Oriented View » Application
Server » Application Server ABAP » Other Services » Services for Administrators » Client Concept 1.

4112.4 Deploy the SAP NetWeaver Pl Content for SAP
Customer Activity Repository Software Component
(Optional)

This procedure outlines how to install the SAP NetWeaver Process Integration (SAP NetWeaver Pl) Content for
SAP Customer Activity Repository software component version XI CONTENT RTLPOSDM 300. This optional
software component version contains integration content that has been predefined by SAP to be used with SAP
Customer Activity Repository.

Procedure

1. Locate XTI CONTENT RTLPOSDM 300 onthe SAP Support Portal at |» support.sap.com/swdc » SAP
Software Download Center » Support Packages and Patches » Browse Our Download Catalog » SAP
Content » ESR Content (XI Content) 1.

2. Follow the instructions for importing SAP NetWeaver Pl Content as listed under [k help.sap.com/
nw_platform » Application Help » Function-Oriented View » Your Language » Process Integration » Enterprise
Services Repository & Registry » Managing Services in the Enterprise Service Repository » Managing
Enterprise Services Delivered by SAP » Importing ESR Content 1.

For more information, see SAP Library for SAP NetWeaver Process Integration on SAP Help Portal at
IF help.sap.com/nw_platform » Application Help » SAP NetWeaver Process Integration 3.
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4.11.3 Install ABAP Front-End Server (Optional)

The following section only requires implementation if you plan on using the SAP Smart Business for Multichannel
Sales Analytics cockpit.

For more information, see SAP Help Portal at [» help.sap.com » Application Help » SAP Smart Business for SAP
Customer Activity Repository 1.

41131 Install SAP NetWeaver Gateway on the ABAP Front-
End Server

The complete Ul layer consisting of the central Ul component, the product-specific Ul components and the SAP
NetWeaver Gateway is contained in the ABAP front-end server. SAP NetWeaver Gateway handles the
communication between the client and the ABAP back-end server. For a visualization of how these components
interact, see Overall System Planning [page 11].

When you are implementing the Central Hub deployment option, you use separate servers for the back-end and
front-end components in your landscape.

Procedure

Ensure that the necessary SAP NetWeaver version is installed on your front-end server. For more information, see
SAP Library for SAP Fiori on SAP Help Portal at ¢ help.sap.com/fiori_bs2013 » System Landscape Required for
SAP Fiori » Setup of SAP Fiori System Landscape with SAP HANA Database » Installation J.

41.1.3.2 Install Central SAP Fiori Ul Components

The complete Ul layer consisting of the central Ul component, the product-specific Ul components and the SAP
NetWeaver Gateway is contained in the ABAP front-end server. The central Ul component contains the SAP UI5
control library and the SAP Fiori Launchpad.

When you are implementing the Central Hub deployment option, you use separate servers for the back-end and
front-end components in your landscape. Your front-end server must have the required central Ul component
version.

Procedure

Ensure that SAP_UI 740 SP11 (which contains SAPUI5 Version 1.24.2 or higher) or equivalent is installed on your
front-end server.

Depending on the version of SAP NetWeaver installed on your front-end server, the central Ul component is either
installed as an add-on (for example, for SAP EhP1 for SAP NetWeaver 7.3 or higher) or is integrated directly in the
SAP NetWeaver installation (for example, SAP NetWeaver 7.4 SPO4 or higher). In either case, to use the apps
delivered as part of SAP Fiori 1.0 for SAP Customer Activity Repository retail applications bundle (SAp FIORT
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FOR SAP CARAB 1.0), SAP_UI 740 SP11 (which contains SAPUI5 Version 1.24.2 or higher) or equivalent must
be installed on your front-end server.

For more information, see SAP Library for SAP Fiori on SAP Help Portal at [» help.sap.com/fiori_bs2013 » System
Landscape Required for SAP Fiori » Setup of SAP Fiori System Landscape with SAP HANA Database »
Installation » Setup of Front-End Server » Installation of Central Ul Components 1.

411.3.3 Install the SAP Smart Business Modeler Apps
Framework

The SAP Smart Business for Multichannel Sales Analytics apps included in this installation are based on the SAP
Smart Business Modeler Apps Framework. Installation and setup of this framework includes the following:

® |nstallation of SAP Smart Business Modeler apps on the front-end server
® |nstallation of SAP Smart Business products on the SAP HANA Server

® |nstallation of SAP Web Dispatcher

e Communication channels

® Appimplementation

For more information on these topics, see |F help.sap.com/nw74 » Application Help » Ul Technologies in SAP
NetWeaver » Ul Frameworks based on HTML5, JavaScript and CSS » SAPUI5 Application Frameworks » SAP
Smart Business » Setting up the SAP Smart Business Modeler Apps Framework 3.

411.3.4 Install Product-Specific SAP Fiori Ul Components

The complete Ul layer consisting of the central Ul component, the product-specific Ul components and the SAP
Gateway is contained in the ABAP front-end server. The product-specific Ul component contains the SAP Fiori
user interface for the SAP Assortment Planning for Retail application and the SAP Smart Business for SAP
Customer Activity Repository. This procedure describes the installation of this product-specific Ul component.

Procedure

1. Logonto SAP Solution Manager and launch Maintenance Optimizer.

For more information about using Maintenance Optimizer, see [ service.sap.com/mopz 3.

1 Note

Maintenance Optimizer 3.0 (MOPZ) is the standard for SAP Solution Manager 7.1 SP12. You may
experience difficulties installing products if you are running an older version of SAP Solution Manager.

We recommend upgrading to the latest version of SAP Solution Manager. If you do not wish to do so, you
must implement SAP Note 1940845 to render the MOPZ front-end compatible with the back-end.

2. Inthe Maintenance Optimizer work step that allows you to choose add-on products, select product version
SAP FIORI FOR SAP CARAB 1.0.

3. Select the product instance based on the SAP NetWeaver version of your front-end server:
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o Ul for SAP CARAB on NW 740

o Ul for SAP CARAB on NW 731
Calculate and download the stack XML file.
Log on to your front-end server.

Use the SAP Add-On Installation Tool (transaction SAINT) to load and install the stack XML generated using
SAP Solution Manager Maintenance Optimizer.

For more information on transaction SAINT, refer to the system documentation available directly in the
system when you run transaction SAINT and select the Online Help icon.

4.11.4 Install SAP HANA Live for SAP ERP

This section describes how to install SAP HANA Live under different implementation conditions:

e |fyou are implementing a deployment option that requires data to be replicated from a source SAP ERP
system, see Deployment Scenario: SAP Customer Activity Repository Standalone or Co-Deployed with SAP
BW [page 32].

e [fyou are implementing a deployment option in which your source SAP ERP system and SAP Customer
Activity Repository are co-deployed on the same SAP HANA database, see Deployment Scenario: SAP
Customer Activity Repository Co-Deployed with SAP ERP [page 341].

For more information, see System Landscape Variants [page 13].

41.14.1 Deployment Scenario: SAP Customer Activity
Repository Standalone or Co-Deployed with SAP
BW

SAP Customer Activity Repository requires that SAP HANA Live for SAP ERP is installed, configured and
connected to the same SAP HANA database that you plan to use for SAP Customer Activity Repository.

For more information on installing SAP HANA Live for SAP ERP, see |F help.sap.com/hba » Installation, Security,
Configuration, and Operations Information » Administrator's Guide » Administrator's Guide, SAP HANA Live for
SAP Business Suite 1.

Caution

SAP Customer Activity Repository does not require that you execute all of the installation steps exactly as they
are described in the Administrator's Guide, SAP HANA Live for SAP Business Suite. Prior to executing steps that
describe the creation and replication of SAP ERP tables, be sure to read the additional instructions for SAP
Customer Activity Repository provided in this guide.

Process
1. Ensure that the SAP Landscape Transformation component (SAP LT Replication Server) is installed.
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2. Configure access from the SAP LT Replication Server to the source SAP ERP system (RFC connection) and
from SAP LT Replication Server to the target SAP HANA database.

For more information, see:

© |r help.sap.com/hba ¢ Installation, Security, Configuration, and Operations Information » Administrator's
Guide » Administrator's Guide, SAP HANA Live for SAP Business Suite » Installation Steps 1.

o |r help.sap.com/hana_platform » System Administration and Maintenance Information » Application
Operations Guide — Trigger-Based Data Replication Using SAP LT Replication Server for SAP HANA »
(<Technical Prerequisites and Authorization Aspects> and <Accessing the Configuration and Monitoring
Dashboard>) 1.

3. Ensure that your back-end system is connected to SAP HANA Studio.
If necessary, set the connection as follows:
1. LogontoSAP HANA Studio.
2. Right-click in the Navigator pane and select Add System.
3. Enter the required information the Specify System dialog:
o0 Hostname
o Instance Number
o System description
4. Specify your system User Name and Password in the Connection Properties dialog.

4. Ensure that a database catalog schema is created on the target SAP HANA database. This is the schema on
your SAP HANA database to which the SAP ERP data will be replicated.

For more information, see:

o |» help.sap.com/hba ¢ Installation, Security, Configuration, and Operations Information » Administrator's
Guide » Administrator's Guide, SAP HANA Live for SAP Business Suite » Installation Steps 1

o |p help.sap.com/hana_platform » System Administration and Maintenance Information » SAP HANA
Administration Guides ¥ Creating Schemas 2.

5. Map the authoring schema of the sap.hba.ecc content package to your particular physical database
schema, described in the previous step. If the physical database schema to which the SAP ERP data will be
replicated is already called SAP_EcCC, this schema mapping is not required.

Table 12
Authoring Schema Physical Schema
SAP ECC <Name of Your Schema for Storing SAP ERP

Data>

For more information, see:

o |» help.sap.com/hba » Installation, Security, Configuration, and Operations Information » Administrator's
Guide » Administrator's Guide, SAP HANA Live for SAP Business Suite » Installation Steps 1

© |» help.sap.com/hana_platform » Modeling Information » SAP HANA Modeling Guide » Mapping the
Authoring Schema to the Physical Schema 1.

6. Create the tables that are required by SAP HANA Live for ERP views on the target SAP HANA database using
the instructions provided in SAP Note 1799313. The tables that are required to be created are listed in SAP
Notes 1782065, 1781992, and 1900038.

The creation of the tables on the target SAP HANA database is required so that the content package of SAP
HANA Live for ERP can be deployed and activated correctly.
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7.

Caution

You must not replicate any data to these tables at this point. Data replication is performed during
post-installation.

For more information, see Replicate SAP ERP Tables for <Your Product> in the Post-Installation section
specific to your scenario.

Deploy the SAP HANA Live for ERP content package on the SAP HANA database.

For more information, see lF help.sap.com/hba ¢ Installation, Security, Configuration, and Operations
Information » Administrator's Guide » Administrator's Guide, SAP HANA Live for SAP Business Suite »
Installation Steps 1.

Ensure that the views included in the content package sap.hba.ecc have been activated.

The subset of the views required by SAP Customer Activity Repository is listed in SAP HANA Live for SAP
ERP Views Required by SAP Customer Activity Repository [page 106].

For more information on activating views, see [» help.sap.com/hana_platform » Development Information »
SAP HANA Developer Guide » Setting Up the Analytic Model » Creating Views » Activating Objects 3.

41142 Deployment Scenario: SAP Customer Activity

Repository Co-Deployed with SAP ERP

SAP Customer Activity Repository requires that SAP HANA Live for SAP ERP is installed, configured and
connected to the same SAP HANA database that you plan to use for SAP Customer Activity Repository.

For more information on installing SAP HANA Live for SAP ERP, see [k help.sap.com/hba » Installation, Security,
Configuration, and Operations Information » Administrator's Guide » Administrator's Guide, SAP HANA Live for
SAP Business Suite 3.

Caution

SAP Customer Activity Repository does not require that you execute all of the installation steps exactly as they
are described in the Administrator's Guide, SAP HANA Live for SAP Business Suite. Be sure to read the
additional instructions for SAP Customer Activity Repository provided in this guide.

1

34

Process

Ensure that your back-end system is connected to SAP HANA Studio.
If necessary, set the connection as follows:
1. Logonto SAP HANA Studio.
2. Right-click in the Navigator pane and select Add System.
3. Enter the required information the Specify System dialog:
©  Hostname
o Instance Number
o System description

4.  Specify your system User Name and Password in the Connection Properties dialog.
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2. Map the authoring schema of the sap . hba.ecc content package to your particular physical database
schema. If the physical database schemais already called sap_Ecc, this schema mapping is not required.

Table 13
Authoring Schema Physical Schema
SAP ECC <Name of Your Schema for Storing SAP ERP

Data>

For more information, see:

© | help.sap.com/hba » Installation, Security, Configuration, and Operations Information » Administrator's
Guide » Administrator's Guide, SAP HANA Live for SAP Business Suite ¥ Installation Steps 1.

o |» help.sap.com/hana_platform » Modeling Information » SAP HANA Modeling Guide » Mapping the
Authoring Schema to the Physical Schema 1.

3. Ensure that all the standard SAP ERP tables listed in SAP Notes 1782065, 1781992, and 1900038 are present
on your SAP HANA database.

The presence of these tables on the SAP HANA database is required so that the content package of SAP
HANA Live for ERP can be deployed and activated correctly.

4. Deploy the SAP HANA Live for ERP content package on the SAP HANA database.

For more information, see lF help.sap.com/hba » Installation, Security, Configuration, and Operations
Information » Administrator's Guide » Administrator's Guide, SAP HANA Live for SAP Business Suite »
Installation Steps 1.

5. Ensure that the views included in the content package sap . hba.ecc have been activated.

The subset of the views required by SAP Customer Activity Repository is listed in SAP HANA Live for SAP
ERP Views Required by SAP Customer Activity Repository [page 106].

For more information on activating views, see [r help.sap.com/hana_platform » Development Information »
SAP HANA Developer Guide » Setting Up the Analytic Model » Creating Views » Activating Objects 1.

41.15 Create SAP CRM Table Definitions

The presence of an SAP CRM system in your landscape is optional. If you do not have an SAP CRM system in your
landscape, you need to create a set of “dummy” SAP CRM tables. These tables are required for the successful
activation of views in the SAP HANA content.

If you have an SAP CRM system in your landscape and you are planning to use the standard SAP implementation
of customer identification delivered with SAP Customer Activity Repository, you additionally need to set up the
SAP CRM table replication as described in Replicate SAP CRM Tables for SAP Customer Activity

Repository [page 40].

1 Note

Before you proceed, identify whether your back-end system will integrate with a source SAP CRM system. For
example, if you have an operational SAP CRM system, you could access this system from SAP Customer
Activity Repository to retrieve information about customers who use loyalty cards at the point of sale.

If your back-end system will not integrate with a source SAP CRM system, read and implement SAP Note
1909488.
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If your back-end system will integrate with a source SAP CRM system, read and implement the following
process.

Process

1. Ensure that the SAP LT Replication Server is installed and that a user with the appropriate authorizations is
set up in the target SAP HANA database.

If you have already ensured proper installation of the SAP LT Replication Server during previous procedures,
skip to the next step. Otherwise, refer to one of the following for more information:

o |k help.sap.com/hana_platform » Installation and Upgrade Information » SAP HANA Replication
Installation Guides 3

© |p help.sap.com/hana_platform » System Administration and Maintenance Information » Application
Operations Guide — Trigger-Based Data Replication Using SAP LT Replication Server for SAP HANA »
Technical Prerequisites and Authorization Aspects 3

2. Setupauserinthe source SAP CRM system and grant relevant authorizations to this user.

For more information, see |k help.sap.com/hana_platform » Installation and Upgrade Information » SAP
HANA Replication Installation Guides » System Connections and Authorizations 3.

3. Specify a configuration in SAP LT Replication Server, which contains the definition of the connections
between:

o The source SAP CRM system and the SAP LT Replication Server
0 The SAP LT Replication Server and the target SAP HANA database

For more information, see |F help.sap.com/hana_platform » System Administration and Maintenance
Information » Application Operations Guide — Trigger-Based Data Replication Using SAP LT Replication Server
for SAP HANA » Accessing the Configuration and Monitoring Dashboard 3.

The name that you assign to your configuration will be also be used as the name of the database catalog
schema that is automatically created on the target SAP HANA database. This is the schema to which you will
replicate the tables from the source SAP CRM system.

Once you save the configuration, a schema GUID and a mass transfer ID are automatically created and
assigned to the configuration. Furthermore, several dictionary tables are automatically replicated from your
source system to your target SAP HANA database.

For more information, see |F help.sap.com/hana_platform » System Administration and Maintenance
Information » Application Operations Guide — Trigger-Based Data Replication Using SAP LT Replication Server
for SAP HANA » Important Transactions and Control Tables 1.

4. Replicate table definitions from SAP CRM by reading and implementing SAP Note 1938004.

41.2 Post-Installation

The following diagram depicts the post-installation process for SAP Customer Activity Repository 2.0.
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Figure 9

41.2.1 Activate SAP HANA Content for SAP Customer
Activity Repository

In this procedure, you activate all SAP HANA content (SAP HANA views and SQLScript procedures) required by
SAP Customer Activity Repository.

For more information about activating SAP HANA content, see SAP Help Portal at [F help.sap.com/
hana_platform » Development Information » SAP HANA Developer Guide » Setting Up the Analytic Model »
Creating Views » Activating Objects 1.

Prerequisites

As a mandatory prerequisite for a successful activation of the SAP HANA content for SAP Customer Activity
Repository, you must have successfully completed all of the procedures listed in the previous sections of this
guide.

Procedure

1. Ensurethatthe sys REPO user has the authorizations required to successfully activate SAP HANA content.

1. Provideuser sys REPO with object privilege SELECT, with option "Grantable to others", on the following
physical DB schemas:
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o Physical database schema of your back-end system, typically this is called SAP<SID>.
o Physical database schema that contains the SAP ERP tables

©  Physical database schema that contains the SAP CRM tables

You can use the following example SQL statement to grant the required privilege:

GRANT SELECT ON <Your schema name> TO _SYS REPO WITH GRANT OPTION;

2. Assign the required privileges described in [F help.sap.com/car » Integration Information »
Administrator’s Guide, Demand Data Foundation (DDF) with Unified Demand Forecast (UDF) on SAP
HANA » Authorization Requirements for Unified Demand Forecast (UDF) 1.

2. Use transaction SE38 to run program /CAR/ACTIVATE HANA CONTENT.

The program activates all SAP HANA content required by SAP Customer Activity Repository. Note that this
includes the SAP HANA content for DDF and UDF.

Log on to SAP HANA studio.
Open the Modeler perspective and use the Navigator to access your back-end system.

Expand the Content folder located under your system name in the Navigator.

o o o~ W

Expand each of the packages listed below and ensure that all the content in the underlying folders is active:
O sap.is.ddf

O sap.is.udf

O sap.is.retail.car

O sap.is.retail.ecc

O sap.is.retail.posdm

O sap.is.retail.syndication

412.2 Replicate SAP ERP Tables for SAP Customer Activity
Repository

In this procedure, you ensure that all SAP ERP tables that are relevant for SAP Customer Activity Repository have
not only been created but have also been filled with data. More specifically, you replicate the contents of relevant
tables from the source SAP ERP system to your back-end system.

The steps outlined in this procedure are required when you are implementing one of the SAP Customer Activity
Repository system landscape variants that require data to be replicated from a source SAP ERP system. If your
source SAP ERP system and the repository are co-deployed on the same SAP HANA database, proceed to the
next procedure. For more information, see System Landscape Variants [page 13].

Procedure

1. Define client transformation rules for all SAP ERP tables that you plan to replicate.

In most cases, you need to apply transformation rules to map the client of the source SAP ERP system to the
client on the target SAP Customer Activity Repository system.
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Caution

Transformation rules must be defined prior to replicating tables.

For more information, refer to one of the following:
o Set Up SAP Client [page 28]

o |k help.sap.com/hana_platform » System Administration and Maintenance Information » Application
Operations Guide — Trigger-Based Data Replication Using SAP LT Replication Server for SAP HANA » Data
Transformation Capabilities within SAP Landscape Transformation Replication Server 3

o  SAP Note 1733714
2. Specify which SAP ERP tables to replicate.

We recommend that you only replicate data for SAP ERP tables that are relevant to SAP Customer Activity
Repository. Read SAP Note 1897024 and replicate only the tables listed in the file attached to this SAP Note.

However, if you are planning to use all of SAP HANA Live for SAP ERP views, then replicate all the tables
listed in the file attached to SAP Note 1781992.

For more information, see:

o |» help.sap.com/hba » Installation, Security, Configuration, and Operations Information » Administrator's
Guide » Administrator's Guide, SAP HANA Live for SAP Business Suite » Configuration Steps » Replicate
Data (Side-by-Side Only) 3

o |k help.sap.com/hana_platform » System Administration and Maintenance Information » Application
Operations Guide — Trigger-Based Data Replication Using SAP LT Replication Server for SAP HANA »
(<Managing the Replication Process Using the SAP HANA Studio> and <Important Transactions and
Control Tables>) » 1

Caution

This procedure includes the replication of tables from your source SAP ERP system. Trigger-based
replication includes deletion in source tables by archiving activities (since on the database level it is
impossible to distinguish between delete actions caused by archiving and regular deletion of data records).
As aresult, SAP LT (Landscape Transformation) Replication Server replicates archiving activities as delete
actions in the SAP HANA database.

More specifically, when data is archived in your source SAP ERP system, records are deleted from their
respective database tables. Therefore, when these tables are replicated to another SAP HANA database,
the records that were archived in the source tables are deleted in the target database tables.

For example, sales document data is set up to be replicated from your source SAP ERP system to your
target SAP HANA database. You may have set up your SAP ERP system to archive sales documents that
are more than a year old. Given the SAP ERP archiving settings, in the SAP Customer Activity Repository
system, you will not be able to run analytic reports on multichannel transaction data (which includes
replicated SAP ERP sales documents) that is more than a year old.

When deciding on the frequency at which to archive data in the source SAP ERP system, you must consider
and balance the performance requirements of your SAP ERP system and the amount of historical data that
must be available in the SAP Customer Activity Repository system for analysis. The general
recommendation is that 18 to 24 months of historical sales data is available in the repository.
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412.3 Replicate SAP CRM Tables for SAP Customer Activity
Repository (Optional)

In this optional procedure, you set up the replication of tables from your SAP CRM source system. You only need
to perform this procedure if you have an SAP CRM system in your SAP Customer Activity Repository landscape
and you are planning to use the standard SAP implementation of customer identification delivered with the SAP
Customer Activity Repository.

Procedure

1. Define client transformation rules for all the SAP CRM tables that you plan to replicate.

In most cases, you need to apply transformation rules to map the client of the source SAP CRM system to the
client on the target SAP Customer Activity Repository system.

Caution

Transformation rules must be defined prior to replicating tables.

For more information, refer to one of the following:
o Set Up SAP Client [page 28]

© |» help.sap.com/hana_platform » System Administration and Maintenance Information » Application
Operations Guide — Trigger-Based Data Replication Using SAP LT Replication Server for SAP HANA » Data
Transformation Capabilities within SAP Landscape Transformation Replication Server 3

o SAP Note 1733714
2. Read SAP Note 1897025 and replicate the tables listed in the . txt file attached to this SAP Note.
For more information, see [F help.sap.com/hana_platform » System Administration and Maintenance

Information » Application Operations Guide — Trigger-Based Data Replication Using SAP LT Replication Server
for SAP HANA 1.

41.2.4 Generate Time Data

In this procedure, you generate time data that is required by time-dependent views included in SAP HANA content
for SAP Customer Activity Repository. In particular, time data is required for all query views that are based on one
of the Sales Analysis virtual data models.

Caution

If you are not using the time-dependent views provided in SAP HANA content for SAP Customer Activity
Repository, you do not need to execute this procedure.

For example, if you are using SAP Assortment Planning for Retail, you use the time objects 0F1SCPER (fiscal
year period) and 0FISCVARNT (fiscal year variant) provided as part of the technical Bl Content. For more
information, see Activate Technical Content [page 80] and Maintain Fiscal Year Variant [page 87].
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Procedure
1. Logonto SAP HANA studio.
2. Inthe Modeler perspective, on the Quick Launch tab, select your SAP Customer Activity Repository system
and choose Generate Time Data.
3. Select the Calendar Type.
SAP HANA views included in SAP HANA content for SAP Customer Activity Repository require the presence
of timedatain sys BI.TIME DIMENSION* SAP HANA database tables. To populate these tables, select
Gregorian as the Calendar Type.
The Fiscal Calendar Type is not recommended. For analytical reports on a particular fiscal period, the SAP
HANA views included in SAP HANA content for SAP Customer Activity Repository do not rely on the
_SYS BI.M FISCAL CALENDAR SAP HANA database tables. Instead, SAP HANA content for SAP Customer
Activity Repository uses the sap.hba.ecc/Fiscal* views for fiscal period-based reporting.
4. Enter arange of years that includes all the years of data that you plan to store in SAP Customer Activity
Repository.
Example
If you plan to start using SAP Customer Activity Repository on January 1, 2014, enter 2014 as your starting
year. But if you plan to access sales documents created in SAP ERP that date from January 2013, you
should specify 2013 as your starting year.
5. Define the granularity as Day, which is the minimum granularity required by SAP Customer Activity
Repository. You can choose a finer level of granularity, for example Hour, if necessary.
6. Choose the day that is the first day of the week in your company.
7. Choose Generate.

For more information, see:

Ir help.sap.com/hba » Installation, Security, Configuration, and Operations Information » Administrator's
Guide » Administrator's Guide, SAP HANA Live for SAP Business Suite » Configuration Steps » Generate Time
Data 1

IF help.sap.com/hana_platform » Development Information » SAP HANA Developer Guide » Generate Time
Data 3

4125 Configure SAP Smart Business for Multichannel

Sales Analytics (Optional)

41.2.5.1 Activate SAP HANA Content for SAP Smart

Business for Multichannel Sales Analytics
(Optional)

In this procedure, you activate all SAP HANA content required by the SAP Smart Business for Multichannel Sales
Analytics dashboards.
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Prerequisites

You have completed activating all SAP HANA content (SAP HANA views and SQLScript procedures) required by
SAP Customer Activity Repository.

For more information, see Activate SAP HANA Content for SAP Customer Activity Repository [page 37].

Procedure
1. Logontothe ABAP instance of the SAP Customer Activity Repository system.
2. Execute transaction SE38.
3. Specify SNHI_NHDU POST_PROCESS in the Program field and choose Execute.
4. If you are running SAP NetWeaver 7.4 SPO5 or higher, make the following entries:
Table 14
Transport Container Name /CAR/HCO_RTLCAR_MCSA
Activate Delivery Unit Content Select the checkbox.
Activate HTC Do not select the checkbox.

5. Choose Execute.

All objects belonging to the delivery unit will be activated in the SAP HANA repository. This process can take
several minutes. Once the activation process is complete, you are notified whether or not the import and
activation of the SAP HANA delivery unit was successful.

4125.2 Configure SAP NetWeaver Gateway

412521 Perform General SAP Gateway Configuration

Prior to connecting the SAP Gateway on your front-end server to your back-end system, you need to perform a
series of general SAP Gateway configuration steps. These configuration steps include the setting of profile
parameters, ICF (Internet Communication Framework) services, language settings, and so on.

These steps are not specific to this installation guide and are described in the SAP NetWeaver product
documentation referenced below.

Procedure

Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o SAP Gateway for SAP NetWeaver 7.31

Seer help.sap.com/nwgateway?20 » Application Help » SAP NetWeaver Gateway » SAP NetWeaver
Gateway Configuration Guide » Basic Configuration Settings 1.
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o SAP Gateway for SAP NetWeaver 7.40

See|r help.sap.com/nw74 » Application Help » Function-Oriented View » SAP NetWeaver Gateway
Foundation (SAP_GWFND) » SAP NetWeaver Gateway Foundation Configuration Guide » Basic
Configuration Settings 2.

4125.2.2 Connect SAP Gateway to your Back-End System

In this procedure, you configure the OData channel, that is, set up a connection between SAP Gateway on your
front-end server and your back-end system.

These steps are not specific to this installation guide and are described in the SAP NetWeaver product
documentation referenced below.

Procedure

1. Setupthe required roles on the front-end server and assign your user to these roles.

For more information, see [k help.sap.com/nw74 » Application Help » Function-Oriented View » SAP
NetWeaver Gateway Foundation (SAP_GWFND) » SAP NetWeaver Gateway Foundation Configuration
Guide » OData Channel Configuration » User, Developer and Administrator Authorizations 1.

2. Specify the connection settings on the SAP Gateway hub system, which include:
o Connection from the SAP Gateway to consumer systems

These settings allow the connection between the SAP Gateway host and the consumer systems (clients
from which you access the SAP Fiori user interfaces.)

o Connection from the SAP Gateway to SAP back-end system
These settings allow the connection between SAP Gateway to your back-end system.
These settings include:
o Creating a type 3 connection from the SAP Gateway host to your back-end system.
o Defining a trust relationship between your back-end system and the SAP Gateway host.
o Configuring your back-end system to accept SAP assertion tickets from the SAP Gateway host.
o Configuring your SAP Gateway host to accept SAP assertion tickets from your back-end system.

o Configure the necessary system aliases.

More Information

For SAP NetWeaver 7.31, see SAP Library for SAP NetWeaver Gateway on SAP Help Portal at [p help.sap.com/
nwgateway20 » Application Help » Support Package Stack » SAP NetWeaver Gateway » SAP NetWeaver Gateway
Configuration Guide » OData Channel Configuration » Connection Settings on the SAP NetWeaver Gateway Hub
System 1.

For SAP NetWeaver 7.4, see SAP Library for SAP NetWeaver on SAP Help Portal at [p help.sap.com/nw74 »
Application Help » Function-Oriented View » SAP NetWeaver Gateway Foundation (SAP_GWFND) » SAP
NetWeaver Gateway Foundation Configuration Guide » OData Channel Configuration » Connection Settings on the
SAP NetWeaver Gateway Hub System 1.
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41.2.5.2.3 Activate SAP Gateway

Before you can use SAP Gateway functionality, you have to activate it globally on your front-end server.

These steps are not specific to this installation guide and are described in the SAP NetWeaver product
documentation referenced below.

Procedure

1. Determine the SAP NetWeaver version of your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:

©  For SAP NetWeaver 7.4, see SAP Help Portal at |» help.sap.com/nw74 » Application Help » Function-
Oriented View » SAP NetWeaver Gateway Foundation (SAP_GWFND) » SAP NetWeaver Gateway
Foundation Configuration Guide » OData Channel Configuration » Activating SAP NetWeaver Gateway 1.

©  For SAP NetWeaver 7.31, see SAP Help Portal at |p help.sap.com/nwgateway20 » Application Help » SAP
NetWeaver Gateway Configuration Guide » SAP NetWeaver Gateway Configuration Guide » OData
Channel Configuration » Activating SAP NetWeaver Gateway 1.

4.1.2.5.2.4 Activate Common OData Services

A number of OData services are required to run the SAP Fiori Launchpad. These OData services are delivered with
the central Ul component (SAP_UI 740 SP11 orequivalent).

For security reasons, all OData services are delivered in an inactive state. To use the SAP Fiori Launchpad, you
must activate the common SAP Fiori OData services.

Procedure

Log on to your front-end system (your SAP Gateway system).
2. Go to Customizing (transaction SPRO).

3. Navigate tolr SAP NetWeaver » Gateway » OData Channel » Administration » General Settings » Activate
and Maintain Services 1.

You are presented with the service catalog. This is a list of all the services that are currently active on your
SAP Gateway.

4. Get common SAP Fiori OData services:
1. Choose Add Service.
The Add Service screen is displayed.
2. Enter the system alias of your local front-end system.

This is the alias created in the Connect SAP NetWeaver Gateway to your Back-End System [page 43]
procedure. For example, LOCAL.

Enter /u12* in the Technical Service Name field.

Choose Get Services.
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The Add Selected Services screen is displayed.

5. Select the common SAP Fiori OData services that you would like to activate, and choose Add Selected
Services.

Table 15

Service Name

/UI2/PAGE BUILDER CONF

/UI2/PAGE BUILDER CUST

/UI2/PAGE BUILDER PERS

/UI2/TRANSPORT

/UI2/INTEROP

The selected OData services are now active in your SAP Gateway.

More Information

® For SAP NetWeaver 7.31, see SAP Library for User Interface Add-On 1.0 on SAP Help Portal at
|F help.sap.com/nw-uiaddon » Application Help » User Interface Add-On for SAP NetWeaver » SAP Fiori
Launchpad » Setting Up the Launchpad » Activating SAP NetWeaver Gateway OData Services 1.

® For SAP NetWeaver 7.4, see the documentation on SAP Help Portal at [r help.sap.com/nw74 » Application
Help » Ul Technologies in SAP NetWeaver » Ul Frameworks based on HTML5, JavaScript and CSS » SAP Fiori
Launchpad » Setting Up the Launchpad » Activating SAP NetWeaver Gateway OData Services 1.

412.5.3 Configure the SAP Web Dispatcher

To configure the SAP Web Dispatcher, see SAP Help Portal at [p help.sap.com/nw_platform » Application Help »
Function-Oriented View » Application Server » Application Server Infrastructure » Components of SAP NetWeaver
Application Server » SAP Web Dispatcher » Administration of the SAP Web Dispatcher 1.

If you use any other reverse proxy, see the manufacturer’'s documentation for more information.

41254 Configure Central Ul Component

The central Ul component (SAaP_UI 740 SP11 or equivalent) contains the SAP UI5 control library and the SAP
Fiori Launchpad. Prior to being able to use the SAP Fiori apps that constitute the user interface of the retail
applications described in this guide, you may need to configure the SAP Fiori Launchpad.

These steps are not specific to this installation guide and are described in the SAP NetWeaver product
documentation referenced below.
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Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o SAP Gateway for SAP NetWeaver 7.31
o |» help.sap.com/nw-uiaddon » Application Help » SAP Fiori Launchpad 3, and

o |» help.sap.com/nw-uiaddon » Application Help » Administration Guide » Content Administration »
SAP Fiori Launchpage » Setting Up the SAP Fiori Launch Page 1.

o  SAP Gateway for SAP NetWeaver 7.40

o |k help.sap.com/nw74 » Application Help » Ul Technologies in SAP NetWeaver » Ul Framework based
on HTML5, JavaScript and CSS » SAP Fiori Launchpad 3, and

o |k help.sap.com/nw74 » Application Help » Ul Technologies in SAP NetWeaver » Ul Framework based
on HTML5, JavaScript and CSS » SAP NetWeaver User Interface Services » Administration Guide »
Content Administration » SAP Fiori Launchpage » Setting Up the SAP Fiori Launch Page 1.

41255 Configure SAP Jam (Optional)

Your retail application uses collaboration SAPUI5 components to define key ABAP-based SAP business object
data that can be consumed by SAP Jam.

If you are using the SAP Jam social collaboration platform in your business, you can configure the integration
between your retail application and SAP Jam. The integration, enabled by Social Media Integration, allows you to
share, or expose, the pre-defined ABAP-based SAP business object data directly from your retail application with
members of your organization, through SAP JAM.

The steps to enable the integration between your retail application and SAP Jam are not specific to this
installation guide and are described in the User Interface Add-On 1.0 for SAP NetWeaver product documentation
referenced below.

Prerequisites

To enable the integration of your retail application with SAP Jam, you must have a license for SAP Jam Enterprise
edition and your SAP Jam instance must be configured for productive use.

Procedure

1. Readthe documentation for User Interface Add-On available on SAP Help Portal at [p help.sap.com/
netweaver » User Interface Add-On for SAP NetWeaver » Application Help » Social Media Integration 1.

This documentation provides important information on configuring the integration of your retail application
with SAP Jam, including:

o Understanding the Overall Process for Integrating Collaboration for a Business Object
o Implementation of ABAP Social Media Integration (ABAP SMI)

o Implementation of Collaboration SAPUI5 Components
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o Connecting SAP Jam with ABAP SMI
o Configuring ABAP SMI for SAP Fiori Apps

More Information

For the latest updates on SAP Jam, see the SAP Help Portal at help.sap.com/sapjam.

41.2.6 Install and Configure On-Shelf Availability (Optional)

1 Note

The steps in this section and all subsections are entirely optional and depend on your specific implementation
requirements.

To use the On-Shelf Availability (OSA) functionality in SAP Customer Activity Repository, perform the following
post-installation steps.

412.6.1 Install the Application Function Library

The On-Shelf Availability (OSA) algorithms are implemented as a separate application function library (AFL) that
you install and run in the SAP HANA database. The AFL releases are called “revisions”. The AFL software
component version is POSAFL INST 100.

For a list of the available revisions and for installation instructions, see SAP Note 2056102.

412.6.2 Generate Run IDs for OSA Processing Steps

Each scheduled run of an OSA processing step has a generated run ID. This is the unique identification for a job.
The run ID is used to distinguish several runs within one period. Each processing step has its own ID generator:

Table 16
Intraweek Pattern /OSA/NR_IWP
Estimation /OSA/NR_EST
Monitoring /OSA/NR_MON
Analysis /OSA/NR_ANA

For each of the four transactions, you must define the range of run IDs.
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Procedure

1. Execute transaction /OSA/NR <XXX>. <XXX>represents the part of the transaction name that is specific for
a processing step.
2. Inthefirst row of the table, enter the following values for the fields No, From No. and To Number:
o No:01
©  From No.: 0000000000000001
o To Number: 9999999999999999

4.1.2.6.3 Check Field Contents in SAP HANA Content for On-
Shelf Availability

There are two OSA-specific SAP HANA views that can be customized:
e AN TRANSACTION
e PROMOTION TRANS

You have to check if the fields in these views contain the mappings or formulas you need.

Caution
If you need to modify any of the views, be aware, that new installation will rewrite the modifications. It is
therefore recommended to back up the modified views.

Procedure

If you want to change the mapping or a formula of a field, perform the following steps:

1. Define the data foundation that is the source for the view, that is, the table /POSDW/TLOGF.
2. Define filters for the view.

3. Map the fields from source to target.

4. Create measures and calculation fields.

For detailed information, see [r help.sap.com/hana_appliance » Modeling Information 3.

Definitions for a view taking the example of the AN_TRANSACTION view

The following definitions are set by default for the AN TRANSACTION view:
® Source of the view is the table /POSDW/TLOGF
e [Examples of filters for the views:
© RECORDQUALIFIER = '5':0Only sales records are used
O DATASTATUS in ('2' , '3'"):Onlythose records are used which passed the SAP Customer Activity
Repository validation
O RETAILQUANTITY > 0.0:Negative quantities are not used by On-Shelf Availability

© VOIDEDLINE = '':Cancelledtransactions are not used by On-Shelf Availability

® Examples of the fields mappings:
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o MANDT: Clientid. This field is mapped to the MANDT column of the /POSDW/TLOGF table.
© STORE_ID: Storeid. This field is mapped to the RETAILSTOREID column of the /POSDW/TLOGF table.

© BUSINESSDAYDATE: Business day. This field is mapped to the BUSINESSDAYDATE column of the /
POSDW/TLOGF table.

® Examples of measures:

O  RETAILQUANTITY: Amount of sold units. Refers to the saLEsUOM (Sales Unit of Measure) field that is
also defined in the /POsDW/TLOGF table. Contains the value of the RETATLQUANTITY field.

©  PRICE: Price specified in the store currency. Contains the value of the ACTUALUNITPRICE field.
e Examples of calculated fields:

© TRANS TIME DBL:Value of the TRANS TIME output field of type DOUBLE. The format of the transaction
time that is stored in BEGINTIMESTAMP and ENDTIMESTAMP is “YYYYMMDDhhmmss".

©  DISCOUNT: Total relative discount applied on the item.

Calculated as (ITEMDISC + DISTDISC) / (RETAILQUANTITY * ACTUALUNITPRICE). If the price is not
positive number, O is returned.

Definitions:
o DISTDISC: global discount on the whole purchase; currently not used.

© |ITEMDISC: item-specific discount; currently used.

41.2.6.4 Activate SAP HANA Content for On-Shelf
Availability

In this procedure, you activate all SAP HANA content required by On-Shelf Availability.

Procedure
1. Logontoyour back-end system.
2. Execute transaction SE38.
3. Specify SNHI NHDU POST PROCESS inthe Program field and choose Execute.
4. Ifyou are running SAP NetWeaver 7.4 SPO5 or higher, make the following entries:
Table 17
Transport Container Name /OSA/HCO_POSDMEXT
Activate Delivery Unit Content Select the checkbox.
Activate HTC Do not select the checkbox.

5. Choose Execute.

All objects belonging to the delivery unit will be activated in the SAP HANA repository. This process can take
several minutes. Once the activation process is complete, you are notified whether or not the import and
activation of the SAP HANA delivery unity was successful.
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41.2.6.5 Verify that SAP HANA Content for On-Shelf
Availability has been activated

Procedure

Log on to SAP HANA studio.

Open the Modeler perspective.

In the Navigator window, expand the database system for which you have activated the views.
Expand the Content folder.

Expand the package hierarchy by choosing |» sap » is » retail » posdmext » osa 1.

QNRC I S

Verify that the following views have been activated:
O sap.is.retail.posdmext.osa.tlog.an transaction
O sap.is.retail.posdmext.osa.tlog.promotion trans
O sap.is.retail.posdmext.osa.status log view
O sap.is.retail.posdmext.osa.reporting.MON ANA VIEW
O sap.is.retail.posdmext.osa.reporting.STATUS LOG VIEW
7. Verify that the following procedures have been activated:
1. Proceduresinthe package sap.is.retail.posdmext.osa.common:
© CREATE_LOG_ENTRY
© PARSE HOLIDAY STRING
© PARSE TYPE CODE STRING
2. Proceduresinthe package sap.is.retail.posdmext.osa.tlog.dao:
© GET TRX FOR PRODUCT
O GET TRX FOR STORE
© GET TRX FOR SUBDEP
© GET TRX FOR SUBDEP WITH MIN
O GET TRX INFO FOR PRODUCT
© GET TRX FOR SUBDEP CURRENCY
3. Proceduresinthe package sap.is.retail.posdmext.osa.pattern.dao:
o PERSIST
© GET INTRA WEEK PATTERN RUNS
© GET INTRA WEEK PATTERN LATEST
© GET INTRA WEEK PATTERN
© GET_INTRA WEEK PATTERN FOR PRODUCT
4. Proceduresinthe package sap.is.retail.posdmext.osa.pattern.runner.internal:
© CALL FUNCTION
© CALL ALGO FOR STORE
© CALL ALGO FOR SUBDEP
© CALL ALGO PRODUCT IN SUBDEP

5. Proceduresinthe package sap.is.retail.posdmext.osa.pattern.runner.public:
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© RUN_FOR_PRODUCT IN SUBDEP
© RUN _FOR_STORE

© RUN FOR_SUBDEP

6. Procedureinthe package sap.is.retail.posdmext.osa.pattern.test:
© TEST L INTEGRATION
7. Procedure inthe package sap.is.retail.posdmext.osa.estimation.config:
© GET CONFIG
8. Proceduresinthe package sap.is.retail.posdmext.osa.estimation.dao:
O PERSIST
o GET_PARAMETER
o GET PARAMETERS
9. Proceduresinthe package sap.is.retail.posdmext.osa.estimation.runner.internal:
o CALL FUNCTION
© CALL ALGO PRODUCT IN SUBDEP
10. Procedure in the package sap.is.retail.posdmext.osa.estimation.runner.public:
© RUN FOR_PRODUCT IN SUBDEP
11. Procedure inthe package sap.is.retail.posdmext.osa.estimation.test:
© TEST L INTEGRATION
12. Procedures inthe package sap.is.retail.posdmext.osa.monitor.dao:
O PERSIST
© CREATE_STATUS LOG ENTRIES
o UPDATE_STATUS_TABLE
© CREATE STATUS LOG _ENTRIES FOR EXCL PRODUCTS
o UPDATE_STATUS TABLE FOR EXCL_PRODUCTS
13. Procedures in the package sap.is.retail.posdmext.osa.monitor.runner.internal:
© CALL FUNCTION
© CALL ALGO PRODUCT IN SUBDEP
© RUN FOR_PRODUCT IN SUBDEP
14. Procedures inthe package sap.is.retail.posdmext.osa.monitor.runner.public:
© GET QUALIFIED PRODUCT FOR RUNNER
©  RUN_MONITOR
15. Procedure in the package sap.is.retail.posdmext.osa.monitor.test:
© TEST L INTEGRATION
16. Procedureinthe package sap.is.retail.posdmext.osa.analysis.calc:
© COMPUTE LOST SALES
17. Procedure in the package sap.is.retail.posdmext.osa.analysis.dao:
O PERSIST
18. Proceduresinthe package sap.is.retail.posdmext.osa.analysis.runner.internal:
© CALL FUNCTION
© CALL ALGO PRODUCT IN SUBDEP
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19. Procedure in the package sap.is.retail.posdmext.osa.analysis.runner.public:

© RUN FOR PRODUCT IN SUBDEP

41.2.6.6 Configure SAP NetWeaver Gateway and Activate
OData Service

This configuration step is only required if you use separate products or developments on top of SAP Customer
Activity Repository that communicate via OData service. After you have installed SAP NetWeaver Gateway,
configure the Gateway system and configure the settings for OData service.

Procedure

The main steps to do this are as follows:

Activate SAP NetWeaver Gateway.

Define RFC connections from SAP NetWeaver Gateway to your back-end system.
Define settings for OData service for the SAP NetWeaver Gateway.

Define settings for Push Functionality (optional).

Set up users and Authorizations for SAP NetWeaver Gateway.

S N

Activate the OData Service in the SAP NetWeaver Gateway system (transaction /IWFND/maint service)
for the requested URI (for example: /sap/opu/sdata/OSA/ON_SHELF AVAILABILITY/).

For detailed information, see SAP Library for SAP NetWeaver Gateway on SAP Help Portal at ¢ help.sap.com/
nwgateway » Application Help » Support Package 06 » SAP NetWeaver Gateway Developer Guide » OData
Channel 1.

412.7 Ensure that Third Party CRM Sales Orders are
Transferred to SAP ERP (Optional)

Sales documents are accessed by SAP Customer Activity Repository (either through replication or direct data
access) from a source SAP ERP system. One way that sales documents of type Sales Order can be generatedin a
SAP ERP system is through the transfer of sales orders created using an SAP CRM source system or a third party
CRM system.

When customers create sales orders using SAP CRM systems, these sales orders are inherently compatible to the
sales document structure in SAP ERP. They are transferred to SAP ERP via Data Exchange for Sales Orders: CRM
Enterprise — ERP System process. For more information, see SAP Library for SAP CRM on SAP Help Portal at
help.sap.com/crm. Select the applicable version of SAP CRM and under Application Help, open SAP Library and
choose |k Basic Functions » Business Transaction » Data Exchange for Business Transactions J.

Customers who use third party CRM systems to create sales orders, and who want to access these sales orders
from SAP Customer Activity Repository, must ensure that their sales order data:

® |ncludes the information required by SAP Customer Activity Repository
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® Has been transferred to SAP ERP prior to being able to access this data from SAP Customer Activity
Repository

Procedure

1. Read section SAP ERP Sales Document Fields used by SAP Customer Activity Repo [page 105] for
information on which SAP ERP sales document fields are required by SAP Customer Activity Repository.

You have to ensure that the fields required by SAP Customer Activity Repository are filled during the transfer
of sales order data from your third party CRM system to SAP ERP.

2. Ensure that sales order data has been transferred from your third party CRM system to SAP ERP.

4128 Partition /POSDW/TLOGF Table (Optional)

SAP Customer Activity Repository application contains the Point of Sale Data Management software component
version RTLPOSDM 200 which is used to receive a large volume of data from your connected stores. Point of Sale
Data Management, or more specifically, its POS Inbound Processing Engine (PIPE), processes the incoming
transactions and stores them in the /POSDW/TLOGF table.

Since every transaction line item is stored as a separate row in the /POSDW/TLOGF table, the table can quickly
grow to become very large. To improve standard database operations, such as inserting, updating, deleting and
reading and mass operations, such as archiving or index merging, SAP recommends that you partition the /
POSDW/TLOGF table.

Also, you can select to store extension segments in a dedicated /POSDW/TLOGF_EXT table using the Store
Extensions in Separate Table option of the Define General Settings Customizing activity. Table /PosDu/
TLOGF EXT should be partitioned in the same way as the /POSDW/TLOGF table.

For more information on extension segments, see the Appendix of the Operations Guide, SAP Customer Activity
Repository.

1 Note

Partitioning is typically used in distributed system, but it may also be beneficial for single-host systems.

Procedure

1. Readthe Table Partitioning in the SAP HANA Database section of the SAP HANA Administration Guide.
2. Plan your partition specifications in accordance to the following guidelines:

o Asingle partition should not contain more than 1 billion rows.

©  The total amount of partitions of a single table should not exceed 1000.

©  Because the actual act of partitioning a table does use system resources, do not start partitioning the /
POSDW/TLOGF table until its volume has surpassed 250 million rows.

3. Partition your /POSDW/TLOGF (and, optionally the /POSDW/TLOGE EXT) table according to SAP Note
1719282.
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4129 Customize Copies of SAP HANA Views (Optional)

In this optional procedure, you create copies of views included in SAP HANA Live for SAP ERP or in the SAP HANA
content for SAP Customer Activity Repository. You then customize these copies to reflect your specific data
model extensions.

Caution
Do not modify standard SAP HANA content.

For example, you would need to execute this procedure if you have extended your POS transaction data model.
The views delivered with the SAP HANA content for SAP Customer Activity Repository are built on the standard /
POSDW/TLOGF table. If you have added custom fields to the /POSDW/TLOGF table, you will have to create views
that expose these fields.

In general, if you have extended any standard SAP data models, you must copy and adapt the standard SAP
HANA content.

Caution

If you have created a copy of a view shipped as part of the standard SAP HANA content and have made
modifications to this copy, a subsequent upgrade of SAP HANA Live for SAP ERP or SAP HANA content for
SAP Customer Activity Repository will not update your copied and modified version of the view. SAP Notes or
enhancements shipped by SAP will also have to be manually implemented on the copied, and subsequently
modified, SAP HANA content.

Procedure

Log on to SAP HANA studio.

2. Openthe Modeler and use the Navigator to access the folder that contains the view that you want to copy.
For example, | <Your System Name> » Content » sap » is » retail » car » Calculation Views 1.

Identify the view you want to copy. For example, sap.is.retail.car/POSSalesQuery.

Use the Auto Documentation feature of SAP HANA studio to identify all reuse and private views that are
consumed by your selected view, as well as any query views that might consume your view. To do so:

1. Right-click on the selected view, and choose Auto Documentation from the context menu.
2. Browse to the location where you want to save the file and choose Finish.
3. Openthe generated * . pdf£ file, and locate the Cross-References section of the document.

The Cross-References section displays the hierarchy of calculation (query, reuse, and private) views that
are accessed by the selected view. Affected underlying, as well as all consuming views, in this hierarchy
must also be copied and modified as a result of your extension.

For example, calculation views sap.is.retail.car/POSSales, sap.is.retail.car/POSLogItem,
and sap.is.retail.car/TLOGF ITEM COM are all consumingthe /POSDW/ TLOGEF table and are
consumed by the sap.is.retail.car/POSSalesQuery view. Therefore, if you have extended the /
POSDW/TLOGF table, all these views must be copied and modified.

5. Foreach view identified in the previous step, do the following:
1. Inthe Navigator panel, select an object and in the context menu, choose Copy.

2. Navigate to the package where you want to paste the view and choose Paste.
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1 Note

You must have write permissions on the target package to which you are pasting the view. Also, you
should copy the view to your own package. Do not modify the original sap package.

3. Modify the copied view as required.
For more information, see the Creating Views section of the SAP HANA Developer Guide.

4. Right-click on the copied and modified view and select Activate.

4.1.2.10 Install and Set Up Unified Demand Forecast (UDF)
(Optional)

UDF is a component in SAP Customer Activity Repository and provides the demand modeling and demand
forecasting services. The UDF algorithms are implemented and shipped as a separate application function library
(UDF AFL) that you install and run in the SAP HANA database.

1 Note

UDF requires the configuration of Demand Data Foundation (DDF), a cross-industry reusable data layer in SAP
Customer Activity Repository. In addition to the steps described in the Configure Demand Data Foundation
(DDF) [page 57] section, please see the Common Master Guide for additional configurations and integration
information. You can find this guide on SAP Help Portal at |» help.sap.com/car » Installation and Upgrade
Information » Master Guide 1.

4.1.2.10.1 Install the UDF AFL

In this procedure, you install the Unified Demand Forecast application function library (software component
version UDFAFL INST 100). Please note that you cannot do this installation using Maintenance Optimizer in SAP
Solution Manager (as you can with other components of SAP Customer Activity Repository). This is because the
UDF AFL is released independently and you need to download and install it as described in this section.

1 Note

We recommend that you always upgrade to the newest UDF AFL to benefit from all enhancements and
corrections.

Procedure

1. Readthe Component Version Dependencies section of the Administrator's Guide, Demand Data Foundation
(DDF) with Unified Demand Forecast (UDF) on SAP HANA.

You can find this guide on SAP Help Portal at ¢ help.sap.com/car » Integration Information » Administrator's
Guide, Demand Data Foundation (DDF) with Unified Demand Forecast (UDF) on SAP HANA 1.
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You need to be aware of the dependencies and minimum requirements described there to ensure that UDF
integrates with your Demand Data Foundation and SAP Customer Activity Repository system.

2. Readthe SAP Notes below and follow the instructions. The notes tell you where to download the UDF AFL
from SAP Service Marketplace and how to install it.

Table 18
2050229 Release and Upgrade Information | Overview of all independent releases (revisions)
for Unified Demand Forecast of the UDF AFL as of revision 82 on SAP HANA
Application Function Library (UDF | Platform SPS 08 revision 82; instructions for
AFL) installing or upgrading the UDF AFL using the
recommended installation tools, hdblcmor
hdblcmgui.
2004952 Migration of UDF AFL and POS AFL | Instructions for performing a mandatory one-
from SAP HANA AFL as of SAP time migration when upgrading from a UDF AFL
HANA Platform SPS 08 on SAP HANA Platform SPS 06 or SPS 07,
additional installation instructions.
1997526 SAP HANA lifecycle manager with | Information about SAP HANA tools that you can
SAP HANA Database SPS 08 use to install the UDF AFL. Please note that the
recommended tool depends on your edition of
the SAP HANA Platform.
1 Note

To use the recommended installation tools,
hdblcmgui or hdblcm, youneedtodoa
preparation step as described in the [» SAP
HANA Server Installation and Update

Guide » Download Software Components
from SAP Service Marketplace » Context 1.

You can find this guide on SAP Help Portal at
|F help.sap.com/hana_platform
Installation and Upgrade Information » SAP
HANA Server Installation and Update

Guide 1.

The preparation step involves running the
hdblcm prepare.sh shell script. You
must run this script before you start either
tool.

412.10.2 Complete UDF Setup

In this procedure, you complete setting up Unified Demand Forecast (UDF) to enable demand modeling and
forecasting. Optionally, you can also install a forecast visualization tool.
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Prerequisites

® You have installed the UDF AFL as described in the previous section.

e |fyouintend to use the optional visualization tool Unified Demand Forecast Launchpad, you are aware that
there are additional hardware requirements for it and have planned your system landscape accordingly. For
more information about those requirements, see the UDF Launchpad Installation Guide, which you can find in
SAP Note 1836357.

Procedure

1. Check which business functions you need to activate in your DDF system to be able to use UDF. For more
information, see Configure Demand Data Foundation (DDF) [page 57].

2. Setupthe users, roles, and privileges required for UDF. To do this, follow the instructions in the Authorization
Requirements for Unified Demand Forecast (UDF) section of the Administrator’s Guide, Demand Data
Foundation (DDF) with Unified Demand Forecast (UDF) on SAP HANA. You can find this guide at
IF help.sap.com/car » Integration Information » Administrator's Guide, Demand Data Foundation (DDF) with
Unified Demand Forecast (UDF) on SAP HANA 1.

3. Analyze and implement the following SAP Notes for UDF:

o 1898341: Updated information on configuration changes for demand modeling and forecasting
o 1911141: Setting UDF-specific performance optimization parameters in the SAP HANA database

4. Optional: Install and configure the visualization tool Unified Demand Forecast Launchpad.

1 Note
Using the UDF Launchpad is optional. You can download it from the SAP Store at store.sap.com. Please
note that the UDF Launchpad has been designed as a template. There is no product support and the user
interface is only available in English.
Please also note that there are additional hardware requirements for using the tool and that you must plan
your system landscape accordingly. For more information about those requirements, see the UDF
Launchpad Installation Guide, which you can find in SAP Note 1836357.

More information:

o Installing and configuring the UDF Launchpad: SAP Note 1836357 and the SAP Ramp-Up Knowledge
Transfer (SAP RKT) content for UDF

o Using the UDF Launchpad: [F help.sap.com/car » Application Help » SAP Library » SAP Customer
Activity Repository » Demand Data Foundation » General Services » Validate Forecasts with UDF
Launchpad 3

41211 Configure Demand Data Foundation (DDF)

1 Note
Required Configurations

The consuming applications and Unified Demand Forecast (UDF) on SAP Customer Activity Repository require
the configuration of the reusable data layer DDF. For more information, see Prerequisites [page 21]. In addition
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to the steps described in the following sections, please see the Common Master Guide for additional
configurations and integration information. You can find this guide on SAP Help Portal at [F help.sap.com/car »
Installation and Upgrade Information » Master Guide 3.

1 Note
Integration Scenarios

e \With the standard integration with an SAP ECC (SAP ERP Central Component) system, outbound data
replication using the data replication framework (DRF, transaction DRFOUT) is required for the SAP
Assortment Planning for Retail and SAP Promotion Management for Retail scenarios. For more
information, please see the Common Master Guide, which you can find on SAP Help Portal at
IF help.sap.com/car ¥ Installation and Upgrade Information » Master Guide 1.

® [ntegration with non-SAP ECC systems and multiple SAP ECC systems is possible for certain scenarios.

4.1.2.11.1 Activate DDF Business Functions

Some products residing in the ABAP back-end server may use data acquired and maintained in Demand Data

Foundation (DDF). If this is the case for your implementation, you must ensure that the relevant DDF business
functions are activated.

= Recommendation
® Business functions should be activated by a system administrator.
® Once a business function is active, we recommend that you do not deactivate it.

® Before activating a business function, read the corresponding business function documentation. For
information about DDF business functions, see SAP Library for SAP Customer Activity Repository on SAP
Help Portal at |» help.sap.com/car » SAP Library » SAP Customer Activity Repository » Demand Data
Foundation » Business Functions 3.

Procedure

1. Activate the following business functions:
© /DMF/DDF IMDB PL TD (Decompression of Product Location Price Data)
© /DMF/DDF IMDB TS (Decompression of Time Series Data)

2. If youuse demand modeling and forecasting with Unified Demand Forecast (UDF), activate the following
business functions in the following order:

© /DMF/FORECAST (Activation of Forecast Engine)
© /DMF/DDF_UDF (Activation of Unified Demand Forecast)
3. Activate additional business functions:

© /DMF/OFR_FIN CALC OPT (Optimizations for Offer Financials)
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= Recommendation

Although this business function is considered optional, we highly recommend that you activate it. With
the business function activated, you get significant improvements in memory and performance.

o Activate the optional business function /DMF/DDF IMDB LANE TD (Decompression of Lane Price and
Time Dependent Data) if applicable to your specific implementation scenario.

© Activate the optional business function /DMF/DDF IMDB OFR_FIN (Decompression of Offer Financials
Data) only if you want to store offer financials data on the database in a decompressed format. The
business function enables you to execute the /DMF/OFFER_FIN MIGRATION report for this purpose. For
more information, see the report documentation (transaction SE38).

More Information

SAP Help Portal at |F help.sap.com/car » Integration Information » Administrator's Guide, Demand Data
Foundation (DDF) with Unified Demand Forecast (UDF) on SAP HANA 2

412.11.2 Import SAP Enterprise Portal Roles for DDF

For user authorization, you can use the roles from the SAP NetWeaver Business Client software and the SAP
Enterprise Portal component. Both sets of roles operate in the same manner. Using the SAP Enterprise Portal is
optional.

The PFCG roles have been created for use in SAP NetWeaver Business Client. To use the functions of these roles
in SAP Enterprise Portal, you must upload the roles from the SAP system to SAP Enterprise Portal.

Procedure

1. Use the Role Upload tool to generate the SAP Enterprise Portal roles automatically.

You can also enhance the SAP Enterprise Portal roles; for example, you can create your own iViews. For more
information about the Role Upload tool, see SAP Note 1685257.

You can upload the following PFCG roles:
0 SAP ISR DDF MASTER

© SAP_ ISR _DDF READONLY MASTER

More Information

IF help.sap.com/car » Integration Information » Administrator’s Guide, Demand Data Foundation (DDF) with
Unified Demand Forecast (UDF) on SAP HANA » Standard Roles 2
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4.2 SAP Assortment Planning for Retail

421 Preparation

1 Note

Some of the activities in this section may have already been performed in the corresponding section under SAP
Customer Activity Repository [page 26]. Such activities do not need to be repeated during the setup and
installation of consuming applications.

4211 Verify SAP HANA Users and Privileges

Prior to installing the application, you need to ensure that the required database users exist, and that these users
have all the required privileges.

Procedure

1. Ensure that the SAP HANA database users listed below exist and that they have the required roles/privileges.

Table 19

SAP<SID> ®  System privilege REPO. IMPORT

This is the generic database user e  System privilege ROLE ADMIN

specified for the connectionfromthe | o g o privilege STRUCTUREDPRIVILEGE ADMIN

SAP NetWeaver back-end server to

the SAP HANA database. ® Role CONTENT_ADMIN

L Role AFL SYS AFL AFLPAL EXECUTE and privilege EXECUTE on

system.afl wrapper generatorand
system.afl wrapper eraser.Formoreinformation, see Enable
Usage of PAL Functions [page 61].

_SYS_REPO ®  Privilege SELECT, with option "Grantable to others", on the following
physical DB schemas:
©  Physical database schema of your back-end system, typically this is

called SAP<SID>
©  Physical database schema that contains the SAP ERP tables
o Physical database schema that contains the SAP CRM tables
You can use the following example SQL statement to grant the required
privilege:
GRANT SELECT ON <Your schema name> TO _SYS REPO
WITH GRANT OPTION;
®  Privileges described in[F help.sap.com/car } Integration Information »
Administrator’s Guide, Demand Data Foundation (DDF) with Unified
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Demand Forecast (UDF) on SAP HANA » Authorization Requirements for
Unified Demand Forecast (UDF) 1.

<Your User Name>* ® Privilege SELECT onschema SYS BI
® Privilege SELECT on schema SAP<SID>

® Privilege EXECUTE on procedure REPOSITORY REST

*Your user on SAP HANA database level, back-end system, and on the front-end server (SAP NetWeaver Gateway)
must be identical on these three levels.

4212 Configure AFL Usage

42121 Activate SAP HANA Script Server

Once all the required AFLs are installed, as listed in the Prerequisites [page 21] section, ensure that you have
activated the script server for the SAP HANA database.

Procedure

Read and implement SAP Note 1650957.

42122 Enable Usage of PAL Functions

The installation of SAP HANA Platform (SPS 08 or higher) includes the installation of SAP HANA AFL 1.0, which
contains the PAL algorithm, a prerequisite to the installation of SAP Assortment Planning for Retail.

To enable the usage of the PAL algorithm as required by SAP Assortment Planning for Retail, perform the
following procedure.

Procedure

1. Ensure that the SAP<SID> user has the role AFL. SYS AFL AFLPAL EXECUTE (there are 2 underscores
between AFL and SYS) as described in Verify SAP HANA User and Privileges [page 60].
This role must be assigned to execute functions of the PAL library. In the case of SAP Assortment Planning
for Retail, this role is necessary for the assortment planner to use smart clustering in the Manage Location
Clusters SAP Fiori app.

2. Ensure that the SAP<SID> user has the EXECUTE privilege of system.afl wrapper generator and
system.afl wrapper eraser.Forexample, if the user name is SAP<SID>, run the following commands:

GRANT EXECUTE ON system.afl wrapper generator to SAP<SID>
GRANT EXECUTE ON system.afl wrapper eraser to SAP<SID>
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This is also necessary for the assortment planner to use smart clustering in the Manage Location Clusters
SAP Fiori app.

You do not need to create the AFL. WRAPPER GENERATOR Of AFL_WRAPPER ERASER procedures, nor do you

need to generate any special PAL procedures. This is automatically done by SAP Assortment Planning for
Retail.

1 Note

If you have upgraded to SAP HANA Platform SPS 08 from an earlier release, your database user might
have lost the EXECUTE privilege of system.afl wrapper generator and

system.afl wrapper eraser duringthe upgrade. You will have to grant these privileges again, as
described in SAP Note 2022080.

3. Check the PAL installation. To confirm that the PAL functions were installed successfully, you can run
SELECT statements in the following three public views:

o sys.afl_areas
o sys.afl_packages

o sys.afl_functions

More Information

IF help.sap.com/hana_platform » Reference Information » SAP HANA Library References » SAP HANA Predictive
Analysis Library (PAL) Reference 2

4.2.2 Installation

1 Note

Some of the activities in this section may have already been performed in the corresponding section under SAP
Customer Activity Repository [page 26]. Such activities do not need to be repeated during the setup and
installation of consuming applications.

The following interactive diagram depicts the installation process for SAP Assortment Planning for Retail 1.0. If
you are reading this document on a device, you can select elements in the diagram to navigate to the
corresponding sections.

1 Note

The Install ABAP Back-End Server, Install ABAP Front-End Server, Install SAP HANA Live for SAP ERP, and
Create SAP CRM Table Definitions installation processes can be executed independently from one another. You
may assign separate teams to work on these processes in parallel for a faster and simpler implementation.
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Figure 10: General Installation Flow

4221 Install Prerequisites

Before proceeding with the installation, the following components must be installed and configured:
e SAPHANA

e SAP HANA Application Function Library (AFL)

® SAP HANA Database Clients

e SAP HANA Studio

e SAP Solution Manager

1 Note

The documentation for installing and configuring these components is maintained and published separately
from this product. See the Prerequisites [page 21] section for more information on retrieving the related
documentation.

4.2.2.2 Install ABAP Back-End Server

4.2.2.2.1 Install SAP NetWeaver

You must install SAP NetWeaver 7.40 SP 09 prior to installing other back-end components.
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For more information about how to install SAP NetWeaver, see [r help.sap.com/nw74 » Installation and Upgrade
Information » Installation Guides 3.

4.2.2.2.2 Install SAP Customer Activity Repository Retail
Applications Bundle

We recommend using Maintenance Optimizer in SAP Solution Manager to install and update product versions.
SAP Solution Manager calculates the required software components that have to be deployed on each server.

For more information about Maintenance Optimizer, see SAP Help Portal at |p help.sap.com/
solutionmanager71 » Application Help » SAP Library » SAP Solution Manager » Maintenance Management »
Maintenance Optimizer 1.

Alternatively, you can download the required files directly from SAP Service Marketplace and deploy them
manually.

In this procedure, you use Maintenance Optimizer to perform a stack XML installation of SAP Customer Activity
Repository retail applications bundle 1.0.

Procedure

1. Logonto SAP Solution Manager and launch Maintenance Optimizer.

For more information on using Maintenance Optimizer, see [ service.sap.com/mopz 1.

1 Note

Maintenance Optimizer 3.0 (MOPZ) is the standard for SAP Solution Manager 7.1 SP12. You may
experience difficulties installing products if you are running an older version of SAP Solution Manager.

We recommend upgrading to the latest version of SAP Solution Manager. If you do not wish to do so, you
must implement SAP Note 1940845 to render the MOPZ front-end compatible with the back-end.

2. Inthe Maintenance Optimizer work step that allows you to choose add-on products, select product version
CAR RETAIL APPL BUNDLE 1.0 and productinstance CARAB ABAP Server.

V] CARRETAILAPPL BUNDLE 1.0 01(10/2014) ~  SAP Customer Activity Repository retail applications bundle 1.0
(3) CAR RETAIL APPL BUNDLE 1.0
Instance Required Instance Required Product Version  Systems
|| CARAB ABAP Server Application Server ABAP SAP NETWEAVER 7.4 Assign System

Figure 11: Selection of Product Version and Product Instance

Caution
Do not deselect any ABAP components from the product instance.

3. Calculate and download the stack XML file.
Log on to your back-end server, that is, the ABAP system on which you are installing CAR Retail Appl Bundle -
ABAP Instance.

5. Use the SAP Add-On Installation Tool (transaction SATNT) to load and install the stack XML generated using
SAP Solution Manager Maintenance Optimizer.
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For more information on transaction sSAINT, refer to the system documentation available directly in the
system when you run transaction SAINT and select the Online Help icon.

42223 SetUp SAP Client

In this procedure, you set up a client on your back-end system.

Procedure

1. Verify the client number in the source SAP ERP system.

This installation includes SAP HANA content that provides views on a combination of client-dependent data
authored in a source SAP ERP system.

2. Create the necessary client on your back-end system using client maintenance transaction (scc4).

Caution

If you are performing a client copy, you should only perform the client copy after a successful import of all
related software components. Also, you should only import or transfer Customizing tables after this client
copy is complete, as described in SAP Note 337623.

If using the same client number is not possible due to the specifics of your implementation and client setup
rules, you must use SLT transformation rules before replicating data to transform the source SAP ERP
client to match the client on your back-end system.

Example

If SAP ERP is set up on client 100 in your implementation, you should also set up your installation on client

100. If, for any reason, you are unable to do so, you can transform the source client to 100 using SLT
transformation rules.

Cross-system information is client-dependent. As a result, it is required to use the SAP Client (MANDT)
attribute as one of the join attributes in the SAP HANA views to combine cross-system sales and master
data. All data (whether created or replicated) must be affiliated with the same client number.

More Information

For more information, see | help.sap.com/nw73 » Application Help » Function-Oriented View » Application
Server » Application Server ABAP » Other Services » Services for Administrators » Client Concept 1.
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4.2.2.3 Install ABAP Front-End Server

4.2.2.31 Install SAP NetWeaver Gateway on the ABAP Front-
End Server

The complete Ul layer consisting of the central Ul component, the product-specific Ul components and the SAP
NetWeaver Gateway is contained in the ABAP front-end server. SAP NetWeaver Gateway handles the
communication between the client and the ABAP back-end server. For a visualization of how these components
interact, see Overall System Planning [page 11].

When you are implementing the Central Hub deployment option, you use separate servers for the back-end and
front-end components in your landscape.

Procedure

Ensure that the necessary SAP NetWeaver version is installed on your front-end server. For more information, see
SAP Library for SAP Fiori on SAP Help Portal at |k help.sap.com/fiori_bs2013 » System Landscape Required for
SAP Fiori » Setup of SAP Fiori System Landscape with SAP HANA Database » Installation J.

4.2.2.3.2 Install Central SAP Fiori Ul Components

The complete Ul layer consisting of the central Ul component, the product-specific Ul components and the SAP
NetWeaver Gateway is contained in the ABAP front-end server. The central Ul component contains the SAP UI5
control library and the SAP Fiori Launchpad.

When you are implementing the Central Hub deployment option, you use separate servers for the back-end and
front-end components in your landscape. Your front-end server must have the required central Ul component
version.

Procedure

Ensure that SAP_UI 740 SP11 (which contains SAPUI5 Version 1.24.2 or higher) or equivalent is installed on your
front-end server.

Depending on the version of SAP NetWeaver installed on your front-end server, the central Ul component is either
installed as an add-on (for example, for SAP EhP1 for SAP NetWeaver 7.3 or higher) or is integrated directly in the
SAP NetWeaver installation (for example, SAP NetWeaver 7.4 SPO4 or higher). In either case, to use the apps
delivered as part of SAP Fiori 1.0 for SAP Customer Activity Repository retail applications bundle (SAP FIORI
FOR SAP CARAB 1.0), SAP_UI 740 SP11 (which contains SAPUI5 Version 1.24.2 or higher) or equivalent must
be installed on your front-end server.

For more information, see SAP Library for SAP Fiori on SAP Help Portal at | help.sap.com/fiori_bs2013 » System
Landscape Required for SAP Fiori » Setup of SAP Fiori System Landscape with SAP HANA Database »
Installation » Setup of Front-End Server » Installation of Central Ul Components 1.
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4.2.2.3.3 Install Product-Specific SAP Fiori Ul Components

The complete Ul layer consisting of the central Ul component, the product-specific Ul components and the SAP
Gateway is contained in the ABAP front-end server. The product-specific Ul component contains the SAP Fiori
user interface for the SAP Assortment Planning for Retail application and the SAP Smart Business for SAP
Customer Activity Repository. This procedure describes the installation of this product-specific Ul component.

Procedure

1. Logonto SAP Solution Manager and launch Maintenance Optimizer.

For more information about using Maintenance Optimizer, see [k service.sap.com/mopz 1.

1 Note

Maintenance Optimizer 3.0 (MOPZ) is the standard for SAP Solution Manager 7.1 SP12. You may
experience difficulties installing products if you are running an older version of SAP Solution Manager.

We recommend upgrading to the latest version of SAP Solution Manager. If you do not wish to do so, you
must implement SAP Note 1940845 to render the MOPZ front-end compatible with the back-end.

2. Inthe Maintenance Optimizer work step that allows you to choose add-on products, select product version
SAP FIORI FOR SAP CARAB 1.0.

3. Select the product instance based on the SAP NetWeaver version of your front-end server:
o Ul for SAP CARAB on NW 740
o Ul for SAP CARAB on NW 731
4. Calculate and download the stack XML file.
Log on to your front-end server.
6. Usethe SAP Add-On Installation Tool (transaction SAINT) to load and install the stack XML generated using
SAP Solution Manager Maintenance Optimizer.

For more information on transaction sSAINT, refer to the system documentation available directly in the
system when you run transaction SATINT and select the Online Help icon.

4.2.2.4 Install SAP HANA Live for SAP ERP

This section describes how to install SAP HANA Live under different implementation conditions:
e |fyou are implementing a deployment option that requires data to be replicated from a source SAP ERP
system, see Deployment Scenario: SAP Customer Activity Repository Standalone or Co-Deployed with SAP
BW [page 68].
® |fyou are implementing a deployment option in which your source SAP ERP system and SAP Customer
Activity Repository are co-deployed on the same SAP HANA database, see Deployment Scenario: SAP
Customer Activity Repository Co-Deployed with SAP ERP [page 69].

For more information, see System Landscape Variants [page 13].
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42241 Deployment Scenario: SAP Customer Activity
Repository Standalone or Co-Deployed with SAP
BW

SAP Customer Activity Repository requires that SAP HANA Live for SAP ERP is installed, configured and
connected to the same SAP HANA database that you plan to use for SAP Customer Activity Repository.

For more information on installing SAP HANA Live for SAP ERP, see |F help.sap.com/hba » Installation, Security,
Configuration, and Operations Information » Administrator's Guide » Administrator's Guide, SAP HANA Live for
SAP Business Suite 1.

Caution

SAP Customer Activity Repository does not require that you execute all of the installation steps exactly as they
are described in the Administrator's Guide, SAP HANA Live for SAP Business Suite. Prior to executing steps that
describe the creation and replication of SAP ERP tables, be sure to read the additional instructions for SAP
Customer Activity Repository provided in this guide.

Process

Ensure that the SAP Landscape Transformation component (SAP LT Replication Server) is installed.

2. Configure access from the SAP LT Replication Server to the source SAP ERP system (RFC connection) and
from SAP LT Replication Server to the target SAP HANA database.

For more information, see:

o |k help.sap.com/hba » Installation, Security, Configuration, and Operations Information » Administrator's
Guide » Administrator's Guide, SAP HANA Live for SAP Business Suite » Installation Steps 1.

o |k help.sap.com/hana_platform » System Administration and Maintenance Information » Application
Operations Guide — Trigger-Based Data Replication Using SAP LT Replication Server for SAP HANA »
(<Technical Prerequisites and Authorization Aspects> and <Accessing the Configuration and Monitoring
Dashboard>) 1.

3. Ensure that your back-end system is connected to SAP HANA Studio.
If necessary, set the connection as follows:
1. Logonto SAP HANA Studio.
2. Right-click in the Navigator pane and select Add System.
3. Enter the required information the Specify System dialog:
o Hostname
o Instance Number
o System description
4. Specify your system User Name and Password in the Connection Properties dialog.

4. Ensure that a database catalog schema is created on the target SAP HANA database. This is the schema on
your SAP HANA database to which the SAP ERP data will be replicated.

For more information, see:

o |k help.sap.com/hba » Installation, Security, Configuration, and Operations Information » Administrator's
Guide » Administrator's Guide, SAP HANA Live for SAP Business Suite » Installation Steps 2
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o |» help.sap.com/hana_platform » System Administration and Maintenance Information » SAP HANA
Administration Guides » Creating Schemas 1.

5. Map the authoring schema of the sap.hba.ecc content package to your particular physical database
schema, described in the previous step. If the physical database schema to which the SAP ERP data will be
replicated is already called SAP_EcCC, this schema mapping is not required.

Table 20
Authoring Schema Physical Schema
SAP ECC <Name of Your Schema for Storing SAP ERP

Data>

For more information, see:

o | help.sap.com/hba » Installation, Security, Configuration, and Operations Information » Administrator's
Guide » Administrator's Guide, SAP HANA Live for SAP Business Suite » Installation Steps 1

o |p help.sap.com/hana_platform » Modeling Information » SAP HANA Modeling Guide » Mapping the
Authoring Schema to the Physical Schema 3.

6. Create the tables that are required by SAP HANA Live for ERP views on the target SAP HANA database using
the instructions provided in SAP Note 1799313. The tables that are required to be created are listed in SAP
Notes 1782065, 1781992, and 1900038.

The creation of the tables on the target SAP HANA database is required so that the content package of SAP
HANA Live for ERP can be deployed and activated correctly.

Caution

You must not replicate any data to these tables at this point. Data replication is performed during
post-installation.

For more information, see Replicate SAP ERP Tables for <Your Product> in the Post-Installation section
specific to your scenario.

7. Deploy the SAP HANA Live for ERP content package on the SAP HANA database.

For more information, see lF help.sap.com/hba » Installation, Security, Configuration, and Operations
Information » Administrator's Guide » Administrator's Guide, SAP HANA Live for SAP Business Suite »
Installation Steps 1.

8. Ensure that the views included in the content package sap.hba.ecc have been activated.

The subset of the views required by SAP Customer Activity Repository is listed in SAP HANA Live for SAP
ERP Views Required by SAP Customer Activity Repository [page 106].

For more information on activating views, see [ help.sap.com/hana_platform » Development Information »
SAP HANA Developer Guide » Setting Up the Analytic Model » Creating Views » Activating Objects 1.

422.4.2 Deployment Scenario: SAP Customer Activity
Repository Co-Deployed with SAP ERP

SAP Customer Activity Repository requires that SAP HANA Live for SAP ERP is installed, configured and
connected to the same SAP HANA database that you plan to use for SAP Customer Activity Repository.
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For more information on installing SAP HANA Live for SAP ERP, see [k help.sap.com/hba » Installation, Security,
Configuration, and Operations Information » Administrator's Guide » Administrator's Guide, SAP HANA Live for
SAP Business Suite 3.

Caution

SAP Customer Activity Repository does not require that you execute all of the installation steps exactly as they
are described in the Administrator's Guide, SAP HANA Live for SAP Business Suite. Be sure to read the
additional instructions for SAP Customer Activity Repository provided in this guide.

Process

70

Ensure that your back-end system is connected to SAP HANA Studio.
If necessary, set the connection as follows:
1. Logonto SAP HANA Studio.
2. Right-click in the Navigator pane and select Add System.
3. Enter the required information the Specify System dialog:
o  Hostname
o Instance Number
o System description
4. Specify your system User Name and Password in the Connection Properties dialog.

Map the authoring schema of the sap . hba.ecc content package to your particular physical database
schema. If the physical database schema is already called sap_Ecc, this schema mapping is not required.

Table 21
Authoring Schema Physical Schema
SAP ECC <Name of Your Schema for Storing SAP ERP

Data>

For more information, see:

o |» help.sap.com/hba » Installation, Security, Configuration, and Operations Information » Administrator's
Guide » Administrator's Guide, SAP HANA Live for SAP Business Suite » Installation Steps 3.

© |p help.sap.com/hana_platform » Modeling Information » SAP HANA Modeling Guide » Mapping the
Authoring Schema to the Physical Schema 1.

Ensure that all the standard SAP ERP tables listed in SAP Notes 1782065, 1781992, and 1900038 are present

on your SAP HANA database.

The presence of these tables on the SAP HANA database is required so that the content package of SAP

HANA Live for ERP can be deployed and activated correctly.

Deploy the SAP HANA Live for ERP content package on the SAP HANA database.

For more information, see |r help.sap.com/hba » Installation, Security, Configuration, and Operations

Information » Administrator's Guide » Administrator's Guide, SAP HANA Live for SAP Business Suite »
Installation Steps 3.

Ensure that the views included in the content package sap.hba.ecc have been activated.

The subset of the views required by SAP Customer Activity Repository is listed in SAP HANA Live for SAP
ERP Views Required by SAP Customer Activity Repository [page 106].
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For more information on activating views, see [» help.sap.com/hana_platform » Development Information »
SAP HANA Developer Guide » Setting Up the Analytic Model » Creating Views » Activating Objects 4.

4.2.2.5 Create SAP CRM Table Definitions

The presence of an SAP CRM system in your landscape is optional. If you do not have an SAP CRM system in your
landscape, you need to create a set of “"dummy” SAP CRM tables. These tables are required for the successful
activation of views in the SAP HANA content.

If you have an SAP CRM system in your landscape and you are planning to use the standard SAP implementation
of customer identification delivered with SAP Customer Activity Repository, you additionally need to set up the
SAP CRM table replication as described in Replicate SAP CRM Tables for SAP Customer Activity

Repository [page 40].

1 Note

Before you proceed, identify whether your back-end system will integrate with a source SAP CRM system. For
example, if you have an operational SAP CRM system, you could access this system from SAP Customer
Activity Repository to retrieve information about customers who use loyalty cards at the point of sale.

If your back-end system will not integrate with a source SAP CRM system, read and implement SAP Note
1909488.

If your back-end system will integrate with a source SAP CRM system, read and implement the following
process.

Process

1. Ensure that the SAP LT Replication Server is installed and that a user with the appropriate authorizations is
set up in the target SAP HANA database.

If you have already ensured proper installation of the SAP LT Replication Server during previous procedures,

skip to the next step. Otherwise, refer to one of the following for more information:

© |p help.sap.com/hana_platform ¥ Installation and Upgrade Information » SAP HANA Replication
Installation Guides 3

o |» help.sap.com/hana_platform » System Administration and Maintenance Information » Application
Operations Guide — Trigger-Based Data Replication Using SAP LT Replication Server for SAP HANA »
Technical Prerequisites and Authorization Aspects 1

2. Setupauserinthe source SAP CRM system and grant relevant authorizations to this user.

For more information, see |F help.sap.com/hana_platform » Installation and Upgrade Information » SAP
HANA Replication Installation Guides » System Connections and Authorizations 1.

3. Specify a configuration in SAP LT Replication Server, which contains the definition of the connections
between:

©  The source SAP CRM system and the SAP LT Replication Server
o0 The SAP LT Replication Server and the target SAP HANA database
For more information, see [k help.sap.com/hana_platform » System Administration and Maintenance

Information » Application Operations Guide — Trigger-Based Data Replication Using SAP LT Replication Server
for SAP HANA » Accessing the Configuration and Monitoring Dashboard 2.
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The name that you assign to your configuration will be also be used as the name of the database catalog
schema that is automatically created on the target SAP HANA database. This is the schema to which you will
replicate the tables from the source SAP CRM system.

Once you save the configuration, a schema GUID and a mass transfer ID are automatically created and
assigned to the configuration. Furthermore, several dictionary tables are automatically replicated from your
source system to your target SAP HANA database.

For more information, see |p help.sap.com/hana_platform » System Administration and Maintenance
Information » Application Operations Guide — Trigger-Based Data Replication Using SAP LT Replication Server
for SAP HANA » Important Transactions and Control Tables 1.

4. Replicate table definitions from SAP CRM by reading and implementing SAP Note 1938004.

4.2.3 Post-Installation

1 Note

Some of the activities in this section may have already been performed in the corresponding section under SAP
Customer Activity Repository [page 26]. Such activities do not need to be repeated during the setup and
installation of consuming applications.

The following diagram depicts the post-installation process for SAP Assortment Planning for Retail 1.0.
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1
L ) !
[ Activate Business Functions ] ( Activate External Views ] Configure SAP NetWeaver
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Configure Demand Data ; i T
Foundation Verify the Connection between Vv
T SAP Assortment Planning for Retail
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v M v
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Figure 12: General Post-Installation Flow
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4.2.3.1 Activate Business Functions

4.2.3.11 Activate DDF Business Functions

SAP Assortment Planning for Retail uses data acquired and maintained in Demand Data Foundation (DDF). You
must ensure that the required DDF business functions are activated.

= Recommendation
e Business functions should be activated by a system administrator.
® (Once abusiness function is active, we recommend that you do not deactivate it.

® Before activating the business function, read the corresponding business function documentation. For
information about DDF business functions, see SAP Library for SAP Customer Activity Repository on SAP
Help Portal at [ help.sap.com/car » SAP Library » SAP Customer Activity Repository » Demand Data
Foundation » Business Functions 1.

Procedure

1. Activate the following business functions:
© /DMF/DDF IMDB PL TD (Decompression of Product Location Price Data)
© /DMF/DDF IMDB TS (Decompression of Time Series Data)

2. If you use Unified Demand Forecast (UDF), activate the following business functions:
© /DMF/FORECAST (Activation of Forecast Engine)

© /DMF/DDF UDF (Activation of Unified Demand Forecast)

More Information

IF help.sap.com/car ¢ Integration Information » Demand Data Foundation (DDF) 2.0 with the SAP HANA
Database 1

42312 Activate SAP Assortment Planning for Retail
Business Function

To use the SAP Assortment Planning for Retail application, the /DMF/DDF ASSORTMENT PLANNING (Activation of
Assortment Planning (Reversible)) business function must be activated. During ramp-up, it is not possible to
activate this business function yourself.
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Procedure

1.

Contact SAP for information on Ramp-Up approval. SAP will provide a workaround allowing you to use SAP
Assortment Planning for Retail without activating the /DMF/DDF ASSORTMENT PLANNING (Activation of

Assortment Planning (Reversible)) business function.

4.2.3.2 Configure Demand Data Foundation

SAP Assortment Planning for Retail relies on data maintained in Demand Data Foundation (DDF). This procedure
highlights key DDF configuration steps required to use the SAP Assortment Planning for Retail application.

Procedure

74

Perform the necessary configuration steps in DDF.

SAP Assortment Planning for Retail uses master data and time series data stored in DDF. As such, prior to
using the SAP Assortment Planning for Retail application, you must ensure that DDF is fully configured and
operational.

1 Note

DDF Customizing activities that are explicitly relevant for SAP Assortment Planning for Retail are
referenced under |» SAP Customizing Implementation Guide » Cross-Application Components »
Assortment Planning for Retail » Imported Demand Data Foundation Settings 3.

For more information, see the Configuring Demand Data Foundation configuration document associated with

the Enabling Demand Data Foundation business process of the Assortment Planning for Retail Solution

Manager scenario.

Configure data replication from SAP ERP to DDF.

SAP Assortment Planning for Retail uses master data (such as product, location, and product hierarchy) as

well as organizational data (such as sales organization and distribution channel) that is replicated from SAP

ERP to DDF using DRFOUT.

For more information on setting up this data replication, see the following:

o Business Process Documentation associated with the Enabling Demand Data Foundation business
process of the Assortment Planning for Retail Solution Manager scenario.

©  Configuring Data Replication from SAP ERP to DDF configuration document associated with the Enabling
Demand Data Foundation business process of the Assortment Planning for Retail Solution Manager
scenario.

For more information on monitoring the replication, see Periodic Tasks in the Management section of the

Administrator's Guide, SAP Assortment Planning for Retail 1.0.

Optionally, configure the transfer of Open-To-Buy figures (OTB) from SAP BW.

Several of the SAP BusinessObjects Analysis, edition for Microsoft Office workbooks provided with SAP
Assortment Planning for Retail allow you to compare the planned assortment figures to the OTB figures. OTB
is determined using the SAP Planning for Retail, rapid-deployment solution, and stored in SAP BW
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InfoProviders (for example, 0rRP_MP12 MultiProvider). To access OTB figures from SAP Assortment Planning
for Retail workbooks, this data must first be imported from the SAP BW system to your back-end system.

1. Setupan RFC connection between your back-end system and the SAP BW system, from which you will
import the OTB data (transaction sM59).

2. Provide the required settings in the Define SAP BW Application for Merchandise Planning and Define Field
Mapping for Merchandise Planning Customizing activities under |p SAP Customizing Implementation
Guide » Cross-Application Components » Assortment Planning for Retail » Imported Demand Data
Foundation Settings » Integration 1.

Alternatively, provide a custom implementation for BAdl: Read Merchandise Planning.

3. Runreport DMF/BI_ IF MERCH PLAN (transaction SE38) to import the OTB data from SAP BW to your
back-end system.

If you use the standard settings defined in the Define Field Mapping for Merchandise Planning
Customizing activity, that is, you are importing the OTB from the ORP_MP12 MultiProvider, you must
specify MMF (Finalized Merchandise Version) in the Merchandise Plan Version field of the report.

1 Note

You can execute the DMF/BI_IF MERCH PLAN report as a scheduled background job (transaction
SM36), as described in the Periodic Tasks section of the SAP Assortment Planning for Retail
Administrator's Guide.

More Information
IF help.sap.com/bicontent » <Your Release> » SAP Library » Bl Content & Bl Content Extensions » Bl Content »

Industry Solutions » Trading Industries » Retail Trade » Merchandise and Assortment Planning » Retail Planning »
MultiProvider » Merchandise Retail Plan 3

|F service.sap.com » Products » SAP Rapid Deployment Solutions (RDS) » A-Z Index » P » SAP Planning for Retail
rapid-deployment solution 2

4.2.3.3 Verify Users, Privileges, and Roles

Prior to proceeding with the post-installation steps for the application, you need to ensure that the required
database and back-end application users have all the required privileges, roles and authorizations.

Prerequisites

You have read and implemented the procedure described in Verify SAP HANA User and Privileges [page 60].

Procedure

1. Ensure that the SAP HANA database users listed below exist and that they have the required additional
roles/privileges.
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Table 22

SAP<SID>

This is the generic database user
specified for the connection from the
SAP NetWeaver back-end server to the
SAP HANA database.

Privilege EXECUTE on procedure TRUNCATE PROCEDURE_OBJECTS

Privilege EXECUTE on procedure GET PROCEDURE_OBJECTS

_SYS_REPO

<Your User Name>*

Privilege REPO . READ on package bw2hana/SAP<SID> /RAP/
<InfoCube> REPORTING

The corresponding privileges will be created automatically when
activating Bl Content. As there are five InfoCubes (DS01, DS02, DS03,
RCO1, RCO5) three are also five privileges that are created and assigned

to the users.

Session Client of this database user has to be set to the appropriate

back-end system client.

1. Logonto SAP HANA Studio.

2. Open the Modeler perspective and use the Navigator to access your
back-end system.
Under Security, select a user.

4. Set the Session Client to the client number created in Set Up SAP
Client [page 65].
This step is necessary to use the SAP Assortment Planning for
Retail planning framework, where SAP BusinessObjects Analysis,
edition for Microsoft Office workbooks obtain data from SAP HANA

views.

For more information, see the Assign Default Client section in the
SAP HANA Modeling Guide.

must be identical.

*The username on SAP HANA database level, back-end system and on the front-end server (SAP NetWeaver Gateway)

Ensure that your back-end application user has the following roles/authorizations

Table 23

<Your User Name>*
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SAP ISR DDF MASTER
SAP ISR AP MASTER
/RAP/BW AP WORKBOOKS

Set SAP HANA User Mapping to C (DBMS user, else SAP HANA user with
same name as BW user) in transaction RS2HANA VIEW.

The user profile must have the following parameters maintained
(transaction SU3, Parameters tab):
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Table 24
Parameter Value
RSPLS HDB PE TRACE Y
RSPLS HDB SUPPORT HDB_ON

*The username on SAP HANA database level, back-end system and on the front-end server (SAP NetWeaver Gateway)

must be identical.

3. Ensure that your front-end application user name is identical to the user name on SAP HANA database level
and on the back-end system. Furthermore, verify that the front-end application user has all the necessary
roles assigned. For more information, see the Security Information section in the SAP Assortment Planning
for Retail 1.0 Administrator's Guide.

4.2.3.4 Activate SAP Assortment Planning for Retail
Planning Framework Content

The planning framework used by SAP Assortment Planning for Retail consists of the following elements:

® Business Intelligence Content (Bl Content) Objects: A collection of local Bl Content objects is used as the
basis for the SAP BusinessObjects Analysis, edition for Microsoft Office workbooks.

SAP BusinessObjects Analysis, edition for Microsoft Office workbooks are designed to consume data from Bl
Content objects. The local Bl Content objects that are provided with the SAP Assortment Planning for Retail
applications use the integrated planning engine in SAP Business Warehouse (SAP BW). These local Bl
Content objects are used as an interface between the SAP HANA views and the SAP BusinessObjects
Analysis, edition for Microsoft Office workbooks.

1 Note

The local Bl Content provided with the SAP Assortment Planning for Retail application is entirely
independent of the SAP Business Warehouse Bl Content and Bl Content Extensions add-on. You can use
this local Bl Content directly in SAP Assortment Planning for Retail.

® SAP BusinessObjects Analysis, edition for Microsoft Office Workbooks: Microsoft Excel-based
spreadsheets that you use to plan assortments for the different locations in your retail business.

This section of the guide provides information on the SAP HANA content activation, Bl Content activation and
configuration, and data upload activities required to set up the SAP Assortment Planning for Retail planning
framework.

1 Note

If you have already activated SAP HANA content for SAP Customer Activity Repository, as described in
Activate SAP HANA Content for SAP Customer Activity Repository [page 37], you can proceed to the Activate
SAP HANA Content for SAP Assortment Planning for Retail [page 79] procedure.
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4.2.3.4.1 Activate SAP HANA Content for SAP Customer
Activity Repository

In this procedure, you activate all SAP HANA content (SAP HANA views and SQLScript procedures) required by
SAP Customer Activity Repository.

For more information about activating SAP HANA content, see SAP Help Portal at |F help.sap.com/
hana_platform » Development Information » SAP HANA Developer Guide » Setting Up the Analytic Model »
Creating Views » Activating Objects 1.

Prerequisites

As a mandatory prerequisite for a successful activation of the SAP HANA content for SAP Customer Activity
Repository, you must have successfully completed all of the procedures listed in the previous sections of this
guide.

Procedure

1. Ensurethatthe sys REPO user has the authorizations required to successfully activate SAP HANA content.

1. Provideuser sys REPO with object privilege SELECT, with option "Grantable to others", on the following
physical DB schemas:

o Physical database schema of your back-end system, typically this is called SAP<STD>.
o Physical database schema that contains the SAP ERP tables

©  Physical database schema that contains the SAP CRM tables

You can use the following example SQL statement to grant the required privilege:

GRANT SELECT ON <Your schema name> TO _SYS_REPO WITH GRANT OPTION;

2. Assign the required privileges described in |F help.sap.com/car » Integration Information »
Administrator’'s Guide, Demand Data Foundation (DDF) with Unified Demand Forecast (UDF) on SAP
HANA » Authorization Requirements for Unified Demand Forecast (UDF) 1.

2. Use transaction SE38 to run program /CAR/ACTIVATE HANA CONTENT.

The program activates all SAP HANA content required by SAP Customer Activity Repository. Note that this
includes the SAP HANA content for DDF and UDF.

Log on to SAP HANA studio.
Open the Modeler perspective and use the Navigator to access your back-end system.

Expand the Content folder located under your system name in the Navigator.

o ok~ W

Expand each of the packages listed below and ensure that all the content in the underlying folders is active:
O sap.is.ddf

O sap.is.udf

O sap.is.retail.car

O sap.is.retail.ecc

O sap.is.retail.posdm

O sap.is.retail.syndication
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42.3.4.2 Activate SAP HANA Content for SAP Assortment
Planning for Retail - Part 1

In this procedure, you perform the initial activation of SAP HANA content (views and stored procedures) required
by the SAP Assortment Planning for Retail application.

Caution

This initial activation results in a partial activation of the SAP HANA content for SAP Assortment Planning for
Retail. Several SAP HANA views depend on local Bl Content objects, and as such, have to be activated following
the activation of these Bl Content objects. For more information, see Activate SAP HANA Content for SAP
Assortment Planning for Retail - Part 2 [page 88].

Prerequisites

As a mandatory prerequisite for a successful activation of SAP HANA content for SAP Assortment Planning for
Retail, you must have successfully completed all of the procedures listed in the previous sections of this guide. In
particular, you must have activated SAP HANA content for SAP Customer Activity Repository.

Procedure

1. Ensurethatthe sys REPO user has the authorizations required to successfully activate SAP HANA content.

1. Provideuser sys REPO with object privilege SELECT, with option "Grantable to others", on the following
physical DB schemas:

©  Physical database schema of your back-end system, typically this is called SAP<SID>.
o Physical database schema that contains the SAP ERP tables

You can use the following example SQL statement to grant the required privilege:

GRANT SELECT ON <Your schema name> TO _SYS REPO WITH GRANT OPTION;

2. Assignthe required privileges described in section Authorization Requirements for Unified Demand
Forecast (UDF), of the Administrator's Guide, Demand Data Foundation (DDF) 2.0 with Unified Demand
Forecast (UDF) on SAP HANA.

2. Use transaction SE38 to run program /RAP/ACTIVATE HANA CONTENT.

The program activates a majority of the SAP HANA content (views and stored procedures) required by SAP
Assortment Planning for Retail.

3. LogontoSAP HANA Studio.
4. Open the Modeler and use the Navigator to access your back-end system.
5. Expand the Content folder located under your system name in the Navigator.
6. Expand the package listed below:

O sap.is.retail.rap

You will notice that some of the content in the underlying folders is not deployed.

CUSTOMER

Common Installation Guide © Copyright 2015 SAP SE or an SAP affiliate company.

Installation Scenarios All rights reserved. 79



4 g¥ rap
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4 f§ plan

L= Calculation Views (3]

<{§ BW_DS02.calculationview
BW_DS03_OPT_PLN_PRD_COUNT.calculationview
BW_RC01.calculationview
BW_RC05_OPT_PLN_SALES_KPLcalculationview
=i RETAIL_PURCHASE_PLAN_INTERFACE.calculationview
4 (= Attribute Views (1)

% AP_PLN_HDR attributeview
4 [= Calculation Views (50)
-1l ANNUAL_SEASONS.calculationview

245 ASSORTMENT_LIST_LOCATIONS_HIER.calculationview
ASSORTMENT_LIST_PRODUCTS_HIER. calculationview
ASSORTMENT_LIST_PRODUCTS_NO_COLOR.calculationview
ASSORTMENT_LIST_PROD_LOC.calculationview
.13 ASSORTMENT_LIST_PROD_LOCS_NOKPLcalculationview
éEl ASSORTMENT_LIST_SALES_HISTORY.calculationview
.13 ASSORTMENT_PLAN_HDR.calculationview
.7 ASSORTMENT_PLAN_MERCH_TO_OTB.calculationview
+7] ASSORTMENT_PLAN_NODE.calculationview
+'@ ASSORTMENT_PLAN_SALES_HISTORY_BW.calculationview
+£2] ASSORTMENT_PLAN_SALES_HISTORY_VERSIONS.calculationview
.13 ASSORTMENT_PLAN_WEDGE.calculationview
.15 ASSORTMENT PLAN WEDGE_VARIANTS. calculationview
<12 CLUSTER calculationview
:éﬂ CLUSTERSET.calculationview
:fl CLUSTER_LOCATION.calculationview
.I5] DISTRIBUTION_CHANNEL.calculationview
:é?.' INVENTORY_ACTUALS_VC.calculationview

L INF.calculationview
.12 MASTER_ASSORTMENTS_TO_BE_DELETED.calculationview
a [ Procedures (4)
EXECUTE PARETO ANALYSIS.procedure
£ GET_AP_PLAN_HEADER.procedure

GET_MERCH_PLAN_DATA.procedure
£# GET_PROD_LIST_KPIL_BY_NODE_ID.procedure

» & PROJECT Objects (1)

Figure 13: SAP HANA content not deployed

This is the expected result of this procedure, and the remaining content will be deployed in the Activate SAP
HANA Content for SAP Assortment Planning for Retail - Part 2 [page 88] procedure.

Caution

If you see that none of the views/procedures inthe sap.is.retail.rap package are deployed, you can
resolve this by manually selecting, right-clicking, and choosing to Redeploy each of the sub-folders. This
manual redeployment should leave only the views/procedures highlighted above as not deployed.

More Information

Section Activating Objects, of the SAP HANA Developer Guide SAP

4.2.3.4.3 Activate SAP Assortment Planning for Retail Local
Bl Content

4.2.3.4.3.1 Activate Technical Content

The first time you enter the Data Warehousing Workbench, the system runs a background job to activate
technical content. Technical content consists of technical information that is generated by the system, for
example, data required for the general operation of Bl Content, or time data.
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Procedure

1. Onyour back-end system, open the Data Warehousing Workbench (transaction RSA1).

In the Replicate Metadata dialog box, choose Only Activate.

If a message appears that you are only authorized to work in client ... (Brain 009), then refer to SAP Note
316923 (do not import the support package, but use the description under section Workaround).

4.  Select Do not show this question Again in the dialog that appears.

Choose Yes.

Make sure that the current job has finished before you proceed with the next step. Check the status of the
background job using transaction sM370r SLG1. If there are problems, you must first solve them.

You can use transaction RSTCO_ADMIN to restart the activation of the technical content and to verify the
status of the activation.

1 Note
In the case that you get the shot-dump "RAISE_EXCEPTION" when installing InfoObjects from the Bl
content, see SAP Note 1637935 for a possible solution.

Also, see SAP Notes 2090845 and 2056106 for important information on technical content activation.

Following activation, you can locate the technical content in the Data Warehousing Workbench as follows:
1. Selecting Modeling in the left-hand frame.
2. Expand InfoObjects.

3. Intheright-hand frame, locate Technical Content.

4.2.3.4.3.2 Activate Application Bl Content

In this procedures, you perform a sequential, step-by-step activation of the local Bl Content objects delivered with
the SAP Assortment Planning for Retail application.

1 Note
To ensure correct activation of the local Bl Content objects, carry out the activation sequentially, as specified in
the following procedures.

Procedure

1. Onyour back-end SAP Assortment Planning for Retail system, open the Data Warehousing Workbench
(transaction RSA1).

2. Verify transport connections.
1. Select Transport Connection in the left-hand frame.
2. Select Object Types.
3. Expand Source System.
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Data Warehousing Workbench: Transport C: -
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[ Modeing ] I |5 |[¢p Grouping .|[Es][<” Package || collection Mode .| Displa
l Administration All Objects According to Type Collected objects 7 | Technical name | Elevated... | Last... |L|
I Transport Connection I » & InfoArea =

T » @ Application =
am
~ €3 SAP Transport : é“’ :{‘;‘Zoh’e“ G

+ @ InfoProviders by InfoAreas
+ /& InfoObjects by InfoAreas
- & InfoSources by Application Component

» @5 BEx Web Template
» [If BEx Web Item
» [E] crystal Report
» @3 Xcekius Dashboard

- @ Roles
» B Enterprise Report
* (] Object Types + 8 Workbook
ranspor eque: » % Query View
- 6 Padkages » [H query Elements
~ R XML » "I;ﬂ Broadcast Setting
~ @ export » &% CompositeProvider

+ @ InfoProviders by InfoAreas
+ & nfoObjects by InfoAreas
+ & InfoSources by Appication Component

» [ open 0DS View

» & SAP HANA Analysis Process
» @ muttProvider

» @ nfoset

» @ HybridProvider

+ @ Roles
» fH semantically Partitioned Object

+ [J Object Types

» @ Infocube
+ €5 Transport Request » @ DataStore Object (Advanced)
@ Packages » Af nfoobject

» P Transformation

’ InfoSource

» BE pata Fow

» @) Infopackage

» @) Data Transfer Process

» @ Process Chain

» 3 Processes -
» (33 Planning ~

Figure 14: Selecting Source Systems

4. Use Select Objects to ensure that the back-end system is selected as the source system.
Choose Transfer Selections.

At the top of the right-hand frame, above the list of Collected objects, choose Grouping and select Only
Necessary Objects.

7. At the top of the right-hand frame, choose Collection Mode and select Collect Automatically.

Data Warehousing Workbench: Tr 1 C ction
Ta Tacolected & Spelete A 2cto X X converson  BaBEx  EaObject Changeabiity  Switch (Business Functions)
[_Modeing J © |G Grouping .|| || Package | collection Mode L[| Dispay .|| [ ][R
[_Admnistrati J | A1l Objects According to Type Collected objects T | Technical name | Elevated... | Last... | Last Cha... | Tr
[ Transport connection ] | » & mfosource -
» P DataSource 5

» [Z] Source System

- » @ Open Hub Destination
» B pata Flow
» (&1 nfaparkana

~ CUSAP Transport
+ @ Infoproviders by InfoAreas
« &8 InfaOhiacts hv InfoAreas

Figure 15: Grouping and Collection Settings

Select Bl Content in the left-hand frame.
Activate InfoObject catalogs.
1. Expand InfoObject Catalog.

2. Use Select Objects to select the /RAP/CHAR CAT andthe /RAP/KYF CAT catalogs, thatis, all the
InfoObject catalogs that starting with /rRAP/ *.

Choose Transfer Selections.

In the right-hand frame, in the list of Collected objects, verify that both InfoObject catalogs are listed.

1 Note

If you are carrying out a brand new installation, proceed to the next step. If, however, you have
previously installed/activated any of the /rap/* Bl Content, you should enable the Match (X) or copy
option for each of the InfoObject catalogs.
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Right-click on each of the InfoObject catalogs, and choose Install all Bellow.
Choose Install.

If an information dialog box appears, choose Continue. Choose Local Object or enter a package if you
need to transport the objects.

1 Note

If you have enabled the Match (X) or copy option for any the InfoObjects, you will need to carry out an
additional Transfer selections step to proceed with the activation.

5. Select Modeling in the left-hand frame.

6. Maintain version master data.

1

2.

Expand InfoObjects.

Search for InfoObject /RAP/VERSN, located under [ Assortment Planning for Retail » RAP Character
InfoObject Catalog 2.

Right-click the InfoObject /RAP/VERSN, choose Maintain Master Data from the context menu, and
maintain the following entries on the Time Independent tab:

Table 25

Version

AP1

AP2

APF

REF

000

The five supported planning versions are described in detail in the Maintain Customizing Table /RAP/
RS_VARCUST [page 86] procedure.

1 Note

If you encounter problems opening the master data maintenance WebDynpro application, ensure that
you have implemented SAP Note 2034623.

7. Select Bl Content in the left-hand frame.
8. Activate DataStore Objects.

1. Expand|r More Types » DataStore Object (Classic) 2.
2. Use Select Objects to select all DataStore Objects starting with /RAP/ *.
3. Choose Transfer Selections.
4. Inthe list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.
5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.
If during the installation, you are presented with a dialog asking you to add objects to a personal list,
select No.
If activation warnings similar to the ones displayed below appear, you can ignore them.
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Figure 16: Warnings

9. Activate InfoCubes.
1. Expand InfoCube.
Use Select Objects to select all InfoCubes starting with /RAP/ *.

Choose Transfer Selections.

W

In the list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

If activation warnings similar to the ones displayed below appear, you can ignore them.

» B Checking InfoCube /RAP/RCOS

* & Checking InfoCube [RAP/VCD ¥ A Column view activated for object /RAP/RCO1

~ & Check of InfoProvider /RAP/VCOL: ~ & Activate external SAP HANA view for object /RAP/RCO1
* & Unable to find SAP HANA information model sap.s.retail.rap.ap/INVENTORY_ACTUALS_VC + @ Package: system-ocal.bw.bw2hana.rap, type: Analytic View, name: R
. 2 :anpe: am:ute AP‘PLN;]D :nes :u( exist for d\;mc;em /WII::':IP T * & Attribute _RAP_ASRTP: Conversion routine ALPHA ignored
e e - & Aeute P _CLSET: Converson routne ALPHA gnord
* & Mapped attrbute EXT_LOC_ID does not exist for characteritic /RAP/LOCAT * & Attribute _RAP_CLUST: Compounding ignored
* O Mapped attribute COLOR does not exist for characterstic /RAP/PRCLR + 4 Attribute _RAP_LOCAT: Conversion routine ATINM ignored
: g'[':g?_?}’-" attrbute EXT_PROD_ID does not exst for "’ﬂmm'%‘f‘.h%l!‘ﬂ"%?m” 4 Attribute _RAP_PRDCT: Conversion routine ALPHA ignored
5 Ahﬁ??@ﬂmﬁ 054 PO SR Bor T Ctareic /RA;RLE;;"" + & Attribute _RAP_VARNT: Conversion routine ALPHA ignored
+ & Mapped attribute CURRENCY does not exist for characteristic 0CURRENCY * & Attribute _RAP_VERSN: Conversion routine ALPHA ignored
* & Mapped attrbute MANDT does not exist for characteristic OMANDT - & Attribute OFISCPER: Conversion routine PERI ignored

+ O Mapped attrbute UOM does not exist for characteristic OUNIT . ; i e
+ & Mapped attribute INVENTORY_AT_COST does not exist for key figure /RAP/CIVCV & Attr!bUte OFISCPER: Compounding lg_nored B

+ & Mapped attrbute INVENTORY_AT_RETAIL does not exist for key figure /RAP/CIVRV * & Attribute OREQUID: Conversion routine RQUID ignored
+ & Mapped attrbute INVENTORY does not exist for key figure /RAP/CIVUN * & Attribute OUNIT: Conversion routine BUNIT ignored

* & Mapped attrbute ON_ORDER does not exist for key figure /RAP/ONOUN

* O Wamings occurred whie checking the InfoProvider

Figure 17: Warnings

10. Activate MultiProviders.
1. Expand MultiProvider.
Use Select Objects to select all MultiProviders starting with /rRaP/ *.

Choose Transfer Selections.

AW

In the list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

11. Activate Aggregation Levels.

1. Expand|r Planning » Aggregation Level 1.

2. Use Select Objects to select all Aggregation Levels starting with /rRaP/*.
3. Choose Transfer Selections.
4

In the list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

12. Activate Queries.
1. ExpandIF Query Elements » Query 2.

2. Use Select Objects. In the Selection of Query Objects dialog that appears, expand all the nodes under
Assortment Planning for Retail, and select all the underlying query objects.
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[= Selection of Query Objects

Avaiable Objects |
~ [€% Assortment Planning for Retail |
~ & Option Plan
. @ Option Plan Attribute Header Query
- & Option Plan
- [ option Plan Query
- [H option Plan Top Query
~ & Plan Summary
- [EPlan Summary Query - Week level
> % Plan Summary OTB
- [H Finalze Assortment - OTB Comparison
~ & Product/Size Plnning
+ [H Assortment Plan Header Query
U E Product Planning Query - Cluster
+ [ Product Planning Query - Cluster set
. E Size Planning Query - Cluster
o g Size Planning Query - Cluster set
~ & Refinement Plan
+ [H Refinement Plan Attrbute View
~ & Refinement Plan (Query)
+ [H Refinement Plan - Cluster
+ [H Refinement Plan - Location
+ [ Refinement Plan Report - Cluster
+ [H Refinement Plan Report - Location
» € Business Information Warehouse
» € Cross-Application Components
» [ Generated infoset for datasource OMDG_CR_ANALYSIS
» € Technical Content

Find | \

Figure 18: Assortment Planning for Retail Queries

Choose Transfer Selections.

4. Inthe list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

13. Activate Planning Sequence Objects.

1. Expand |y Planning » Planning Sequence 1.

2. Use Select Objects to select all Planning Sequences starting with /RAP/ *.
3. Choose Transfer Selections.
4

In the list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

14. Activate Workbooks.
1. Expand|r More Types » Analysis Office Excel Workbook 3.
Use Select Objects to select all the workbooks starting with /raP/ *.

Choose Transfer Selections.

A w N

In the list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

15. Choose Exit to leave the transaction.
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42344 Configure SAP Assortment Planning for Retail
Local Bl Content

4.2.3.4.4.1 Enable the Planning Application Kit (PAK)

To be able to use the SAP BusinessObjects Analysis, edition for Microsoft Office workbooks provided as part of

the SAP Assortment Planning for Retail planning framework content, you must enable the Planning Application
Kit.

Procedure

Read SAP Note 1637199.
In your back-end system, launch table/view maintenance (transaction sM30).

1
2
3. Enter RSPLS HDB ACT in the Table/View field and choose Maintain.
4. Choose New Entries.

5

In the HANA Integratn. Active column select Deep HANA Integration Actiwve andinthe Functn. Active
column, enable the checkbox.

4.2.3.4.4.2 Maintain Customizing Table /RAP/RS_VARCUST

In this procedure, you maintain entries in the variable customizing table /RAP/RS_VARCUST in the back-end
system. For each SAP Assortment Planning for Retail query, the entries of this table specify a mapping of a data
version (for example, actual data versus planning data) to the source of data (InfoCube).

Procedure

1. Logon toyour back-end system.

2. Openthe Data Browser (transaction SE16).

3. Enter /RAP/RS_VARCUST in the Table Name field and choose Create Entries.
4. Choose Execute followed by Create.

Onthe Table /RAP/RS_VARCUST Insert screen, you will be able to make the following entries:

Table 26
Field Name User Entry
COMPID SAP Assortment Planning for Retail technical query name.

For example, /RAP/MO1A02 IRQO2.

VNAM ICUBE | InfoCube variable name.

For example, /RAP/INFOPROV_ESM 01.

INFOCUBE InfoCube identifier.
CUSTOMER
© Copyright 2015 SAP SE or an SAP affiliate company. Common Installation Guide
86 All rights reserved. Installation Scenarios


http://service.sap.com/~form/handler?_APP=01100107900000000342&_EVENT=REDIR&_NNUM=1637199&_NLANG=en&_NVERS=0

Field Name User Entry

For example, /RAP/RCO1.

VNAM VERS Version variable name.

For example, /RAP/VERSN MSM 01.

VERSION Version Identifier.
For example, AP1. There are five supported planning versions:
® API1:Planning simulation version 1. Version that is typically used as the planning version.

® AP2:Planning simulation version 2. Version typically used to simulate different scenarios
without having to change your planned version.

e APF: Final version (planned data). After completing the planning, the user will select the plan
they want to finalize and review in Plan Summary. Only the APF version is available in the Plan
Summary. This is done to help align completed plans with the Open-To-Buy figures (OTB) from
the SAP Planning for Retail, rapid-deployment solution.

® REF: Reference version (past data). This is historical data for the items from the time frame of
the reference period. This data is used to pre-populate the planning version by using the copy
function. This allows the planner to have a baseline when starting the planning process. It is
recommended to seed the planning version with the REF data.

®  000: Actual version (current data). The user can see current inventory values with this such as
Actual Inventory and Open Orders.

F4HELP Flag that specifies whether the field provides F4 help or not.

5. Maintain entries in the /RAP/RS VARCUST table for each of the SAP Assortment Planning for Retail queries.
The complete list of entries that you must maintain is found in is found in SAP Note 2056254.

6. Choose Save.

4.2.3.4.4.3 Maintain Fiscal Year Variant

In this procedure you maintain the required fiscal year variant (OFISCVARNT 'RW'").

Caution

SAP Assortment Planning for Retail uses time objects 0FTISCPER (fiscal year period) and 0FISCVARNT (fiscal
year variant), provided as part of the technical Bl Content, and activated in the Activate Technical

Content [page 80] procedure. As such, if you are using SAP Assortment Planning for Retail, you must execute
the procedure below despite having potentially carried out the Generate Time Data [page 40] procedure.

The steps provided in this procedure allow you to maintain 0FISCVARNT 'RW' using the standard 4-5-4 calendar
entries. If you are using alternative fiscal periods in your retail business, for example, each week starting on a
Sunday instead of Saturday, you can provide your own entries instead of the ones suggested in this guide.

Procedure

1. Logon toyour back-end system.
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2. Launch fiscal year variant maintenance (transaction GVAR).
Choose New Entries.

On the New Entries: Overview of Added Entries screen make the following sets of entries:

‘ Fiscal year variants |

Fv |Description |Year—delpen...|mlendar yr \Number of postin... }No.of specil peril
RW Assort. Plan Week [w] ] 53 -
= -t

Figure 19: Create New Fiscal Year Variant

5. Choose Enter.
An information message is displayed about creating more than 16 periods, choose Continue.
6. Choose Back.
You can see the newly created entry.
Mark the entry RW and select Periods from the Dialog Structure.
8. Enter 2012 inthe Calendar yr field and choose Continue.
Data for the previous year must be maintained.
9. Choose New Entries.
10. Open SAP Note 2112634, locate the entries for year 2012, and enter the data by copy-and-paste.
11. Choose Enter to finish your input.

While making the fiscal year entries, an information message might be displayed stating that there are Gaps
in financial year variant periods RW. This is an information message only, and the entered fiscal year data is
saved.

12. Maintain the weekly fiscal year variant in the same way for the year 2017. The entries for year 2017 are also
available in SAP Note 2112634.

13. Select Shortened Fiscal Years from the Dialog Structure.
14. Enter 2013 in the Fiscal year field and choose Continue.
15. Choose New Entries.

16. Enter 52 in the No. of posting periods field.

17. Choose Back twice.

18. Maintain the weekly fiscal year variant in the same way for the shortened fiscal years, that is, years 2013,
2014, 2015, 2016, and 2018. The corresponding tables are available in SAP Note 2112634.

19. Choose Save after you have finished the maintenance for year 2018.

4.2.3.4.5 Activate SAP HANA Content for SAP Assortment
Planning for Retail - Part 2

In this procedure, you perform the final activation of SAP HANA content (views and stored procedures) required
by the SAP Assortment Planning for Retail application. This final activation results in a full activation of the SAP
HANA content for SAP Assortment Planning for Retail. Several SAP HANA views depend on local Bl Content
objects, and as such, have to be activated following the activation of these Bl Content objects, as described in this
procedure.
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Prerequisites

As a mandatory prerequisite for a successful activation of SAP HANA content for SAP Assortment Planning for
Retail, you must have successfully completed all of the procedures listed in the previous sections of this guide.

Procedure

o ok W

Ensure thatthe Sys REPO user has the authorizations required to successfully activate SAP HANA content.

1. Provideuser sys REPO with object privilege SELECT, with option "Grantable to others"”, on the following
physical DB schemas:

©  Physical database schema of your back-end system, typically this is called SAP<SID>.
o  Physical database schema that contains the SAP ERP tables

You can use the following example SQL statement to grant the required privilege:

GRANT SELECT ON <Your schema name> TO _SYS_REPO WITH GRANT OPTION;

2. Assign the required privileges described in section Authorization Requirements for Unified Demand
Forecast (UDF), of the Administrator's Guide, Demand Data Foundation (DDF) 2.0 with Unified Demand
Forecast (UDF) on SAP HANA.

Use transaction SE38 to run program /RAP/ACTIVATE HANA CONTENT.

The program activates the remaining SAP HANA content (views and stored procedures) required by SAP
Assortment Planning for Retail.

Log on to SAP HANA Studio.

Open the Modeler and use the Navigator to access your back-end system.
Expand the Content folder located under your system name in the Navigator.
Expand the package listed below:

O sap.is.retail.rap

All the content in the underlying folders should be active.

More Information

Section Activating Objects, of the SAP HANA Developer Guide SAP

4.2.3.4.6 Activate External Views

During the activation of SAP HANA content for SAP Assortment Planning for Retail, several external views are not
automatically activated.

Procedure

1.

Read and implement SAP Note 2067030 to manually activate external views.

You can use either transaction SE11 or SE80 to activate the views.
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4.2.3.4.7 Verify the Connection Between SAP Assortment
Planning for Retail System and SAP
BusinessObjects Analysis, edition for Microsoft
Office

The SAP Assortment Planning for Retail application includes several SAP BusinessObjects Analysis, edition for
Microsoft Office workbooks. These workbooks, which are installed on your back-end system as part of the local Bl
Content, can only be opened using SAP BusinessObjects Analysis, edition for Microsoft Office.

In this procedure, you verify that you can open an SAP Assortment Planning for Retail workbook from SAP
BusinessObjects Analysis, edition for Microsoft Office.

Prerequisites

You have installed SAP BusinessObjects Analysis, edition for Microsoft Office 1.4 SP 09 or higher as a prerequisite
to the installation of the SAP Assortment Planning for Retail application, as described in the
Prerequisites [page 21] section.

Procedure

1. Open SAP BusinessObjects Analysis, edition for Microsoft Office from [» Start » All Programs » SAP Business
Intelligence » SAP BusinessObjects Analysis » Analysis for Microsoft Excel 1.

2. Fromthe File menu, select |» Analysis » Open Workbook (Open Workbook from SAP NetWeaver) 1.
3. Select your back-end system.

Tip: The list of systems corresponds to the systems available in your SAP Logon.
4. |f single sign-on is not configured provide your user information.

Search for /RAP/* on the Search tab.

Alternatively, open the Folder tab and navigate to | Assortment planning workbooks » Workbooks 3.
6. Open any of the workbooks from the list of SAP Assortment Planning for Retail workbooks.

The opening of the workbook indicates that there are no issues with the connection between your back-end
system and SAP BusinessObjects Analysis, edition for Microsoft Office.

4.2.3.4.8 Specify Analysis Workbooks Settings

SAP Assortment Planning for Retail is delivered with a number of SAP BusinessObjects Analysis, edition for
Microsoft Office workbooks. These are template workbooks that you can adapt to use in your retail business.

For an example of how to create customized versions of the workbooks, see Workbook Design
Example [page 108].
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4.2.3.4.8.1 Enable Macros

In this procedure, you enable your SAP BusinessObjects Analysis, edition for Microsoft Office workbooks to use
macros.

Procedure

1. Open SAP BusinessObjects Analysis, edition for Microsoft Office from | Start » All Programs » SAP Business
Intelligence » SAP BusinessObjects Analysis » Analysis for Microsoft Excel 1.

Choose |p File » Options » Customize Ribbon 1.

Under Customize the Ribbon, select Main Tabs.

Enable the entry Developer and confirm by choosing OK.

Now you will see the new Developer tab in your SAP BusinessObjects Analysis, edition for Microsoft Office.

Select the Developer Tab and choose Macro Security.

N o o s~ DN

Choose Enable all macros.

4.2.3.4.8.2 Set Language for Workbook Ribbons “Planning
Functions” and “Filter KPIs”

In this procedure, you can set the desired language of the workbook ribbons Planning Functions and Filter KPlIs.
The content of the workbooks consists of multiple parts:
® Thelanguage of the standard menus and standard ribbons depends on the language set for Microsoft Excel.

® The language of the contents in the cells (mainly KPIs) depends on the user-selected system language of the
back-end system.

® The language of the workbook ribbons Planning Functions and Filter KPIs, is not set by the selected system
language of the back-end system, but you can change it for each workbook according to the following
procedure. The default language is English.

Procedure

1. Unhide the worksheet SAP_TEXT_CUSTOMIZING using standard functionality of Microsoft Excel.

2. Onthe worksheet SAP_TEXT_CUSTOMIZING, copy the column of the desired language to column B —
Custom Text.

Hide the worksheet SAP_TEXT_CUSTOMIZING.

4. Save your changes in the worksheet on the SAP NetWeaver Server by choosing |» File » Analysis » Save
Workbook to SAP NetWeaver 3.
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4.2.3.4.8.3 Set ResultSetSizeLimit Registry Setting

By default, SAP BusinessObjects Analysis, edition for Microsoft Office workbooks are set to display 500,000 cells.
This setting might not be sufficient for the productive use of SAP Assortment Planning for Retail. For example, if
you have more than 300 products in your assortment plan, you might encounter the following error message:
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3
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5 Size limit of result set exceeded

Figure 20: Size Limit Error

Toresolve this issue, you need to increase the default setting of the ResultSetSizeLimit registry setting.

Procedure
Read and implement SAP Note 1662968.

1 Note
As the administrator overseeing the installation of SAP Assortment Planning for Retail, you need to carry out
the steps listed in this procedure on the workstation of each SAP Assortment Planning for Retail user.

4.2.3.5 Replicate SAP ERP Tables for SAP Assortment
Planning for Retail

In this procedure, you ensure that all SAP ERP tables that are relevant for SAP Assortment Planning for Retail
have not only been created but have also been filled with data. More specifically, you replicate the contents of
relevant tables from the source SAP ERP system to your back-end system.

The steps outlined in this procedure are required when you are implementing one of the system landscape
variants that require data to be replicated from a source SAP ERP system. If your source SAP ERP system and
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your back-end system are co-deployed on the same SAP HANA database, proceed to the next procedure. For
more information, see System Landscape Variants [page 13].

Procedure

1. Define client transformation rules for all SAP ERP tables that you plan to replicate.

In most cases, you need to apply transformation rules to map the client of the source SAP ERP system to the
client on the target back-end system.

Caution

Transformation rules must be defined prior to replicating tables.

For more information, refer to one of the following:
o Set Up SAP Client [page 65]

o |k help.sap.com/hana_platform » System Administration and Maintenance Information » Application
Operations Guide — Trigger-Based Data Replication Using SAP LT Replication Server for SAP HANA » Data
Transformation Capabilities within SAP Landscape Transformation Replication Server 3

o SAP Note 1733714
2. Read SAP Note 2054656 and replicate the tables listed in the file attached to this SAP Note.

For more information, see:

o |» help.sap.com/hba » Installation, Security, Configuration, and Operations Information » Administrator's
Guide » Administrator's Guide, SAP HANA Live for SAP Business Suite » Configuration Steps » Replicate
Data (Side-by-Side Only) 3

o |» help.sap.com/hana_platform » System Administration and Maintenance Information » Application
Operations Guide — Trigger-Based Data Replication Using SAP LT Replication Server for SAP HANA »
(<Managing the Replication Process Using the SAP HANA Studio> and <Important Transactions and
Control Tables>) 1

Caution

This procedure includes the replication of tables from your source SAP ERP system. Trigger-based
replication includes deletion in source tables by archiving activities (since on the database level it is
impossible to distinguish between delete actions caused by archiving and regular deletion of data records).
As aresult, SAP LT (Landscape Transformation) Replication Server replicates archiving activities as delete
actions in the SAP HANA database.

More specifically, when data is archived in your source SAP ERP system, records are deleted from their
respective database tables. Therefore, when these tables are replicated to another SAP HANA database,
the records that were archived in the source tables are deleted in the target database tables.

When deciding on the frequency at which to archive data in the source SAP ERP system, you must consider
and balance the performance requirements of your SAP ERP system and the amount of historical data that
should be replicated to and available in your back-end system.
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4.2.3.6 Configure Front-End
4.2.3.6.1 Configure SAP Gateway

4.2.3.6.1.1 Perform General SAP Gateway Configuration

Prior to connecting the SAP Gateway on your front-end server to your back-end system, you need to perform a
series of general SAP Gateway configuration steps. These configuration steps include the setting of profile
parameters, ICF (Internet Communication Framework) services, language settings, and so on.

These steps are not specific to this installation guide and are described in the SAP NetWeaver product
documentation referenced below.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o SAP Gateway for SAP NetWeaver 7.31

Seelr help.sap.com/nwgateway20 » Application Help » SAP NetWeaver Gateway » SAP NetWeaver
Gateway Configuration Guide » Basic Configuration Settings 1.

o SAP Gateway for SAP NetWeaver 7.40

See|p help.sap.com/nw74 » Application Help » Function-Oriented View » SAP NetWeaver Gateway
Foundation (SAP_GWFND) » SAP NetWeaver Gateway Foundation Configuration Guide » Basic
Configuration Settings 1.

4.2.3.6.1.2 Connect SAP Gateway to your Back-End System

In this procedure, you configure the OData channel, that is, set up a connection between SAP Gateway on your
front-end server and your back-end system.

These steps are not specific to this installation guide and are described in the SAP NetWeaver product
documentation referenced below.

Procedure

1. Setuptherequired roles on the front-end server and assign your user to these roles.

For more information, see [r help.sap.com/nw74 » Application Help » Function-Oriented View » SAP
NetWeaver Gateway Foundation (SAP_GWFND) » SAP NetWeaver Gateway Foundation Configuration
Guide » OData Channel Configuration » User, Developer and Administrator Authorizations 1.

2. Specify the connection settings on the SAP Gateway hub system, which include:

o Connection from the SAP Gateway to consumer systems
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These settings allow the connection between the SAP Gateway host and the consumer systems (clients
from which you access the SAP Fiori user interfaces.)

Connection from the SAP Gateway to SAP back-end system

These settings allow the connection between SAP Gateway to your back-end system.

These settings include:

o Creating a type 3 connection from the SAP Gateway host to your back-end system.

o Defining a trust relationship between your back-end system and the SAP Gateway host.

o Configuring your back-end system to accept SAP assertion tickets from the SAP Gateway host.
o Configuring your SAP Gateway host to accept SAP assertion tickets from your back-end system.

o Configure the necessary system aliases.

More Information

For SAP NetWeaver 7.31, see SAP Library for SAP NetWeaver Gateway on SAP Help Portal at [p help.sap.com/
nwgateway20 » Application Help » Support Package Stack » SAP NetWeaver Gateway » SAP NetWeaver Gateway
Configuration Guide » OData Channel Configuration » Connection Settings on the SAP NetWeaver Gateway Hub
System 1.

For SAP NetWeaver 7.4, see SAP Library for SAP NetWeaver on SAP Help Portal at [p help.sap.com/nw74 »
Application Help » Function-Oriented View » SAP NetWeaver Gateway Foundation (SAP_GWFND) » SAP
NetWeaver Gateway Foundation Configuration Guide » OData Channel Configuration » Connection Settings on the
SAP NetWeaver Gateway Hub System 1.

4.2.3.6.1.3 Activate SAP Gateway

Before you can use SAP Gateway functionality, you have to activate it globally on your front-end server.

These steps are not specific to this installation guide and are described in the SAP NetWeaver product
documentation referenced below.

Procedure

1. Determine the SAP NetWeaver version of your front-end server.

2. Carry out the instructions specific to your SAP NetWeaver version:

e}

For SAP NetWeaver 7.4, see SAP Help Portal at [» help.sap.com/nw74 » Application Help » Function-
Oriented View » SAP NetWeaver Gateway Foundation (SAP_GWFND) » SAP NetWeaver Gateway
Foundation Configuration Guide » OData Channel Configuration » Activating SAP NetWeaver Gateway 1.

For SAP NetWeaver 7.31, see SAP Help Portal at[p help.sap.com/nwgateway?0 » Application Help » SAP
NetWeaver Gateway Configuration Guide » SAP NetWeaver Gateway Configuration Guide » OData
Channel Configuration » Activating SAP NetWeaver Gateway 3.
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4.2.3.6.1.4 Activate Common OData Services

A number of OData services are required to run the SAP Fiori Launchpad. These OData services are delivered with
the central Ul component (SAP_UI 740 SP11 orequivalent).

For security reasons, all OData services are delivered in an inactive state. To use the SAP Fiori Launchpad, you
must activate the common SAP Fiori OData services.

Procedure

1. Logon toyour front-end system (your SAP Gateway system).
2. Goto Customizing (transaction SPRO).

3. Navigate tolr SAP NetWeaver » Gateway » OData Channel » Administration » General Settings » Activate
and Maintain Services 1.

You are presented with the service catalog. This is a list of all the services that are currently active on your
SAP Gateway.

4. Get common SAP Fiori OData services:

1. Choose Add Service.
The Add Service screen is displayed.

2. Enter the system alias of your local front-end system.
This is the alias created in the Connect SAP NetWeaver Gateway to your Back-End System [page 94]
procedure. For example, LOCAL.

3. Enter /uz2* inthe Technical Service Name field.

4. Choose Get Services.
The Add Selected Services screen is displayed.

5. Select the common SAP Fiori OData services that you would like to activate, and choose Add Selected
Services.

Table 27

Service Name

/UI2/PAGE_BUILDER CONF

/UI2/PAGE_BUILDER CUST

/UI2/PAGE_BUILDER PERS

/UI2/TRANSPORT

/UI2/INTEROP

The selected OData services are now active in your SAP Gateway.
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More Information

® For SAP NetWeaver 7.31, see SAP Library for User Interface Add-On 1.0 on SAP Help Portal at
IF help.sap.com/nw-uiaddon » Application Help » User Interface Add-On for SAP NetWeaver » SAP Fiori
Launchpad » Setting Up the Launchpad » Activating SAP NetWeaver Gateway OData Services 1.

® For SAP NetWeaver 7.4, see the documentation on SAP Help Portal at [k help.sap.com/nw74 » Application
Help » Ul Technologies in SAP NetWeaver » Ul Frameworks based on HTML5, JavaScript and CSS » SAP Fiori
Launchpad » Setting Up the Launchpad » Activating SAP NetWeaver Gateway OData Services 1.

4.2.3.6.2 Configure Central Ul Component

The central Ul component (SaP_UI 740 sP11 or equivalent) contains the SAP UI5 control library and the SAP
Fiori Launchpad. Prior to being able to use the SAP Fiori apps that constitute the user interface of the retail
applications described in this guide, you may need to configure the SAP Fiori Launchpad.

These steps are not specific to this installation guide and are described in the SAP NetWeaver product
documentation referenced below.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o SAP Gateway for SAP NetWeaver 7.31
© |p help.sap.com/nw-uiaddon ¥ Application Help » SAP Fiori Launchpad 3, and

o |» help.sap.com/nw-uiaddon » Application Help » Administration Guide » Content Administration »
SAP Fiori Launchpage » Setting Up the SAP Fiori Launch Page 1.

o SAP Gateway for SAP NetWeaver 7.40

o |k help.sap.com/nw74 » Application Help » Ul Technologies in SAP NetWeaver » Ul Framework based
on HTML5, JavaScript and CSS » SAP Fiori Launchpad 3, and

o | help.sap.com/nw74 » Application Help » Ul Technologies in SAP NetWeaver » Ul Framework based
on HTML5, JavaScript and CSS » SAP NetWeaver User Interface Services » Administration Guide »
Content Administration » SAP Fiori Launchpage » Setting Up the SAP Fiori Launch Page 1.

4.2.3.6.3 Activate SAP Assortment Planning for Retail OData
Services

A number of OData services are required to run the SAP Assortment Planning for Retail application.

For security reasons, all OData services are delivered in an inactive state. You must activate these application-
specific OData services to use the SAP Fiori user interface of the SAP Assortment Planning for Retail application.
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Procedure

1. Logontoyour front-end system (your SAP NetWeaver system).

2. Goto Customizing (transaction SPRO).

3. Navigate tolp SAP NetWeaver » Gateway » OData Channel » Administration » General Settings » Activate
and Maintain Services 1.
You are presented with the service catalog. This is a list of all the services that are currently active on your
SAP Gateway.

4. Get SAP Assortment Planning for Retail OData services:

98

1. Choose Add Service.
The Add Service screen is displayed.

2. Enter the system alias of your back-end system.
This is the alias created for your back-end system in the Connect SAP NetWeaver Gateway to your
Back-End System [page 94] procedure. For example RAPCLNT100.

Enter /DMF* in the Technical Service Name field.
4. Choose Get Services.

The Add Selected Services screen is displayed.

5. Select the SAP Assortment Planning for Retail OData services you would like to activate, and choose Add

Selected Services.

Table 28

Service Name

/DMF/LOCATION CLUSTERSET SRV

/DMF/SEARCH LOCATIONS SRV

/DMF/SEARCH PRODUCTS SRV

/DMF/CURRENCY LIST SRV

The selected OData services are now active in your SAP Gateway.
6. Enter /RAP* in the Technical Service Name field.
7. Choose Get Services.

The Add Selected Services screen is displayed.

8. Select the SAP Assortment Planning for Retail OData services you would like to activate, and choose Add

Selected Services.

Table 29

Service Name

/RAP/MASTER ASSORT LIST SRV

/RAP/OPTION PLAN SRV

/RAP/OBJ ATTRIBUTE_ SRV

/RAP/REFINE ASSORTMENT

/RAP/PHP MATCH SRV
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The selected OData services are now active in your SAP Gateway.

More Information

For SAP NetWeaver 7.31, see SAP Library for User Interface Add-On 1.0 on SAP Help Portal at
|F help.sap.com/nw-uiaddon » Application Help » User Interface Add-On for SAP NetWeaver » SAP Fiori
Launchpad » Setting Up the Launchpad » Activating SAP NetWeaver Gateway OData Services 1.

For SAP NetWeaver 7.4, see the documentation on SAP Help Portal at | help.sap.com/nw74 » Application
Help » Ul Technologies in SAP NetWeaver » Ul Frameworks based on HTML5, JavaScript and CSS » SAP Fiori
Launchpad » Setting Up the Launchpad » Activating SAP NetWeaver Gateway OData Services 1.

4.2.3.6.4 Activate SAP Assortment Planning for Retail ICF
Services

For security reasons, all Internet Communication Framework (ICF) services relevant to your SAP Assortment
Planning for Retail application are made available in an inactive state.

You have activated the central ICF services in the Perform General SAP NetWeaver Gateway
Configuration [page 94] and Configure Central Ul Component [page 97] procedures. This procedure provides the
instructions to activate ICF services required for the SAP Assortment Planning for Retail SAP Fiori apps.

Procedure

1. Logon toyour front-end server.
2. Open service maintenance (transaction SICF).
3. Inthe Maintain Service screen, select the Location Clustering service by specifying the following:
o Hierarchy Type: SERVICE
© Virtual Host: DEFAULT HOST
© Service Path: /sap/bc/ui5_ui5/sap/locationclsts/
4. Choose Execute.
5. Toactivate the service, choose Service/host Activate.
6. Repeat steps 3 to 5 for the following services:
© /sap/bc/uib5 uib/sap/mstrassortlist/
0 /sap/bc/uib5 uib/sap/assortplan/
o /sap/bc/ui5 ui5/sap/phpmatch/

0 /sap/bc/ui5 uib5/sap/optionplan/
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4.2.3.6.5 Define System Alias for Back-End Transactions

From the SAP Fiori launchpad, you can launch SAP Assortment planning for Retail apps that access and start
transactions on the back-end system. For example, the Manage Products tile actually launches the Demand Data
Foundation (DDF) powL EASY WebDynpro application.

To enable this behavior, you need to create a dedicated RFC connection between the front-end and the back-end
systems.

Procedure

1. Logontoyour front-end system, that is, the system where you have installed the user interface (Ul)
components of the SAP Assortment Planning for Retail application.

2. Launch Configuration of RFC Connections (transaction sM59).

3. Create an RFC connection with the RFC Destination set to Sap_ ISR CARAB and Connection Type set to H
(HTTP connection).

4. Save your changes.

Once this connection is created, the required SAP Assortment Planning for Retail SAP Fiori apps are
connected to your back-end system. To verify this:

1. OpenLaunchpad Customizing (transaction LPD_CUST).

2. Select the SAP Assortment Planning for Retail role (UTRAP001), and choose Display.
The two catalogs, Assortment Planner and Planning Administrator, are displayed.

3. Expand the Assortment Administrator catalog.

4. From the list of displayed apps, select Manage Category Responsibilities.

5. Verify the name in the System Alias field, it is set to SAP ISR CARAB.

This setting allows the Manage Category Responsibilities app to launch the corresponding DDF
WebDynpro application. Same is true for the Manage Products and Manage Locations SAP Fiori apps.

4.2.3.6.6 Assign Roles, Catalogs, and Groups in SAP Fiori
Launchpad

To be able to access SAP Fiori apps that constitute the SAP Assortment Planning for Retail user interface from
the SAP Fiorilaunchpad, your front-end system user must have the necessary roles assigned. Based on the
role(s) assigned to your user, you can access certain business catalogs and business catalog groups.

Your SAP Assortment Planning for Retail application is delivered with two predefined roles, catalogs, and groups.
These include technical content as well as business content:
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Table 30

Front-End Server Business Content Front-End Technical Content

Business Role Business Catalog Business Catalog Group Technical Role Technical
Catalog

SAP_RAP BCR AP P |SAP RAP BC AP PL | SAP_RAP BCG AP PLANNER | SAP _RAP TCR T SAP RAP TC
LANNER ANNER T

SAP_RAP BCR PLAN | SAP RAP BC PLANN SAP RAP BCG PLANNING A
NING ADMIN ING_ADMIN DMIN

To test the installation of SAP Assortment Planning for Retail from the SAP Fiori launchpad, you need to assign
the roles above to your user on the front-end system.

Procedure

1. Logon to your front-end system.

2. Launch User Maintenance (transaction suo01).

3. Enter your user name in the User field and choose Change.

4. Onthe Roles tab, assign the roles SAP RAP BCR_AP PLANNER and SAP RAP BCR PLANNING ADMIN to

your user.

More Information

Security Information section of the SAP Assortment Planning for Retail Administrator's Guide.

4.2.3.7 Configure SAP Jam (Optional)

Your retail application uses collaboration SAPUI5 components to define key ABAP-based SAP business object
data that can be consumed by SAP Jam.

If you are using the SAP Jam social collaboration platform in your business, you can configure the integration
between your retail application and SAP Jam. The integration, enabled by Social Media Integration, allows you to
share, or expose, the pre-defined ABAP-based SAP business object data directly from your retail application with
members of your organization, through SAP JAM.

The steps to enable the integration between your retail application and SAP Jam are not specific to this
installation guide and are described in the User Interface Add-On 1.0 for SAP NetWeaver product documentation
referenced below.

Prerequisites

To enable the integration of your retail application with SAP Jam, you must have a license for SAP Jam Enterprise
edition and your SAP Jam instance must be configured for productive use.
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Procedure

1. Readthe documentation for User Interface Add-On available on SAP Help Portal at [p help.sap.com/
netweaver » User Interface Add-On for SAP NetWeaver » Application Help » Social Media Integration 2.

This documentation provides important information on configuring the integration of your retail application
with SAP Jam, including:

o Understanding the Overall Process for Integrating Collaboration for a Business Object
o Implementation of ABAP Social Media Integration (ABAP SMI)

© Implementation of Collaboration SAPUI5 Components

o Connecting SAP Jam with ABAP SMI

o Configuring ABAP SMI for SAP Fiori Apps

More Information

For the latest updates on SAP Jam, see the SAP Help Portal at help.sap.com/sapjam.

4.3 SAP Promotion Management for Retail
4.3.1 Installation

4.3.11 Install SAP Customer Activity Repository Retail
Applications Bundle

We recommend using Maintenance Optimizer in SAP Solution Manager to install and update product versions.
SAP Solution Manager calculates the required software components that have to be deployed on each server.

For more information about Maintenance Optimizer, see SAP Help Portal at|r help.sap.com/
solutionmanager?71 » Application Help » SAP Library » SAP Solution Manager » Maintenance Management »
Maintenance Optimizer 1.

Alternatively, you can download the required files directly from SAP Service Marketplace and deploy them
manually.

In this procedure, you use Maintenance Optimizer to perform a stack XML installation of SAP Customer Activity
Repository retail applications bundle 1.0.

Procedure

1. Logonto SAP Solution Manager and launch Maintenance Optimizer.

For more information on using Maintenance Optimizer, see [ service.sap.com/mopz 2.
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1 Note

Maintenance Optimizer 3.0 (MOPZ) is the standard for SAP Solution Manager 7.1 SP12. You may
experience difficulties installing products if you are running an older version of SAP Solution Manager.

We recommend upgrading to the latest version of SAP Solution Manager. If you do not wish to do so, you
must implement SAP Note 1940845 to render the MOPZ front-end compatible with the back-end.

2. Inthe Maintenance Optimizer work step that allows you to choose add-on products, select product version
CAR RETAIL APPL BUNDLE 1.0 and productinstance CARAB ABAP Server.

5? CAR RETAIL APPL BUNDLE 1.0 01 (10/2014) w SAP Customer Aclivity Repository retail applications bundie 1.0
(i) CAR RETAIL APPL BUNDLE 1.0
Instance Required Instance Required Product Version Systems
Iw| CARAB ABAP Server Application Server ABAP SAP NETWEAVER 7.4 Assign System

Figure 21: Selection of Product Version and Product Instance

Caution

Do not deselect any ABAP components from the product instance.

3. Calculate and download the stack XML file.

4. Logontoyourback-end server, that is, the ABAP system on which you are installing CAR Retail Appl Bundle -
ABAP Instance.

5. Usethe SAP Add-On Installation Tool (transaction SAINT) to load and install the stack XML generated using
SAP Solution Manager Maintenance Optimizer.

For more information on transaction SAINT, refer to the system documentation available directly in the
system when you run transaction SAINT and select the Online Help icon.

4.3.1.2 Install SAP Promotion Management for Retail

Prerequisites

1. You have installed SAP Customer Activity Repository as outlined in the SAP Customer Activity
Repository [page 26] section of this guide.

2. You have performed the required steps to configure Demand Data Foundation (DDF) as outlined in the
Configure Demand Data Foundation (DDF) [page 57] section of this guide.

Procedure

1. You must read the following SAP Notes before you start the installation. These SAP Notes contain the most
recent information on the installation, as well as corrections to the installation documentation.
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Table 31
2026580 Release strategy for the ABAP add-on This SAP Note contains information
RTLPROMO about planning the installation and
upgrades of the ABAP add-on [Add-on].
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5 Additional Information

5.1 SAP ERP Sales Document Fields used by SAP Customer
Activity Repository

This section lists all the SAP ERP sales document fields that are used by SAP Customer Activity Repository.

This information is particularly relevant for customers who transfer sales orders from a third party CRM system to
SAP ERP. You must ensure that the third party CRM sales orders are transferred to SAP ERP as described in
Ensure that Third Party CRM Sales Orders are Transferred to SAP [page 52]. The resulting SAP ERP sales
document tables can then be accessed from SAP Customer Activity Repository, either thorough SLT replication
or through direct access to the SAP ERP tables.

The SAP Customer Activity Repository, in particular, the SAP HANA content for SAP Customer Activity
Repository, assumes that the fields listed below contain data.

Table 32
e

VBELN VBAK Sales document number (sales orders and returns)

VBTYP VBAK Sales document category

AUART VBAK Sales document type

AUDAT VBAK Order date

VKORG VBAK Sales organization, needed for the distribution chain (distribution channel + sales

organization). This is part of the order channel definition.
VTWEG VBAK Distribution channel, needed for the distribution chain (distribution channel + sales
organization). This is part of the order channel definition.

KUNNR VBAK Customer number (sold-to party)

VDATU VBAK Requested delivery date

NETWR VBAK Transaction total

WAERK VBAK Currency

LOGSYSB VBAK Source logical system

GBSTK VBUK Sales order status

ZLSCH VBKD Payment type / means of payment

WAKTION VBKD Promotion ID

CAMPAIGN VBKD Campaign ID

MATNR VBAP Ordered article (SAP ERP article number)

MATKL VBAP Merchandise category
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REASN VBAP Replacement article

MWSBP VBAP Tax information

WAVWR VBAP Cost information

ABGRU VBAP Reason for rejection

PSTYV VBAP [tem category

NETPR VBAP Sales price

WERKS VBAP Plant

WERKS VBAP Actual fulfillment location
WERKS VBAP Pickup location

VSTEL VBAP Shipping/receiving point
KWMENG VBAP Order quantity in sales units
LFGSA VBUP Delivery item status

ABSTA VBUP Rejection status

VBELN VBEP Sales document number (sales orders and returns)
POSNR VBEP ltem

ETENR VBEP Schedule line

WMENG VBEP Ordered quantity in sales units
BMENG VBEP Confirmed quantity

CMENG VBEP Corrected quantity

VRKME VBEP Sales unit

MBDAT VBEP Planned availability date for item
LFIMG LIPS Delivered quantity

LFDAT LIKP Actual delivery date

WADAT LIKP Planned goods issue date
WADAT_IST LIKP Actual goods issue date

5.2 SAP HANA Live for SAP ERP Views Required by SAP
Customer Activity Repository

The following SAP HANA views, available in the sap.hba.ecc content package and installed and activated as part
of the SAP HANA Live for SAP ERP SPO2 installation, are required for operation of SAP Customer Activity
Repository:
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Table 33

sap.hba.ecc/ArticleGroup

sap.hba.ecc/MaterialCategory

sap.hba.ecc/
RetailPromotionCategoryName

sap.hba.ecc/ArticleGroupName

sap.hba.ecc/MaterialGroup

sap.hba.ecc/
RetailPromotionCrtedByAppl

sap.hba.ecc/BillingDocumentCondition

sap.hba.ecc/
Materiallnternational ArtINmbr

sap.hba.ecc/
RetailPromotionCrtedByAppIName

sap.hba.ecc/BillingDocumentHeader

sap.hba.ecc/MaterialPlantData

sap.hba.ecc/
RetailPromotionDiscStatusName

sap.hba.ecc/BillingDocumentitem

sap.hba.ecc/
MaterialProcurementArrangement

sap.hba.ecc/RetailPromotionDiscount

sap.hba.ecc/
BonusBuyCndnlsGrantedOnce

sap.hba.ecc/MaterialSeasonCategory

sap.hba.ecc/
RetailPromotionDiscountStatus

sap.hba.ecc/
BonusBuyCndnlsGrantedOnceName

sap.hba.ecc/
MaterialSeasonCategoryName

sap.hba.ecc/RetailPromotionltem

sap.hba.ecc/
BonusBuyConditionTargetType

sap.hba.ecc/Material Type

sap.hba.ecc/RetailPromotionName

sap.hba.ecc/
BonusBuyConditionTargetTypeName

sap.hba.ecc/MaterialUnitOfMeasure

sap.hba.ecc/RetailPromotionTheme

sap.hba.ecc/
BonusBuyLinkCatBuyGetltems

sap.hba.ecc/
MaterialValuatedNonSpecialStockFact
s

sap.hba.ecc/
RetailPromotionThemeName

sap.hba.ecc/
BonusBuyLinkCatBuyGetltemsName

sap.hba.ecc/
MaterialValuationTableName

sap.hba.ecc/RetailPromotionType

sap.hba.ecc/BonusBuyName

sap.hba.ecc/Plant

sap.hba.ecc/
RetailPromotionTypeName

sap.hba.ecc/BonusBuyStatus

sap.hba.ecc/ProductHierarchyNode

sap.hba.ecc/SDDocumentReason

sap.hba.ecc/BonusBuyStatusName

sap.hba.ecc/PurchasingOrganisation

sap.hba.ecc/SalesDistrict

sap.hba.ecc/BonusBuyType

sap.hba.ecc/Region

sap.hba.ecc/SalesDocumentHeader

sap.hba.ecc/BonusBuyTypeName

sap.hba.ecc/RetailArticleBrand

sap.hba.ecc/SalesDocumentitem

sap.hba.ecc/
CalendarBasedFiscalYearVariantFiscalC
alendar

sap.hba.ecc/RetailArticleBrandName

sap.hba.ecc/
SalesDocumentSchedulelLine

sap.hba.ecc/
CalendarDeviantFiscalYearVariantFiscal
Calendar

sap.hba.ecc/RetailArticleFashionGrade

sap.hba.ecc/SalesOrganization

sap.hba.ecc/CharacteristicValueDesc

sap.hba.ecc/
RetailArticleFashionGradeName

sap.hba.ecc/
SalesPriceActivationStatus
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View Name

sap.hba.ecc/CompanyCode

sap.hba.ecc/
RetailArticleHierNodeToArticle

sap.hba.ecc/
SalesPriceActivationStatusName

sap.hba.ecc/Country

sap.hba.ecc/RetailArticleHierarchy

sap.hba.ecc/
TCURM_BWKEY_BUKRS_WERKS

sap.hba.ecc/Currency

sap.hba.ecc/
RetailArticleHierarchyAssignment

sap.hba.ecc/UnitOfMeasureName

sap.hba.ecc/CustomerBasicData

sap.hba.ecc/
RetailArticleHierarchyName

sap.hba.ecc/VBAK_COM

sap.hba.ecc/Date

sap.hba.ecc/
RetailArticleHierarchyNode

sap.hba.ecc/VBAP_COM

sap.hba.ecc/DistributionChain

sap.hba.ecc/
RetailBonusBuyConditions

sap.hba.ecc/VBEP_COM

sap.hba.ecc/DistributionChannel

sap.hba.ecc/
RetailBonusBuyPrerequisites

sap.hba.ecc/VBKD_COM

sap.hba.ecc/Division

sap.hba.ecc/RetailLocation

sap.hba.ecc/VBRK_COM

sap.hba.ecc/FiscalCalendar

sap.hba.ecc/RetailLocationType

sap.hba.ecc/VBRP_COM

sap.hba.ecc/KNA1_COM

sap.hba.ecc/RetailLocationTypeName

sap.hba.ecc/VBUK_COM

sap.hba.ecc/KONV_COM

sap.hba.ecc/
RetailPromnOfferDiscTypeName

sap.hba.ecc/VBUP_COM

sap.hba.ecc/MARC_KeyNonValuated

sap.hba.ecc/
RetailPromnOfferDiscountType

sap.hba.ecc/VEDA_COM

sap.hba.ecc/MARC_stocks

sap.hba.ecc/
RetailPromnOfferPriceType

sap.hba.ecc/Year

sap.hba.ecc/MARD_stocks

sap.hba.ecc/
RetailPromnOfferPriceTypeName

sap.hba.ecc/
YearSpecificFiscalYearVariant

sap.hba.ecc/MBEW_stock

sap.hba.ecc/RetailPromotion

sap.hba.ecc/
YearUnspecificFiscalYearVariant

sap.hba.ecc/Material

sap.hba.ecc/
RetailPromotionBonusBuy

sap.hba.ecc/MaterialAccountingData

sap.hba.ecc/RetailPromotionCategory

5.3 Workbook Design Example

In this procedure, you walk through an example of creating an SAP BusinessObjects Analysis, edition for
Microsoft Office workbook. You can use steps of this procedure to create customized versions of the SAP-
delivered assortment planning workbooks.
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Prerequisites

The necessary Bl queries must exist in the back-end system.

Procedure

Open SAP BusinessObjects Analysis, edition for Microsoft Office from | Start » All Programs » SAP Business
Intelligence » SAP BusinessObjects Analysis » Analysis for Microsoft Excel 3.

2. Select the cell in the worksheet where the crosstab with the data from the selected data source should be
inserted.

3. Fromthe menu, choose |F Analysis » Insert » Select Data Source 1.

4. Choose Skip on the popup window Logon to SAP BusinessObjects Bl Platform.

5. Inthe Select Data Source dialog box, select the source system, then choose Next.

6. Inthe Logon to system <Your System Name> dialog box, enter your logon data, then choose OK.

7. Inthe Select Data Source dialog box, choose tab Search.

8. Inthe Search tab, you can search for the description or technical name of a data source, that is, the name of
the Bl query that will provide the data for your workbook.

For example, search for /RAP/M0O1A01 IRQO02 or /RAP/MO1A01 IRQO1.Ingeneral, you can search for /
RAP* to find any SAP Assortment Planning for Retail query.

9. Select the required data source, and then choose OK.

10. Onthe Prompts screen, make the relevant entries base on the selected query in the Specify Value for
Prompts area.

11. Choose OK, and then you will see the table is inserted in the sheet. You can now analyze the data and change
the displayed data set according to your needs. You can also add other components to your analysis, for
example charts.

12. Choose menu |k Analysis » Display 2 to open the design panel.

13. Choose the Components tab in the bottom right corner, and right-click Bookl and choose Use Planning
Sequence.

14. Inthe Search For field of the Open Planning Sequence dialog box enter your planning sequence and choose
Search.

15. Select the required planning sequence, and then choose OK. The planning sequence will be displayed under
|r Bookl » Planning Objects 1 in the design panel.

16. Select the cell in the worksheet where a button should be inserted.

17. From the menu, choose IF Developer » Insert » Button (Form Control) 3, and insert the button using drag and
drop.

18. Inthe Assign Macro dialog box, choose New.

19. Inthe VB edit, maintain the relevant code in the Sub ButtonX_Click area.

20. Choose Close.

21. Right-click the button, and choose Edit Text. Replace the button name with a meaningful name.

22. Position your cursor where the condition will be defined, and make the relevant entries.

23. Select the sheet and position the cursor where the variable list will be inserted, for example cell H1 in sheetl.

24. Choose menu | Analysis » Info » Field » Variables 3, and the variables will be inserted into the relevant sheet.

25. Maintain the relevant entries in the sheet.
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26. Choose your Planning Sequence in the design panel.

27. Inthe section of Variables of Planning Sequence, make the relevant entries.

28. Choose Save Button.

29. Provide a file name and save the workbook as type Excel Macro-Enabled Workbook (*.xIsm).

30. Choose Save.

Result

The customized workbook is created.

5.4 Referenced SAP Notes

The following is a comprehensive list of all SAP Notes referenced throughout the entire guide. For a list of critical
SAP Notes that you must read (and, when appropriate, implement) before you start the installation, see the SAP
Notes for the Installation [page 5] section.

Make sure that you have the up-to-date version of each SAP Note, which you can find on SAP Service Marketplace
at service.sap.com/notes.

Table 34: SAP Notes for SAP Customer Activity Repository

1605140 SAP HANA 1.0: Central Note - SAP LT | Collective note for all the relevant SAP Notes for
Replication Server LT Replication Server for SAP HANA.
1778607 SAP HANA Live for SAP Business What to consider when implementing SAP HANA
Suite Live for SAP Business Suite.
1791342 Time Zone Support in SAP HANA How to handle time zone functions UTCTOLOCAL
and LOCALTOUTC.
1799313 Create Tables for SAP HANA Live How to create a set of tables relevant for SAP
HANA Live in the SAP HANA database using the
SAP LT Replication Server.
1782065 Tables for SAP HANA Analytics for Contains a list of general tables required for SAP
SAP Business Suite HANA Live for SAP Business Suite.
1781992 Tables for SAP HANA Analytics for Contains a list of tables required for SAP HANA
ERP1.0 Live for ERP.
1938004 Create CRM tables in SAP Customer | Note describing the creation of SAP CRM tables
Activity Repository required to activate SAP HANA content for SAP
Customer Activity Repository.
1909488 Create “dummy” CRM tables in SAP | Note describing the creation of SAP CRM
Customer Activity Repository “dummy” tables required to activate SAP HANA
content for SAP Customer Activity Repository.
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1897024 Replicate ERP tables for SAP Note describing the replication of SAP ERP tables
Customer Activity Repository from a source SAP ERP system.

1897025 Replicate CRM tables for SAP Note describing the optional replication of SAP
Customer Activity Repository CRM tables from a source SAP CRM system.

337623 Customizing after installation or Note describing the process of copying the
upgrade standard SAP-delivered Customizing settings.

1900038 Create ECC SLT tables in SAP Information on how to automatically create ECC
Customer Activity Repository SLT tables via SQL.

2056102 Release and Upgrade Information for | Information on where and how the POS AFL is
On-Shelf Availability Application released; overview of all independent releases
Function Library (POS AFL) (revisions) of the POS AFL as of revision 82;

installation instructions.
1846194 Lack of permissions when using AFL | Information on how to solve authorization issues

when using an application function library such as
the POS AFL (On-Shelf Availability functionality);
information on the required database users, roles,
and schemas.

Table 35: SAP Notes for Demand Data Foundation (DDF) with Unified Demand Forecast (UDF)

You need to read and, when appropriate, implement the following SAP Notes if your installation scenario includes the
following SAP Customer Activity Repository components:

e DDF2.0(RTLDDF 200) as the cross-industry reusable data layer

e UDFAFL(UDFAFL INST 100), revision 83 or higher, as the demand modeling and forecasting engine that you install
and run in the SAP HANA database

1809841 Release strategy for the ABAP add- | Information about planning the installation and
on RTLDDF upgrades of the ABAP add-on RTLDDF.
2001688 Consuming Applications of Demand | List of the consuming applications supported by
Data Foundation and Unified DDF with UDF on SAP HANA, information on the
Demand Forecast minimum requirements.
2050229 Release and Upgrade Information for | Only for UDF: Overview of all independent
Unified Demand Forecast releases (revisions) of the UDF AFL as of revision
Application Function Library (UDF 82 on SAP HANA Platform SPS 08 revision 82;
AFL) instructions for installing or upgrading the UDF
AFL using the recommended installation tools,
hdblcmor hdblcmgui.
2004952 Migration of UDF AFL and POS AFL | Only for UDF: Instructions for performing a

from SAP HANA AFL as of SAP
HANA Platform SPS 08

mandatory one-time migration when upgrading
from a UDF AFL on SAP HANA Platform SPS 06 or
SPS 07; additional installation instructions.
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1997526 SAP HANA lifecycle manager with Only for UDF: Information on SAP HANA tools that
SAP HANA Database SPS 08 you can use to install the UDF AFL. Note that the
recommended tools depend on your edition of the
SAP HANA Platform.
2075266 SAP HANA Platform SPS 09 Release | Only for UDF: This note is only relevant for you if
Note you want to use revision 90 or higher of the UDF
AFL. In this case, you need to install the same
revision of SAP HANA Platform SPS 09.
1898341 Modeling or forecasting fails with Information about how you can change the
failed decomposition configuration for demand modeling and
forecasting if the errors 901 Failed execution for
&1 and 926 Failed decomposition occur.
2038829 Corrections for unified rendering up | Corrections to unified rendering for Web Dynpro
to SAP_UI740/09 | applications; information about the required
installation of SAP_UI 740 SP 10 on the back-
end server when installing SAP NetWeaver 7.4 SP
02 up to SP 09.
2080423 Assortment Planning: Sales Performance optimization for the sales
Projection crashes with large data projections that DDF can generate for SAP
volumes Assortment Planning for Retail.

1846194 Lack of permissions when using AFL | Only for UDF: Information on how to solve
authorization issues when using an application
function library such as the UDF AFL; information
on the required database users, roles, and
schemas.

1836357 (optional) Install and Configure the UDF Only for UDF: Hardware requirements for the

Launchpad optional visualization tool Unified Demand
Forecast Launchpad; installation and
configuration instructions.

Table 36: SAP Notes for SAP Assortment Planning for Retail

1637199 Using the planning applications KIT Important information for running the Planning
Application Kit (PAK).
2033016 Improved buffering of "unposted"” Correction to reduce the number of times the
calls in queries LOAD method in class
CL_RSR_RRKO_UNPOSTED_PLAN is called.
2067733 BW-IP: Not all data is filtered Corrections related to the SAP BW planning
buffer.
2022080 Upgrade of PAL AFL and BFL AFL Corrections to add privileges removed during
from SAP HANA earlier release to upgrade to SAP HANA Platform SPS O8.
SPS08
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1662968 Clarification on setting Information on changing the default
ResultSetSizeLimit in Analysis Office | ResultSetSizeLimit registry setting.
2075135 Assortment Planning: Wrong values | Correction related to option planning.
and incorrect planning functions in
option plan
2075211 Assortment Planning: Errors in Correction to Refine Assortment workbook.

Refine Assortment workbook
category display and KPIs

Table 37: SAP Notes for SAP Assortment Planning for Retail

1637199 Using the planning applications KIT Important information for running the Planning
Application Kit (PAK).
2033016 Improved buffering of "unposted" Correction to reduce the number of times the
calls in queries LOAD method in class
CL_RSR_RRKO_UNPOSTED_PLAN is called.
2067733 BW-IP: Not all data is filtered Corrections related to the SAP BW planning
buffer.
2022080 Upgrade of PAL AFL and BFL AFL Corrections to add privileges removed during
from SAP HANA earlier release to upgrade to SAP HANA Platform SPS 08.
SPS08
1662968 Clarification on setting Information on changing the default
ResultSetSizeLimit in Analysis Office | ResultSetSizeLimit registry setting.
2082906 Use new api to get option count in Correction to retrieving option counts in
assortment list assortment lists.
2075135 Assortment Planning: Wrong values | Correction related to option planning.
and incorrect planning functions in
option plan
2075211 Assortment Planning: Errors in Correction to Refine Assortment workbook.
Refine Assortment workbook
category display and KPIs
2082929 Duplicate SQL exception when Correction to location clustering for products with
extracting data multiple base units of measure.
2080423 Assortment Planning: Sales Performance optimization for DDF sales

Projection crashes with large data
volumes

projections.
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Table 38: SAP Notes for SAP Promotion Management for Retail

2026580 Release strategy for the ABAP add- | This SAP Note contains information about
on RTLPROMO planning the installation and upgrades of the
ABAP add-on [Add-on].
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Typographic Conventions

Table 39

oome o

<Example>

Angle brackets indicate that you replace these words or characters with appropriate entries
to make entries in the system, for example, “Enter your <User Name>".

b Example » Example 3

Arrows separating the parts of a navigation path, for example, menu options

Example

Emphasized words or expressions

Example

Words or characters that you enter in the system exactly as they appear in the
documentation

Www.sap.com

Textual cross-references to an internet address

/example Quicklinks added to the internet address of a homepage to enable quick access to specific
content on the Web
123456 Hyperlink to an SAP Note, for example, SAP Note 123456
Example ®  Words or characters quoted from the screen. These include field labels, screen titles,
pushbutton labels, menu names, and menu options.
® Cross-references to other documentation or published works
Example e  Qutput on the screen following a user action, for example, messages
®  Source code or syntax quoted directly from a program
® File and directory names and their paths, names of variables and parameters, and
names of installation, upgrade, and database tools
EXAMPLE Technical names of system objects. These include report names, program names,

transaction codes, database table names, and key concepts of a programming language
when they are surrounded by body text, for example, SELECT and INCLUDE

Keys on the keyboard
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No part of this publication may be reproduced or transmitted in any
form or for any purpose without the express permission of SAP SE
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SAP and other SAP products and services mentioned herein as well
as their respective logos are trademarks or registered trademarks
of SAP SE (or an SAP affiliate company) in Germany and other
countries. Please see www.sap.com/corporate-en/legal/copyright/
index.epx#trademark for additional trademark information and
notices.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software
vendors. National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company
for informational purposes only, without representation or warranty
of any kind, and SAP SE or its affiliated companies shall not be liable =
for errors or omissions with respect to the materials. The only

warranties for SAP SE or SAP affiliate company products and

services are those that are set forth in the express warranty

statements accompanying such products and services, if any.

Nothing herein should be construed as constituting an additional
warranty.

In particular, SAP SE or its affiliated companies have no obligation to
pursue any course of business outlined in this document or any "
related presentation, or to develop or release any functionality "
mentioned therein. This document, or any related presentation, and
SAP SE's or its affiliated companies' strategy and possible future
developments, products, and/or platform directions and
functionality are all subject to change and may be changed by SAP
SE or its affiliated companies at any time for any reason without
notice. The information in this document is not a commitment,
promise, or legal obligation to deliver any material, code, or
functionality. All forward-looking statements are subject to various
risks and uncertainties that could cause actual results to differ
materially from expectations. Readers are cautioned not to place
undue reliance on these forward-looking statements, which speak
only as of their dates, and they should not be relied upon in making
purchasing decisions.
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